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capítulo 1

Introducción a SampleCell II Plus
SampleCell II combina las mejores 
prestaciones de los muestreadores 
especializados con la potencia de su 
estación de trabajo de audio digital. Ofrece 
eficaces funciones de reproducción y 
edición de muestras para sistemas 
Windows y Macintosh con PCI.

Con SampleCell II, puede utilizar sonidos 
procedentes de bibliotecas de muestras en 
CD-ROM o importar sus propios sonidos 
grabados digitalmente y editarlos según sus 
requisitos. A continuación podrá controlar 
la reproducción de las muestras desde 
cualquier dispositivo o software MIDI.

Novedades de SampleCell II 
Plus
La tarjeta SampleCell II Plus incorpora las 
funciones de la SampleCell II PCI, y añade 
32 MB de RAM integrada. No se requiere 
RAM adicional. 

El sistema SampleCell II Plus es compatible 
con Open Music System (OMS) en 
Macintosh y Multimedia en Windows 98 y 
Windows NT, y puede utilizarse con 
secuenciadores MIDI y controladores MIDI 
externos.
Acerca de esta guía
Este documento trata los siguientes temas:

◆ Capítulo 1: Introducción a SampleCell II 
Plus presenta las funciones de 
SampleCell II. 

◆ Capítulo 2: Instalación de 
SampleCell II Plus con Macintosh explica los 
procedimientos de instalación y 
comprobación del hardware SampleCell II 
y el software asociado (incluido OMS), así 
como las conexiones a hardware MIDI y de 
audio.

◆ Capítulo 3: Instalación de 
SampleCell II Plus con Windows explica los 
procedimientos de instalación y 
comprobación del hardware SampleCell II 
y el software asociado (incluido Windows 
Multimedia), así como las conexiones a 
MIDI y hardware de audio.

◆ Capítulo 4: Guía de uso de SampleCell 
explica operaciones con bancos e 
instrumentos e incluye una descripción de 
la ventana Bank.

◆ Capítulo 5: Creación y modificación de 
instrumentos describe el modo de crear 
instrumentos personalizados con muestras 
del usuario y cómo configurar la 
reproducción de dichos instrumentos.
Capítulo 1: Introducción a SampleCell II Plus 1
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◆ Capítulo 6: Edición de muestras, bucles y 
recorte de audio explica el uso del software 
SampleCell Editor para crear y editar bucles 
de muestras.

◆ Capítulo 7: Técnicas avanzadas ofrece 
ejemplos de las excelentes funciones de 
reproducción de muestras de SampleCell II.

◆ Capítulo 8: Interfaz SampleCell II describe 
los comandos de menú del software 
SampleCell Editor.

Convenciones utilizadas en esta guía

Para llamar la atención sobre información 
importante, se utilizan los siguientes 
símbolos:

✽ Sugerencias para sacar el máximo partido 
del sistema del usuario.

▲ Avisos importantes con información que 
puede afectar a los datos o al rendimiento del 
sistema.

Funciones de 
SampleCell II Plus
Las funciones principales de la tarjeta 
SampleCell II Plus son:
• Compatibilidad total con OMS para 

Macintosh 
• Compatibilidad total con Multimedia 

para Windows  98 y Windows NT
• 32 MB de RAM integrada
• Editor de bucles incorporado
• Polifonía de 32 voces y funciones 

multitímbricas
Guía de SampleCell II
• Cincuenta instrumentos mono o 25 
instrumentos estéreo multimuestra, y 10 
instrumentos mono o 5 estéreo de 
muestra única por tarjeta

• Dos generadores de señales de 
seguimiento con 9 puntos cada uno

• Un filtro de paso bajo de barrido por voz
• Convertidores digital-analógico 

individuales para cada una de las cuatro 
salidas de audio estéreo

• Versión de demostración de utilidad de 
software con la que los usuarios de 
Windows pueden abrir archivos de 
instrumentos y muestras en volúmenes 
Macintosh HFS

Opción SampleCell TDM
SampleCell TDM™ es una tarjeta auxiliar 
que integra la reproducción de audio de 
SampleCell en el entorno TDM de los 
sistemas Digidesign Pro Tools®. Con 
SampleCell TDM, las salidas de audio de 
SampleCell aparecen como fuentes de 
entrada adicionales en sesiones Pro Tools.

Contenido del paquete
El paquete SampleCell II Plus contiene los 
siguientes componentes:
• Tarjeta de audio digital SampleCell II 

Plus de 16 bits, con 32 MB de RAM 
integrada

• Cable estéreo a Y para conectar una de las 
cuatro salidas de SampleCell II a su 
sistema

• CD-ROM instalador de SampleCell II, 
para instalar el software SampleCell 
Editor



                 
• Compatibilidad total con controlador 
Multimedia MIDI para Windows  98 y 
Windows NT

• DAE y DigiSystem Init para Macintosh
• Cuatro discos CD-ROM de bibliotecas de 

muestras, con más de 900 MB de 
muestras e instrumentos: SampleCell 
Libraries #1 y #2 para Macintosh, y 
Libraries #1 y #2 para Windows

• Versión de demostración de utilidad de 
software con la que los usuarios de 
Windows pueden montar y abrir 
archivos desde volúmenes 
HFS/Macintosh

Requisitos del sistema
A continuación se enumeran los requisitos 
del sistema para las tres plataformas.

Macintosh

Para usar SampleCell II Plus con un sistema 
Macintosh, se necesita:
• Un Power Macintosh 7200, 7500, 7600, 

8500, 9500, 9600 o un G3
• Un mínimo de 20 MB de RAM
• Sistema Mac OS 7.5 o posterior
• OMS™ 2.3.2 o posterior (incluido en 

paquete)
• Interfaz MIDI Macintosh

Windows 98

Para usar SampleCell II Plus en un PC con 
Windows 98, se necesita:
• Un procesador Pentium
• Windows 98, Second Edition
• Un mínimo de 32 MB de memoria (se 

recomiendan 64 o más)
• Windows Multimedia
• Interfaz MIDI compatible con 

Windows 98

Windows NT

Para usar SampleCell II Plus en un PC con 
Windows NT, se necesita:
• Un procesador Pentium
• Windows NT 4.0 con Service Pack 3 (o 

Service Pack 4)
• Un mínimo de 32 MB de memoria (se 

recomiendan 64 o más)
• Windows Multimedia
• Interfaz MIDI compatible con 

Windows NT

Elementos opcionales
Según los requisitos específicos de cada 
usuario, pueden ser necesarios los 
siguientes elementos:
• Cables estéreo a Y opcionales para 

conectar las salidas estéreo de 1/4" de 
SampleCell II al sistema de audio. El 
paquete SampleCell II incluye un cable 
estéreo.

• Teclado controlador MIDI (u otro 
dispositivo controlador MIDI) y cables 
MIDI para activar la reproducción de 
SampleCell II vía MIDI.

✽ En sistemas Windows, muchas tarjetas de 
sonido y juegos tienen interfaces MIDI 
integradas.

• Software de secuenciación MIDI 
compatible con OMS en Macintosh, o 
con Multimedia en Windows 98 o 
Windows NT.
Capítulo 1: Introducción a SampleCell II Plus 3
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• Si tiene intención de usar Digital 
Performer de MOTU u otra aplicación 
FreeMIDI, debe usar FreeMIDI OMS 
Emulator para activar la reproducción de 
SampleCell II. 

Uso de SampleCell en sistemas 
expandidos
En un ordenador pueden usarse varias 
tarjetas SampleCell (siempre y cuando haya 
suficientes ranuras PCI disponibles), cada 
una de ellas con cuatro salidas estéreo y 32 
voces adicionales. Además, puede usar un 
chasis de expansión PCI aprobado por 
Digidesign para trabajar con un máximo de 
10 tarjetas SampleCell en un sistema 
autónomo, o un máximo de 8 si instala 
SampleCell II con un sistema Pro Tools.

▲ La versión 2.1.1 y posteriores del software 
SampleCell Editor son incompatibles con 
SampleCell I (Macintosh) y SampleCell II PC.
Guía de SampleCell II



                   
capítulo 2

Instalación de SampleCell II Plus con 
Macintosh
Antes de instalar el software SampleCell 
debe instalar la tarjeta en el ordenador.

Instalación de la tarjeta 
SampleCell II
Si va a utilizar la SampleCell II con un 
sistema Pro Tools TDM, asegúrese de seguir 
el orden de ranuras correcto. Para más 
detalles, véase "Orden de colocación en las 
ranuras de tarjeta para sistemas TDM" en la 
página 6.

Para instalar tarjetas SampleCell II:

1  El ordenador y los dispositivos periféricos 
deben estar apagados. Deje enchufado el 
cable de alimentación de la CPU para que 
esté conectada a tierra.

2  Retire la tapa del Macintosh. La Figura 1 
muestra la instalación en un Power 
Macintosh 9600; la suya debería ser similar. 
Si tiene dudas sobre cómo instalar una 
tarjeta en el ordenador, consulte la 
documentación del usuario de Macintosh.
Capítulo 2: 
3  Antes de manipular tarjetas SampleCell, 
toque una superficie metálica con 
conexión a tierra (por ejemplo, la caja de la 
fuente de alimentación dentro del 
Macintosh) para eliminar posible 
electricidad estática de su ropa o de su 
cuerpo.

4  Retire la tapa metálica situada detrás de la 
ranura de expansión que desea usar; debe 
deslizar la tapa para separarla del puerto de 
acceso.

Figura 1.  Eliminación de electricidad estática 
residual y extracción de tapas de acceso
Instalación de SampleCell II Plus con Macintosh 5
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5  Saque la SampleCell II de la bolsa 
antiestática. Sujete la tarjeta por el borde, 
para evitar transmitir a los componentes 
posible electricidad estática o grasa.

6  Introduzca la tarjeta SampleCell II en 
una ranura PCI del ordenador (véase la 
Figura 2). Empuje la tarjeta suavemente 
hasta que encaje firmemente en el 
conector. No doble la tarjeta ni ejerza 
excesiva presión en la placa base del 
ordenador. Si tiene dificultades con la 
instalación, saque la tarjeta e inténtelo de 
nuevo.

Repita el procedimiento descrito 
anteriormente para todas las demás tarjetas 
SampleCell II.

7  Cuando termine, vuelva a colocar la tapa 
del Macintosh.

Si ya tenía una tarjeta SampleCell II de una 
versión previa (que sea PCI), puede usarla 
con la nueva SampleCell II Plus.

Figura 2.  Instalación de SampleCell II con 
Macintosh 
Guía de SampleCell II
Orden de colocación en las 
ranuras de tarjeta para 
sistemas TDM
Para que TDM temporice correctamente los 
datos que pasan por el sistema, todas las 
tarjetas con TDM deben estar instaladas en 
las ranuras en un orden determinado. Si su 
sistema incorpora un chasis de expansión 
PCI externo, el orden debe tenerse en 
cuenta también para el chasis.

En sistemas Pro Tools expandidos, todas las 
tarjetas SampleCell II (y SampleCell II 
TDM) deben colocarse a continuación de 
las tarjetas DSP Farm, y si hay varias tarjetas 
SampleCell deben ocupar posiciones 
contiguas.

Empezando por la ranura con el número 
más bajo, el orden requerido debería ser:

1  MIX Core (Pro Tools 24 MIX), d24 
(Pro Tools 24) o Disk I/O (Pro Tools III PCI)

2  MIX Farm

3  DSP Farm

4  SampleCell II con TDM

5  SampleCell II sin TDM

Si tiene varias tarjetas del mismo tipo, debe 
instalarlas en ranuras contiguas. Por 
ejemplo, debería instalar todas las tarjetas 
DSP Farm juntas, luego todas las 
SampleCell II TDM y después todas las 
SampleCell II sin TDM.

▲ No instale tarjetas sin TDM ni deje ranuras 
vacías entre ranuras que contengan tarjetas 
con TDM.



       
Instalación del software 
SampleCell
Una vez instalada la SampleCell II y 
encendido el ordenador, puede proceder a 
instalar el software SampleCell.

El instalador SampleCell copia en su disco 
duro SampleCell Editor, la aplicación de 
diagnósticos DigiTest, Digidesign Audio 
Engine (DAE) y DigiSystem Init.

Tarjeta de registro de SampleCell

Como usuario registrado, recibirá 
actualizaciones de software periódicas y 
ofertas de actualización. Envíe su tarjeta de 
registro hoy mismo.

Para instalar el software SampleCell: 

1  Introduzca el CD-ROM de SampleCell en 
la unidad de CD-ROM.

2  Haga doble clic en la aplicación Install 
SampleCell en el CD de SampleCell.

3  Siga las instrucciones en pantalla para 
instalar el software.

SampleCell Editor y DigiTest se instalan en 
sus respectivas carpetas, dentro de la 
carpeta de Digidesign (en el nivel raíz de su 
disco duro). En la carpeta del sistema se 
instala una carpeta DAE y DigiSystem Init 
se instala en la carpeta de extensiones.

4  Reinicie el ordenador cuando se le 
indique.
Capítulo 2: 
Eliminación del software 
SampleCell
Puede eliminar el software SampleCell de 
su ordenador mediante la función Remove 
del instalador.

Para eliminar el software SampleCell:

1  Introduzca el CD-ROM de SampleCell en 
la unidad de CD-ROM.

2  Localice y haga doble clic en la aplicación 
Install SampleCell en el CD de SampleCell.

3  En la ventana del instalador, elija 
Remove en el menú emergente de la 
esquina superior izquierda.

4  Haga clic en Switch Disk para especificar 
el disco duro que contiene el software 
SampleCell.

5  Haga clic en Remove.

SampleCell Editor, DigiTest, DAE y 
DigiSystem Init se eliminarán de su disco 
duro.

Configuración de OMS
Para usar SampleCell II con aplicaciones 
compatibles con OMS, o para usar los 
servicios MIDI en SampleCell Editor, debe 
instalar y configurar Open Music System 
(OMS).

OMS está al corriente de los datos de 
conexión y configuración del estudio MIDI 
y almacena esta información en 
documentos Studio Setup, que se editan en 
la aplicación OMS Setup. OMS también 
dirige MIDI entre SampleCell II, 
secuenciadores compatibles con OMS y la 
interfaz MIDI.
Instalación de SampleCell II Plus con Macintosh 7
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Si aún no lo ha hecho, instale el software 
OMS incluido en el paquete SampleCell.

Si ya tiene instalado y configurado OMS, 
actualice Studio Setup para que reconozca 
la tarjeta SampleCell II.

Para actualizar OMS Studio Setup:

1  En la aplicación OMS Setup, elija Studio > 
MIDI Cards & Interfaces.

OMS buscará la tarjeta SampleCell II y la 
mostrará en el documento Studio Setup.

2  Haga doble clic en el icono de SampleCell 
para configurar los parámetros del cuadro 
de diálogo MIDI Device Info.

Asegúrese de que está configurado para 
recibir en todos los canales (1–16), a menos 
que prefiera recibir MIDI sólo en algunos 
de ellos.

✽ Algunas aplicaciones OMS pueden requerir 
que se actualice la lista de instrumentos OMS 
para poder usar SampleCell. Consulte la 
documentación del fabricante para más 
detalles.

Dirección de MIDI a la tarjeta 
SampleCell II
En SampleCell Editor puede activar la 
reproducción de instrumentos de 
SampleCell desde el teclado MIDI. 
SampleCell Editor dirige MIDI (vía OMS) 
desde el controlador de su teclado a 
cualquier instrumento asignado al canal 
enviado por su teclado.

Para dirigir MIDI automáticamente al 
instrumento SampleCell seleccionado 
actualmente, active la opción de 
Guía de SampleCell II
preferencia para "Pass MIDI Thru". Para 
más información sobre esta opción, véase 
"Preferences" en la página 98.

Si desea activar la reproducción de 
instrumentos de SampleCell desde su 
teclado MIDI cuando SampleCell Editor no 
es la aplicación activa, seleccione la opción 
OMS para "Run MIDI in Background".

Para activar la opción Run MIDI in 
Background:

1  En SampleCell Editor, elija SampleCell > 
MIDI Setup.

2  En el cuadro de diálogo OMS MIDI Setup, 
seleccione Run MIDI in Background.

3  Haga clic en OK.

Esta opción también permite al 
secuenciador compatible con OMS 
continuar la reproducción MIDI aunque no 
sea la aplicación activa; de este modo puede 
escuchar para comprobar cambios en 
SampleCell Editor mientras el secuenciador 
sigue reproduciendo.

Tenga en cuenta que cuando está activada 
la opción Run MIDI in Background y tanto 
SampleCell Editor como su secuenciador 
emiten eco de MIDI thru al mismo 
instrumento, se producirán notas dobles. 

Para evitar este problema, desactive el "eco" 
MIDI en su secuenciador, o asegúrese de 
que no se dirija MIDI a un instrumento de 
SampleCell.



Uso de aplicaciones que no 
sean OMS
FreeMIDI

Si utiliza SampleCell II con software 
compatible con FreeMIDI™ de Mark of the 
Unicorn, debe usar OMS Emulator. 
Consulte la documentación de FreeMIDI 
para detalles de configuración.

No ejecute simultáneamente FreeMIDI y 
OMS. Si instala Performer o Digital 
Performer, que instala automáticamente 
FreeMIDI OMS Emulator en la carpeta de 
extensiones, asegúrese de eliminar o 
desactivar OMS.

▲ FreeMIDI OMS Emulator detendrá la 
reproducción si activa SampleCell Editor 
mientras reproduce el secuenciador.

Conexiones MIDI
Para reproducir SampleCell II desde un 
teclado controlador MIDI externo, conecte 
la salida MIDI del controlador a la entrada 
MIDI de su interfaz MIDI. Esto permite a su 
teclado MIDI transmitir MIDI a la tarjeta 
SampleCell II "a través de" su software 
MIDI compatible con OMS.

Para detalles sobre la instalación y 
configuración de su interfaz MIDI, consulte 
la documentación suministrada por el 
fabricante.
Capítulo 2: 
Conexiones de audio
SampleCell II tiene un total de ocho 
canales de salida de audio. Estas salidas 
tienen conectores estéreo de 1/4" y están 
situadas en la parte posterior de la tarjeta 
SampleCell II. Cada instrumento 
SampleCell puede asignarse a cualquiera de 
estos pares estéreo y panoramizarse como 
se desee.

Para conectar las salidas de audio 
SampleCell II:

1  Conecte el extremo estéreo del cable 
Y-estéreo (incluido en el paquete 
SampleCell II) a la salida de audio 
SampleCell deseada.

La Figura 3 ilustra la numeración de las 
salidas de audio de SampleCell II.

2  Conecte el otro extremo "dual" del cable 
a las entradas de nivel de línea del 
mezclador.

El cable Y estéreo incluido con el paquete 
SampleCell II se conecta con el extremo 
rojo a la derecha y el gris a la izquierda.

Figura 3.  Numeración de salidas de audio de 
SampleCell

1-2

3-4

5-6

7-8
Instalación de SampleCell II Plus con Macintosh 9
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Optimización de ganancia del 
sistema de audio
SampleCell tiene varias funciones de 
prueba integradas, entre ellas un generador 
de onda sinusoidal que puede usarse para 
calibrar la ganancia en su sistema.

▲ El generador de tono de SampleCell 
produce una onda sinusoidal de código 
completo excesivamente alta. Como medida 
de seguridad, reduzca el volumen del equipo 
de supervisión y luego auméntelo 
gradualmente después de activar el generador 
de tono. Tenga mucho cuidado si lleva puestos 
los auriculares.

Para optimizar la ganancia de salida de 
SampleCell:

1  Reduzca el volumen de los canales del 
mezclador.

2  En SampleCell Editor, elija SampleCell > 
Test SampleCell.

Se abrirá la ventana Test de SampleCell. En 
el extremo derecho de la misma aparecen 
los botones Test Sine.

3  Haga clic en cada uno de los botones Test 
Sine para cada canal y ajuste los canales 
correspondientes en su mezclador para oír 
un tono puro, sin distorsiones.

☞ Consulte el Apéndice B: Solución de 
problemas antes de seleccionar otras 
opciones de la ventana Test de SampleCell.

Ventana Test de SampleCell
Guía de SampleCell II
Prueba de instrumentos
Puede usar uno de los bancos incluidos en 
la biblioteca de muestras del CD-ROM para 
realizar una comprobación rápida de sus 
conexiones de audio y MIDI.

Para comprobar las conexiones de audio y 
MIDI:

1  En SampleCell Editor, elija File > Open.

2  Introduzca en la unidad de CD-ROM el 
CD-ROM Sample Library #1 para 
Macintosh.

3  Seleccione el banco "Tite Groove 
Playstation" y haga clic en Open.

4  Haga doble clic en un nombre de 
instrumento de la ventana para abrir una 
ventana Sample Map.

5  En la ventana Sample Map, haga clic en 
el teclado para reproducir una muestra.

6  Toque el teclado controlador MIDI y 
compruebe si la comunicación MIDI es 
correcta.

7  Mientras reproduce sonido, desplace los 
controles de panorámico de audio del 
mezclador para asegurarse de que la 
conexión de las salidas de audio sea 
correcta.



capítulo 3

Instalación de SampleCell II Plus con 
Windows
Antes de instalar el software SampleCell 
debe instalar la tarjeta en el ordenador.

Instalación de la tarjeta 
SampleCell II
Si va a utilizar la SampleCell II con un 
sistema Pro Tools TDM, asegúrese de seguir 
el orden de ranuras correcto. Para más 
detalles, véase "Orden de colocación en las 
ranuras de tarjeta para sistemas TDM" en la 
página 12.

Para instalar tarjetas SampleCell II:

1  El ordenador y los dispositivos periféricos 
deben estar apagados. Deje enchufado el 
cable de alimentación de la CPU para que 
esté conectado a tierra.

2  Retire la tapa del ordenador. Si tiene 
dudas sobre cómo instalar una tarjeta en el 
ordenador, consulte la documentación 
pertinente.

3  Antes de manipular las tarjetas SampleCell 
 II, toque una superficie metálica con 
conexión a tierra (por ejemplo, la caja de la 
fuente de alimentación dentro del 
ordenador) para eliminar posible electricidad 
estática de su ropa o de su cuerpo.
Capítulo 3
4  Retire la tapa metálica situada detrás de la 
ranura de expansión que desea usar; debe 
deslizar la tapa para separarla del puerto de 
acceso.

5  Saque la SampleCell II de la bolsa 
antiestática. Sujete la tarjeta por el borde, 
para evitar transmitir a los componentes 
posible electricidad estática o grasa.

6  Introduzca la tarjeta SampleCell II en 
una ranura PCI del ordenador (véase la 
Figura 4). Empuje la tarjeta suavemente 
hasta que encaje firmemente en el 
conector. No doble la tarjeta ni ejerza 
excesiva presión en la placa base del 
ordenador. Si tiene dificultades con la 
instalación, saque la tarjeta e inténtelo de 
nuevo.

Figura 4.  Instalación de SampleCell II con PC 
: Instalación de SampleCell II Plus con Windows 11
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 Guía de SampleCell II

Repita el procedimiento descrito 
anteriormente para todas las demás tarjetas 
SampleCell II.

7  Cuando termine, vuelva a colocar la tapa 
del ordenador.

Orden de colocación en las 
ranuras de tarjeta para 
sistemas TDM
Para que TDM temporice correctamente los 
datos que pasan por el sistema, todas las 
tarjetas con TDM deben estar instaladas en 
las ranuras en un orden determinado. Si su 
sistema incorpora un chasis de expansión 
PCI externo, el orden debe tenerse en 
cuenta también para el chasis.

En sistemas Pro Tools expandidos, todas las 
tarjetas SampleCell II (y SampleCell II con 
TDM) deben colocarse a continuación de 
las tarjetas DSP Farm, y si hay varias tarjetas 
SampleCell deben estar seguidas.

Empezando por la ranura con el número 
más bajo, el orden requerido debería ser:

1  MIX Core (Pro Tools 24 MIX) o d24 
(Pro Tools 24)

2  MIX Farm

3  DSP Farm

4  SampleCell II con TDM

5  SampleCell II sin TDM

Si tiene varias tarjetas del mismo tipo, debe 
instalarlas en ranuras contiguas. Por ejemplo, 
debería instalar todas las tarjetas DSP Farm 
juntas, luego todas las SampleCell con TDM y 
después todas las SampleCell sin TDM. 

▲ No instale tarjetas sin TDM ni deje ranuras 
vacías entre ranuras que contengan tarjetas 
con TDM.
Instalación del software 
SampleCell
La instalación del software SampleCell 
varía dependiendo de si se trabaja con 
Windows 98 o con Windows NT. Asegúrese 
de seguir el procedimiento de instalación 
adecuado para su sistema.

▲ Si está utilizando una utilidad de software 
para leer volúmenes Macintosh HFS, 
asegúrese de que la preferencia configurada 
es la de volumen PC para CDs de formato 
dual.

Tarjeta de registro de SampleCell

Como usuario registrado, recibirá 
actualizaciones de software periódicas y 
ofertas de actualización. Envíe su tarjeta de 
registro hoy mismo.

Instalación del software para 
Windows 98
Una vez instalada la SampleCell II y 
encendido el ordenador, el asistente para 
agregar nuevo hardware le pedirá que 
instale los controladores requeridos para 
Windows 98.

Figura 5.  Asistente para agregar nuevo hardware, 
Windows 98



Para instalar los controladores de 
Windows 98:

1  Cuando aparezca el Asistente para 
agregar nuevo hardware, haga clic en 
Siguiente.

2  Windows le ofrecerá varias opciones. 
Seleccione "Mostrar una lista de todos los 
controladores en una ubicación" y haga clic 
en Siguiente.

3  A continuación, seleccione "Dispositivos 
de sonido, vídeo y juegos" en la lista de 
tipos de dispositivo. Haga clic en Siguiente.

4  Introduzca el CD-ROM de SampleCell en 
la unidad de CD-ROM y haga clic en 
Utilizar disco.

5  Especifique la letra correspondiente a su 
unidad de CD-ROM (por ejemplo, D:\) y 
haga clic en Aceptar.

6  Asegúrese de que está seleccionada la 
opción de controlador de SampleCell y 
haga clic en Aceptar. Haga clic en Siguiente 
para instalar los componentes de 
controlador necesarios. 

7  Si no tiene que instalar otros 
controladores, haga clic en Siguiente y 
luego en Finalizar, para salir del Asistente.

Después de instalar el controlador para 
Windows 98, instale el software 
SampleCell Editor desde el CD-ROM.

Para instalar SampleCell Editor con 
Windows 98:

1  Introduzca el CD-ROM de SampleCell en 
la unidad de CD-ROM.

2  Si el instalador no se inicia 
automáticamente, localícelo y haga doble 
clic en el icono Setup.exe, en el CD del 
instalador.
Capítulo 3
3  Siga las instrucciones en pantalla para 
instalar el software. Los archivos de 
SampleCell se instalan en una carpeta 
"Digidesign" situada en la carpeta Archivos 
de programa de su sistema.

4  Reinicie Windows cuando se le indique.

Instalación del software para 
Windows NT
Una vez instalada la SampleCell II y 
encendido el ordenador, use el programa 
de instalación incluido en el CD-ROM de 
SampleCell para instalar el software 
requerido para Windows NT.

Para instalar SampleCell Editor y 
controladores para Windows NT:

1  Introduzca el CD-ROM de SampleCell en 
la unidad de CD-ROM.

2  Si el instalador no se inicia 
automáticamente, localícelo y haga doble 
clic en el icono Setup.exe, en el CD del 
instalador.

3  Siga las instrucciones en pantalla para 
instalar el software. Los archivos de 
SampleCell se instalan en una carpeta 
"Digidesign" situada en la carpeta Archivos 
de programa de su sistema. También se 
instalan los controladores de Windows NT 
para la SampleCell II.

4  Reinicie Windows cuando se le indique.
: Instalación de SampleCell II Plus con Windows 13
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Eliminación del software 
SampleCell
Puede eliminar el software SampleCell del 
ordenador mediante el panel de control 
Agregar o quitar programas, en Windows.

Para eliminar el software SampleCell:

1  Haga doble clic en el icono Agregar o 
quitar programas, en el Panel de control.

2  Seleccione la opción correspondiente a 
SampleCell Editor y haga clic en Agregar o 
quitar para eliminar el software.

Uso de aplicaciones MIDI 
de Windows
Una vez instalado el controlador de 
SampleCell para Windows, aparece un 
dispositivo de salida MIDI correspondiente 
en las aplicaciones MIDI. Asegúrese de 
asignar las pistas MIDI a canales de 
SampleCell que correspondan a los 
instrumentos de SampleCell cargados 
actualmente.

Si utiliza varias tarjetas SampleCell II, 
aparecerán en sus aplicaciones MIDI de 
Windows como "SampleCell Card 1", 
"SampleCell Card 2", etc.

3  En sistemas con varias tarjetas, también 
habrá un controlador de dispositivo 
denominado "SampleCell Broadcast" que 
permite enviar datos MIDI a todas las 
tarjetas simultáneamente.
Guía de SampleCell II
Conexiones MIDI
La dirección de señales MIDI para 
SampleCell II se gestiona internamente en 
el subsistema Windows Multimedia. 
Windows Multimedia gestiona la 
comunicación entre aplicaciones y todos 
los dispositivos compatibles del sistema, 
tales como tarjetas de sonido, interfaces 
MIDI y tarjetas SampleCell II.

Para reproducir SampleCell II desde un 
teclado controlador MIDI externo, conecte 
la salida MIDI del controlador a la entrada 
MIDI de su interfaz MIDI compatible con 
Windows. Así, el teclado MIDI puede 
transmitir MIDI a la tarjeta SampleCell II.

Para detalles sobre la instalación y 
configuración de su interfaz MIDI, consulte 
la documentación suministrada por el 
fabricante.

Conexiones de audio
SampleCell II tiene un total de ocho 
canales de salida de audio. Estas salidas 
tienen conectores estéreo de 1/4" y están 
situadas en la parte posterior de la tarjeta 
SampleCell II. Cada instrumento 
SampleCell puede asignarse a cualquiera de 
estos pares estéreo y panoramizarse como 
se desee.

Para conectar las salidas de audio 
SampleCell II:

1  Conecte el extremo estéreo del cable 
Y-estéreo (incluido en el paquete 
SampleCell II) a la salida de audio 
SampleCell deseada.



La Figura 6 ilustra la numeración de las 
salidas de audio de SampleCell II.

2  Conecte el otro extremo "dual" del cable 
a las entradas de nivel de línea del 
mezclador.

El cable Y estéreo incluido con el paquete 
SampleCell II se conecta con el extremo 
rojo a la derecha y el gris a la izquierda.

Optimización de ganancia del 
sistema de audio
SampleCell II tiene varias funciones de 
prueba integradas, entre ellas un generador 
de onda sinusoidal que puede usarse para 
calibrar la ganancia en su sistema.

▲ El generador de tono de SampleCell 
produce una onda sinusoidal de código 
completo excesivamente alta. Como medida 
de seguridad, reduzca el volumen del equipo 
de supervisión y luego auméntelo 
gradualmente después de activar el generador 
de tono. Tenga mucho cuidado si lleva puestos 
los auriculares.

Figura 6.  Numeración de salidas de audio de 
SampleCell

1-2

3-4

5-6

7-8
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Para optimizar la ganancia de salida de 
SampleCell:

1  Reduzca el volumen de los canales del 
mezclador.

2  En SampleCell Editor, elija SampleCell > 
Test SampleCell.

Se abrirá la ventana Test de SampleCell. En 
el extremo derecho de la misma aparecen 
los botones Test Sine.

3  Haga clic en cada uno de los botones Test 
Sine para cada canal y ajuste los canales 
correspondientes en su mezclador para oír 
un tono puro, sin distorsiones.

☞ Consulte el Apéndice B: Solución de 
problemas antes de utilizar otros elementos de 
la ventana Test de SampleCell. 

Ventana Test de SampleCell
: Instalación de SampleCell II Plus con Windows 15
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Prueba de instrumentos
Puede usar uno de los bancos incluidos en 
la biblioteca de muestras del CD-ROM para 
realizar una comprobación rápida de sus 
conexiones de audio y MIDI.

Para comprobar las conexiones de audio y 
MIDI:

1  En SampleCell Editor, elija File > Open.

2  Introduzca en la unidad de CD-ROM el 
CD-ROM Sample Library #1 para Windows.

3  Seleccione el banco "Tite Groove 
Playstation" y haga clic en Open.

4  Haga doble clic en un nombre de 
instrumento de la ventana para abrir una 
ventana Sample Map.

5  En la ventana Sample Map, haga clic en 
el teclado para reproducir una muestra.

6  Toque el teclado controlador MIDI y 
compruebe si la comunicación MIDI es 
correcta.

7  Mientras reproduce sonido, desplace los 
controles de panorámico de audio del 
mezclador para asegurarse de que la 
conexión de las salidas de audio sea 
correcta.
Guía de SampleCell II



capítulo 4

Guía de uso de SampleCell
Este capítulo trata los principales aspectos 
del uso de bancos e instrumentos 
procedentes de la biblioteca de SampleCell.

Para informarse sobre la creación de 
instrumentos y bancos utilizando sus propias 
muestras, consulte el Capítulo 5: Creación y 
modificación de instrumentos.

Tipos de archivo de 
SampleCell

Muestras
Una muestra es la información sin procesar 
de forma de onda de un sonido muestreado.

SampleCell no dispone de un medio 
directo para grabar muestras ni formas de 
onda digitales. Los CD-ROMs del producto 
incluyen gran número de muestras; y 
pueden adquirirse muchas más de otros 
desarrolladores de sonido. Con Pro Tools 
también pueden grabarse muestras.

Pero no es posible reproducir muestras 
directamente desde SampleCell; es preciso 
cargarlas en un instrumento.

Archivo de muestra (formato SD II) 
Instrumentos
Un instrumento se compone de una o varias 
muestras que se asignan a distintos rangos 
de teclas y velocidades.                                                 

A nivel de instrumento pueden emplease 
diversas opciones de modulación, entre 
ellas envolventes y osciladores LFO.

Bancos
Los instrumentos pueden combinarse en 
grupos denominados bancos.

En los bancos, los instrumentos se asignan 
a salidas, se atenúan y también se les ajusta 
el panorámico. Cada uno de los 

Instrumento (fila superior) y archivos de muestra

Banco (fila superior), instrumentos y archivos de 
muestra
Capítulo 4: Guía de uso de SampleCell 17
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instrumentos de un banco puede asignarse 
para responder a un rango de notas y a un 
canal MIDI, y usarse como módulo de 
sonido multitímbrico con un secuenciador 
(u otro dispositivo capaz de transmitir 
varios canales MIDI).

Mediante comandos de copiar y pegar 
estándar, puede colocar un instrumento en 
distintos bancos. Aunque no es posible 
abrir los instrumentos en varios bancos 
cargados en la misma tarjeta 
SampleCell II Plus, es posible copiarlos y 
pegarlos.

Los bancos son útiles para organizar en un 
solo documento todos los instrumentos 
requeridos para una canción o una secuencia 
MIDI, o para colocar todos los elementos de 
una submezcla (distintos instrumentos 
musicales o de efectos y combinaciones) en 
una misma vista en pantalla.

▲ Detenga el secuenciador siempre que vaya 
a abrir archivos de instrumento o bancos, o al 
abrir la ventana Edit Loops (para evitar 
bloqueos de notas).
Guía de SampleCell II
Estructura de archivos del 
CD-ROM
La estructura del contenido de los 
CD-ROMs de SampleCell refleja la jerarquía 
mencionada en la sección anterior. 
Muestras, instrumentos y bancos se 
guardan en carpetas cuyos nombres 
reflejan el contenido.

La carpeta Banks contiene la información 
que SampleCell necesita para crear bancos 
a partir de uno o varios instrumentos.

La carpeta Instruments contiene la 
información que SampleCell necesita para 
crear instrumentos a partir de las muestras 
relacionadas con los mismos. Estas carpetas 
anidadas facilitan la labor de identificación 
de instrumentos almacenados en el 
CD-ROM por categorías tales como Guitars, 
Synths o Woodwinds.

La carpeta Samples contiene únicamente 
muestras sin procesar, organizadas según 
instrumentos.

Si trabaja con sus propias muestras, le 
conviene seguir la misma estructura al 
crear carpetas para bancos, instrumentos y 
muestras, para tenerlo todo organizado.

Jerarquía de archivos de los CD-ROMs SampleCell



Carga de instrumentos
Para cargar un banco existente, siga las 
instrucciones detalladas a continuación 
correspondientes a su plataforma:

Macintosh

Para cargar un banco existente:

1  Elija File > Open.

2  Seleccione el banco deseado y haga clic 
en Abrir.

Windows

Para cargar un banco existente:

1  Elija File > Open.

2  Elija el tipo de archivo en el menú 
emergente Mostrar archivos de tipo.

3  Localice el banco deseado y haga clic en 
Abrir.

Apertura de un banco en Macintosh
Todos los sistemas

En el cuadro de diálogo de selección de 
instrumento, especifique los instrumentos 
del banco que desea cargar en la RAM de 
SampleCell. Si tiene varias tarjetas 
SampleCell, puede especificar en cuál debe 
cargarse cada uno de los instrumentos. 
Seleccione los instrumentos deseados, elija 
las tarjetas apropiadas y haga clic en OK.

Apertura de un banco en Windows

Cuadro de diálogo de selección de instrumento
Capítulo 4: Guía de uso de SampleCell 19
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Búsqueda de archivos
Si SampleCell no encuentra un 
instrumento o una muestra que cargar en 
un banco o en un instrumento, se abrirá el 
cuadro de diálogo de búsqueda de archivos.

Macintosh

En el cuadro de diálogo mostrado bajo estas 
líneas puede buscar archivos seleccionando 
las áreas de búsqueda en los menús 
emergentes situados en la parte inferior y 
haciendo clic en el botón New Search.

Puede escuchar un archivo de muestra 
desde este cuadro seleccionando su nombre 
y haciendo clic en el botón Play. Haga clic 
en el mismo botón (cuyo texto habrá 
cambiado a Stop) para detener la 
reproducción.

Windows

En el cuadro de diálogo de búsqueda, 
seleccione la carpeta deseada en el menú 
emergente situado en la parte superior, o 
haciendo clic en el botón Look On 
Mounted Volumes.

Cuadro de diálogo de búsqueda de archivos 
(Macintosh)
Guía de SampleCell II
Puede escuchar un archivo de muestra 
desde este cuadro seleccionando su nombre 
y haciendo clic en el botón Play. Para oír a 
partir de la mitad del archivo de muestra, 
mueva el control deslizante horizontal 
situado sobre el botón Play. Para ajustar el 
volumen de reproducción, mueva el 
control deslizante vertical.

Carga de muestras
Puede seleccionar y cargar muestras 
individualmente, o elegir Load All Samples 
en el menú SampleCell para cargar todas 
las requeridas para el instrumento.

Si no hay suficiente RAM disponible en la 
tarjeta SampleCell seleccionada para cargar 
todas las muestras para un instrumento, 
éste se cargará sin todos los datos de 
muestras. Las muestras vacías o 
"descargadas" se identifican por el nombre 
de zona o grupo de notas, en cursiva.

Cuadro de diálogo de búsqueda de archivos 
(Windows)



Para crear espacio para nuevas muestras, 
puede que sea preciso descargar algunas de 
la memoria.

Para descargar de la memoria muestras sin 
usar:

■ Elija SampleCell > Delete Unused 
Samples.

Control de carga de muestras

Una vez abiertos los archivos de 
instrumento, puede controlar el orden en 
que se cargarán las muestras, mediante la 
reorganización de los instrumentos en sus 
bancos.

Opción Automatically Load Samples

Cuando está seleccionada, esta opción 
indica a SampleCell que elimine de la RAM 
muestras que no se usen, para abrir un 
banco o instrumento. 

Trabajo con bancos
Una vez cargados todos los archivos de un 
banco, aparece la ventana de éste.

Vistas de banco
SampleCell ofrece dos vistas de banco, una 
completa y otra de tamaño reducido. La 
vista completa representa la tira de cada 
canal expandida para todos los 
instrumentos de un banco. En vista 
reducida puede organizar los bancos en 
sentido horizontal.
Para alternar entre las dos vistas:

■ Elija Windows > Switch Bank View.

Para configurar como predeterminada la vista 
reducida:

1  Elija SampleCell > Preferences.

2  Seleccione Default to Small Bank View.

Para editar parámetros en vista reducida:

■ Para ajustar un parámetro, haga clic en el 
botón correspondiente y realice las 
modificaciones deseadas. Pulse la tecla 
Opción y haga clic para restablecer la 
configuración predeterminada de un 
parámetro. 

Puede elegir otras opciones de 
visualización adicionales, si lo desea. Es 
posible mostrar parámetros de instrumento 
tales como sintonía, filtro, envolvente y 
amplitud. La mayoría de estos parámetros 

Vista completa

Vista reducida
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se encuentran en las ventanas Sample Map, 
Misc, Envelopes, Matrix, Trackers y 
Modulators. Véase "Preferencias de 
visualización" en la página 100 para más 
información.

Creación de un banco
Cuando trabaje con instrumentos y 
muestras procedentes de diversos 
volúmenes fuente (varios CD-ROMs, por 
ejemplo) tendrá que organizar en un banco 
todos los archivos de un mismo volumen.

Para gestionar archivos procedentes de 
varios CD-ROMs, cree un banco para cada 
disco. Esto puede facilitar su trabajo.

Para crear un banco:

1  Elija File > New.

2  Seleccione la opción Bank y haga clic en 
OK.

– o –

Elija File > Save Bank As. De este modo 
puede guardar en una operación varias 
muestras e instrumentos, igual que cuando 
guarda en el disco duro elementos 
procedentes de un CD-ROM.

Cuadro de diálogo Select New Document Type
Guía de SampleCell II
Carga de instrumentos en un 
banco
Debe cargar uno o varios instrumentos en 
un banco nuevo. También puede añadir 
instrumentos a un banco existente, 
siempre y cuando disponga de suficiente 
memoria.

▲ Importante: Detenga el secuenciador 
siempre que vaya a abrir archivos de 
instrumento o bancos, o al abrir la ventana 
Edit Loops, para evitar bloqueos de notas.

Para cargar un instrumento en una ventana 
de banco abierta:

1  Elija File > Open y localice las carpetas 
que contienen los instrumentos para 
cargar.

Apertura de un instrumento (Macintosh)

Apertura de un instrumento (Windows)



2  Seleccione el instrumento deseado y haga 
clic en Open, o haga doble clic en el 
nombre del instrumento.

✽ En este cuadro de diálogo también pueden 
seleccionarse y cargarse muestras. La 
muestra seleccionada se cargará en un nuevo 
instrumento de muestra única del banco 
actual, o en un banco nuevo si no hay ninguno 
abierto.

3  Si utiliza más de una tarjeta SampleCell, 
seleccione la deseada para cargar el 
instrumento.

4  Repita la operación para el resto de los 
instrumentos.

No es posible abrir un mismo instrumento 
en más de un banco con la misma tarjeta 
SampleCell. No volverán a cargarse 
muestras requeridas por el instrumento si 
dichas muestras se encuentran ya en la 
memoria.

Instrumento en un banco
✽ Si le resulta difícil dar cabida a ciertos 
instrumentos en la memoria disponible, puede 
utilizar versiones reducidas que encontrará en 
el CD-ROM de SampleCell. Los archivos 
correspondientes contienen el sufijo "lm" 
("low memory") y están ubicados en la carpeta 
del instrumento en cuestión.

Trabajo con varios bancos
Puede tener varios bancos abiertos y activos 
al mismo tiempo. Por ejemplo, puede abrir 
bancos que contengan instrumentos para 
diversas canciones o conjuntos. O puede 
haber un banco que contenga un conjunto 
de percusión para rock y otro banco para 
jazz. Esta organización modular puede 
servir para facilitarle las tareas de 
configuración de bancos e instrumentos 
con diversas canciones y fuentes. Siempre 
que sea posible, agrupe archivos en bancos 
diferentes, según sus CD-ROMs originales.

Uso de varias copias de un 
instrumento en un banco
Una técnica de producción habitual 
consiste en utilizar dos sonidos idénticos 
ligeramente desafinados entre sí. Pero para 
implementar este tipo de efecto se 
necesitan dos instrumentos idénticos en la 
memoria. Aunque la cantidad de memoria 
extra requerida es mínima, ya que se 
reutilizan las mismas muestras, SampleCell 
no permite cargar más de una vez en un 
banco un archivo de instrumento; y ciertos 
parámetros de muestra son globales, es 
decir, los valores específicos de muestra en 
el cuadro de diálogo Sample Parameters 
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afectan a todos los instrumentos en los que 
se use la muestra.

Puesto que es posible ajustar de modo 
independiente los parámetros de dos 
instrumentos, puede copiar un 
instrumento y pegar la copia en el mismo 
banco para obtener efectos de coro o 
similares.

Para hacer una copia de un instrumento 
dentro de un banco:

1  Seleccione el instrumento que desea 
copiar haciendo clic en el nombre 
correspondiente.

2  Elija Edit > Copy Instrument.

3  Haga clic en el espacio en blanco en la 
ventana de banco donde desea colocar la 
copia.

4  Elija Edit > Paste.

Control de muestras utilizadas en varios 
instrumentos

Al copiar y pegar para crear un duplicado 
de un instrumento, parámetros de muestra 
tales como Panning y Loop Detune pueden 
editarse independientemente de los del 
instrumento original. Otros parámetros, 
entre ellos Sample Select Coarse/Medium, 
Zone Start y Sample Detune, son globales y 
afectarán a todos los instrumentos que 
contengan la muestra en cuestión. Esto se 
debe a que los instrumentos copiados 
referencian las mismas muestras (lo que 
permite a SampleCell conservar RAM).
Guía de SampleCell II
Eliminación de instrumentos de 
un banco
La eliminación de instrumentos de un 
banco es tan fácil como la adición.

Para eliminar un instrumento de un banco:

1  Seleccione el instrumento que desea 
eliminar haciendo clic en el nombre 
correspondiente.

2  Elija Edit > Cut Instrument, o Edit > Clear 
Instrument.

✽ El comando Cut Instrument coloca una 
copia del instrumento en el portapapeles, 
pero no ocurre así con el comando Clear 
Instrument. Tenga en cuenta que la acción de 
este comando es irreversible.

La eliminación de muestras puede tardar 
un tiempo, debido a que SampleCell 
"reorganiza" las muestras restantes en la 
memoria liberada.

Métodos alternativos de 
introducción de datos
La mayoría de instrumentos y parámetros 
de banco de SampleCell se ajustan 
mediante botones y controles deslizantes 
en pantalla.

Los controles Lo/Hi y MIDI Channel abren 
listas emergentes para configurar dichos 
parámetros.

Existen varios métodos alternativos y 
métodos abreviados para introducir valores 
aplicables a muchos de los parámetros de 
SampleCell. Entre estos métodos se 
incluyen controles deslizantes de 



SampleCell para control MIDI (rueda de 
modulación para filtrar, por ejemplo), así 
como edición de números o texto a través 
del teclado o un dispositivo de entrada 
MIDI.

✽ La comunicación MIDI entre su 
secuenciador y SampleCell y la asignación de 
matriz de SampleCell permiten el control 
directo de parámetros de SampleCell. La 
ventana Matrix se describe en el 
Capítulo 5: Creación y modificación de 
instrumentos.

Para manipular un control deslizante de 
SampleCell mediante un dispositivo MIDI:

1  Pulse la tecla Control y haga clic 
(Macintosh) o haga clic con el botón 
derecho del ratón (Windows) en el control 
deslizante que desea ajustar. Aparecerá un 
icono que representa un conector MIDI.

2  Use la rueda de modulación, el joystick, 
el pedal, el control deslizante para datos u 
otro controlador continuo de su 
dispositivo MIDI para asignar dicho 
controlador al control deslizante de 
SampleCell seleccionado, y ajústelo a 
través de MIDI.

3  La asignación del control deslizante al 
control en pantalla se mantendrá hasta que 
vuelva a hacer clic con el ratón. Haga clic 
sobre otro punto de la pantalla SampleCell 
para salir del modo de edición MIDI.

Asignación de panorámico de audio a un controlador 
MIDI externo
Para especificar un número de nota MIDI 
desde un dispositivo MIDI para definir el 
rango de notas MIDI de un instrumento:

1  Pulse la tecla Control y haga clic 
(Macintosh) o haga clic con el botón 
derecho del ratón (Windows) en el nombre 
de nota Lo o Hi (por ejemplo, "A0"). 
Aparecerá un icono que representa un 
conector MIDI.

2  Toque la nota deseada en el teclado 
controlador MIDI.

Para ajustar un control deslizante de 
SampleCell mediante el teclado:

1  Pulse la tecla Control y haga clic 
(Macintosh) o haga clic con el botón 
derecho del ratón (Windows) en el valor 
actual del control deslizante o en otro 
control, para poner el valor en modo de 
introducción directa. Aparecerá el icono de 
control MIDI.

2  Ajuste el valor escribiendo + o pulse las 
teclas de dirección "arriba" o "derecha" para 
aumentar el valor desde el teclado; escriba - 
o pulse las teclas de dirección "abajo" o 
"izquierda" para reducir el valor.

3  Haga clic para salir de este modo de 
introducción remota.

Para recuperar un valor predeterminado:

■ Mantenga pulsada la tecla Opción 
(Macintosh) o Alt (Windows) mientras 
hace clic en el parámetro deseado.
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Configuración del canal 
MIDI
El canal MIDI de instrumentos existentes 
puede configurarse mediante el menú 
emergente de canal MIDI, en la tira del 
instrumento.

Para configurar el canal MIDI de un 
instrumento:

1  Haga clic en el número sobre el indicador 
MIDI Chan. Se abrirá un menú.

2  Arrastre para resaltar el número de canal 
deseado.

✽ Al crear instrumentos, SampleCell puede 
asignar automáticamente un canal MIDI a 
cada nuevo instrumento. Para más detalles, 
véase "Try to Assign Unused MIDI Channel for 
New Instruments" en la página 100.

Configuración de zonas MIDI
Al cargar por primera vez un instrumento en 
un banco, responde al rango completo de 
notas MIDI. El rango de respuesta puede 
cambiarse para cada instrumento. Por 
ejemplo, para crear un teclado dividido 
puede necesitar un sonido grave que 
responda sólo a notas por debajo de C2 y un 
órgano que responda a notas C2 y superiores. 
Los teclados emergentes de notas Hi/Lo 
facilitan la definición de puntos divisorios 
mediante la configuración de rangos de 
notas altas y bajas para el instrumento.

Configuración de canal MIDI (vista reducida)
Guía de SampleCell II
Para cambiar la nota MIDI más baja a la que 
un instrumento debe responder:

1  Haga clic en el icono de teclado situado a 
la derecha de Lo. Aparecerá un teclado 
emergente.

2  Arrastre el puntero a lo largo del teclado 
para resaltar la nota deseada. El 
instrumento dejará de responder a notas 
por debajo de la seleccionada.

Para cambiar la nota MIDI más alta a la que 
un instrumento debe responder:

1  Haga clic en el icono de teclado situado a 
la derecha de Hi. Aparecerá un teclado 
emergente.

2  Arrastre el puntero a lo largo del teclado 
para resaltar la nota deseada. El 
instrumento dejará de responder a notas 
por encima de la seleccionada.

También puede pulsar la tecla Control 
mientras hace clic en el valor Hi/Lo e 
introduce un nuevo valor reproduciendo 
una nota en su teclado MIDI.

☞ Las zonas y canales pueden guardarse 
como elementos predeterminados de un 
instrumento. Para información sobre el 
comando Set Instrument Default, véase el 
Capítulo 8: Interfaz SampleCell II.

✽ Puede crear y guardar instrumentos como 
plantillas y almacenarlas para reutilizarlas con 
nuevos instrumentos. Véase "Plantillas" en la 
página 79 para más información.

Configuración de la nota MIDI Lo



Asignación de salidas de 
audio
La semejanza de los paneles de control de 
instrumentos con una consola de mezclas 
tiene una razón. Las funciones que llevan a 
cabo son casi idénticas; cada instrumento 
actúa de modo muy parecido al de un canal 
de una consola tradicional y SampleCell 
tiene un instrumento musical real cargado 
en cada canal.

Cada instrumento puede dirigirse a 
cualquiera de los cuatro pares de salida de 
audio en la tarjeta SampleCell a la que esté 
asignado. Al igual que podría tener piano, 
graves y batería con recepción en canales 
MIDI diferentes, sus respectivas salidas de 
audio podrían dirigirse a tres salidas estéreo 
diferentes en la tarjeta SampleCell. Éstas a 
su vez podrían dirigirse a tres pares estéreo 
distintos en una consola de mezclas para 
submezclas. Asimismo, cada par de salida 
en un vídeo o una película podría dedicarse 
a una combinación diferente (por ejemplo, 
música y efectos, Foley, sonido ambiente).

Para asignar un instrumento a un par de 
salida de audio:

■ Haga clic en el botón de salida asociado 
con el par de salida deseado. El audio del 
instrumento aparecerá sólo en las salidas 
correspondientes.

Configuración de canales de salida
Sólo puede haber seleccionado un par de 
salida para un instrumento en un 
momento dado.

Si utiliza SampleCell TDM, al cambiar los 
controles de asignación de salida analógica 
también cambia la dirección de la señal en 
TDM.

☞ La salida de audio puede guardarse como 
opción predeterminada de un instrumento. 
Para información sobre el comando Set 
Instrument Default, véase el 
Capítulo 8: Interfaz SampleCell II.

Panorámico de audio de un 
instrumento
El panorámico de audio determina el 
equilibrio del instrumento dentro del par 
estéreo seleccionado. Por ejemplo, si está 
seleccionado el par Output 1-2, al ajustar el 
panorámico en el extremo izquierdo se 
envía un instrumento mono sólo a Output 
1; al ajustar el panorámico en el extremo 
derecho se enviaría sólo a Output 2.

Los instrumentos estéreo envían al 
extremo izquierdo los canales de número 
impar, y al extremo derecho los de número 
par.

El control deslizante de panorámico de 
audio cambia de posición el centro de la 
imagen estéreo del instrumento. Los 
valores negativos ponderan el sonido hacia 
la salida izquierda y los positivos hacia la 
derecha. 
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Para cambiar el panorámico de audio de 
muestras individuales dentro de la imagen 
estéreo del instrumento, véase 
"Panorámico de audio de grupos de notas" 
en la página 48.

Para ajustar el panorámico de audio de un 
instrumento dentro del par de salida 
seleccionado:

■ Arrastre el control deslizante de 
panorámico de audio en la dirección 
deseada. El número dentro del control 
deslizante indica el valor exacto de 
panorámico de audio.

Para información sobre modulación de 
panorámico con LFO y otras fuentes de 
modulación, véase "Modulación de matriz" 
en la página 55.

☞ El panorámico de audio puede guardarse 
como opción predeterminada de un 
instrumento. Para información sobre el 
comando Set Instrument Default, véase el 
Capítulo 8: Interfaz SampleCell II.

Control de panorámico de instrumento
Guía de SampleCell II
Silenciamiento y aislamiento 
de un instrumento
Al igual que una consola de mezclas, el 
silenciamiento hace inaudible el 
instrumento asociado, mientras que el 
aislamiento asegura que sólo se oye el 
instrumento al que se aplica la acción.

Puede haber varios instrumentos 
silenciados o aislados simultáneamente. Al 
aislar un instrumento se silencian todos los 
demás en los bancos que haya abiertos.

Para silenciar un instrumento:

■ Haga clic en el botón Mute 
correspondiente.

Para reactivar el funcionamiento normal, 
vuelva a hacer clic en el botón Mute. 
Mantenga pulsada la tecla Opción 
(Macintosh) o Alt (Windows) para anular el 
silenciamiento de todos los instrumentos.

Para aislar un instrumento:

■ Haga clic en el botón Solo 
correspondiente.

Para reactivar el funcionamiento normal, 
vuelva a hacer clic en el botón Solo. 
Mantenga pulsada la tecla Opción 
(Macintosh) o Alt (Windows) para anular el 
aislamiento de todos los instrumentos. 

Botones Solo y Mute



Volumen de instrumentos
El volumen principal de un instrumento se 
atenúa con su correspondiente atenuador 
de volumen.

Para cambiar el volumen de un instrumento:

■ Arrastre el control deslizante del 
atenuador de volumen hasta el nivel 
deseado. El número que aparece dentro del 
control deslizante indica la medida exacta.

✽ Pulse la tecla Control y haga clic 
(Macintosh) o haga clic con el botón derecho 
del ratón (Windows) en el atenuador de 
volumen para asignar temporalmente un 
controlador MIDI (rueda de modulación, etc.) a 
un volumen de instrumento.

Clipping

Cuando hay muchos instrumentos 
reproduciéndose simultáneamente a 
volúmenes altos, puede producirse 
clipping en las salidas de SampleCell. 
Compruebe la estructura de ganancia de su 
sistema de audio (es decir, los niveles 
relativos de cada componente: SampleCell, 
nivel de entrada y salida del mezclador, 
ganancia de amplificador y nivel de salida 
de amplificador).

Atenuador de volumen de instrumento
✽ El volumen puede guardarse como opción 
predeterminada de un instrumento. Para 
información sobre el comando Set Instrument 
Default, véase el Capítulo 8: Interfaz 
SampleCell II.

Comentarios sobre 
instrumentos y bancos
SampleCell permite introducir 
comentarios acerca de instrumentos y 
bancos. Los comentarios aparecen el 
cuadro de diálogo Open File al seleccionar 
un instrumento o banco determinado.

Para introducir o editar comentarios acerca 
de un banco o instrumento:

1  Con un archivo de banco abierto, elija 
File > Get Bank Info.

– o –

2  Seleccione un instrumento y elija 
Instruments > Get Instrument Info (o haga 
clic en el botón Info).

3  Introduzca o edite los comentarios 
deseados.

4  Al cerrar la ventana, los comentarios se 
guardan en el archivo de banco activo.

Los comentarios asociados a instrumentos 
también se introducen en esta ventana. 
Estos comentarios también permanecen 
asociados a estos instrumentos al usarlos en 
otros bancos.
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Afinación de instrumentos
SampleCell no tiene controles globales de 
afinación de bancos. Cada instrumento 
posee sus parámetros de afinación 
individuales. Estos controles se encuentran 
en la ventana Misc de cada instrumento.

Para acceder a los controles de afinación de 
un instrumento:

1  Seleccione el instrumento en la ventana 
del banco.

2  Elija Windows > Misc o haga clic en Misc 
en la barra de herramientas del banco.

Para transportar la octava del instrumento:

■ Arrastre el control deslizante Pitch 
Octave a la posición deseada. El rango 
puede ajustarse hasta tres octavas hacia 
arriba y tres octavas hacia abajo, con 
relación al tono original.

Botón Misc

Ventana Misc
Guía de SampleCell II
Para transportar un instrumento en 
semitonos:

■ Arrastre el control deslizante Pitch 
Semitone a la posición deseada. El rango 
puede ajustarse ±12 semitonos con relación 
al tono original.

La afinación precisa es muy importante 
cuando se quiere obtener un efecto 
desafinado o de coro entre dos copias 
idénticas de un instrumento.

Para afinar con precisión o desafinar un 
instrumento:

■ Arrastre el control deslizante Detune a la 
posición deseada. El rango puede ajustarse 
±1/4 de tono con relación al tono original.

✽ Cada muestra puede afinarse 
individualmente desde la ventana Sample 
Parameters. Véase "Parámetros de muestra" 
en la página 49.

Equal Detune

El control deslizante Detune responde de 
modo diferente en distintos rangos de un 
instrumento, según el valor del parámetro 
Equal Detune seleccionado en la ventana 
Misc.

Equal Detune desactivado. Cuando la 
opción Equal Detune está desactivada, la 
reproducción de SampleCell se basa en la 
afinación exponencial y el control 
deslizante Detune modifica la afinación de 
todas las notas según el número de 
centésimas seleccionado (una centésima = 
1/100 de un semitono). Es decir, una 
desafinación de -5 centésimas producirá el 
mismo efecto a través de todo el rango de 
un instrumento. A1 sonará tan "bemol" 



como A6 o D7. Esto se debe a que el desfase 
en centésimas es logarítmico.

Equal Detune activado. Cuando la opción 
Equal Detune está activada, el efecto del 
control deslizante Detune varía según la 
frecuencia. El control deslizante Detune 
producirá desafinación en incrementos de 
ciclos por segundo o Hz. El control 
deslizante Detune dará la impresión de 
producir un efecto más evidente con notas 
de registro bajo que con notas de registro 
alto. Con la opción Equal Detune activada 
y un valor -5 para el parámetro Detune, A1 
(55,0 Hz) sonará más "bemol" que A6 
(1760,0 Hz), porque 5 Hz por debajo de A1 
es casi un semitono (G#1 = 51,91 Hz) 
mientras que 5 Hz por debajo de A6 es una 
mera fracción de un semitono. Esto se debe 
a que el desfase en Hz es lineal.

Puede que le resulte interesante 
experimentar con la opción Equal Detune 
en instrumentos antiguos o no 
occidentales. También puede usar la 
opción para ajustar bucles a otros 
compases. Es posible que aporte el cambio 
de velocidad (velocidad de 
reproducción/tono) necesario para que 
todo encaje a la perfección.
Guardar un banco
Una vez configurado un banco con 
instrumentos y sus parámetros básicos, 
debe guardar el banco para poder utilizarlo 
en el futuro.

Puede guardar todos los instrumentos y 
muestras asociadas a un banco mediante el 
comando Save Bank As.

▲ Asigne nombres exclusivos a bancos, 
instrumentos y muestras al guardarlos. 
SampleCell no distingue automáticamente 
entre bancos, instrumentos y muestras, por lo 
que existe riesgo de sobrescribir una muestra 
si asigna un nombre idéntico a un instrumento 
en la misma ubicación que la muestra.

Para guardar el banco actual con el nombre y 
destino originales:

■ Elija File > Save Bank.

Para guardar un banco con un nombre o un 
destino nuevo:

1  Elija File > Save Bank As.

2  Escriba el nombre deseado y elija el 
destino.

3  Puede optar por una de las siguientes 
acciones para guardar los instrumentos 
asociados al banco:

• Haga clic en Don’t Save para evitar 
guardar nuevas copias de los 
instrumentos del banco en una nueva 
ubicación.

• Haga clic en Cancel para guardar el 
banco sin cambiar ninguno de sus 
instrumentos.

• Haga clic en Save para guardar los 
instrumentos asociados.
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4  Puede optar por una de las siguientes 
acciones para guardar las muestras 
asociadas a cada instrumento:

• Haga clic en Don't Save para evitar 
guardar las muestras.

• Haga clic en Cancel para guardar el 
instrumento sin cambiar ninguna de 
las muestras.

• Haga clic en Save para guardar todas 
las muestras en la carpeta del banco 
recién guardado.

Para guardar todos los instrumentos y bancos 
modificados:

■ Elija File > Save All Changed.

Cierre de un banco

Para cerrar un banco abierto:

■ Haga clic en el cuadro de cierre de la 
ventana del banco o elija File > Close.

✽ Para más información sobre el cierre de 
bancos de SampleCell, véase "Automatically 
delete unused samples..." en la página 99.
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Guardar un instrumento
La mayoría de los parámetros descritos en 
este capítulo se guardan como parte de un 
banco, y no con el instrumento. Si se 
modifica el comentario sobre un 
instrumento o cualquier parámetro 
asociado a un instrumento, es preciso 
guardar el instrumento para conservar los 
cambios realizados. Aunque se le recordará 
automáticamente que guarde los cambios a 
instrumentos al cerrar un banco, también 
puede guardar instrumentos 
manualmente.

Para guardar un instrumento con el nombre y 
destino originales:

■ Elija File > Save Instrument.

Para guardar un instrumento con un nombre o 
un destino nuevo:

1  Elija File > Save Instrument As.

2  Escriba el nombre deseado y elija el 
destino para el instrumento.

3  Puede optar por una de las siguientes 
acciones para guardar las muestras 
asociadas con el instrumento:
• Haga clic en Don't Save para cerrar sin 

copiar las muestras.
• Haga clic en Cancel para guardar el 

instrumento sin cambiar ninguna de las 
muestras.

• Haga clic en Save para guardar todas las 
muestras asociadas antes de cerrar.

Para guardar todos los instrumentos y bancos 
modificados:

■ Elija File > Save All Changed.



Finalización de una sesión
Los bancos y sus instrumentos asociados 
pueden contener modificaciones que se 
perderán a menos que se guarden 
debidamente.

Para salir de SampleCell:

■ Elija File > Quit (Macintosh) o File > Exit 
(Windows).

Uso de SampleCell 
después de finalizar una 
sesión
Puede configurar SampleCell Editor para 
que las muestras queden cargadas en la 
RAM después de cerrar el programa.

Al anular la selección de la opción de 
preferencia Automatically Delete Unused 
Samples, es posible cerrar SampleCell 
teniendo un banco abierto, y los 
instrumentos del banco seguirán 
disponibles y podrán activarse desde el 
secuenciador.

Para más detalles, véase "Automatically 
delete unused samples..." en la página 99.
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capítulo 5

Creación y modificación de instrumentos
Este capítulo explica las funciones de 
edición de instrumentos de SampleCell.

Los controles de SampleCell para volumen, 
panorámico de audio, salida de audio, 
canal MIDI y rango se asocian a bancos. Los 
bancos agrupan estos controles junto con 
parámetros de ejecución. Para información 
sobre controles de banco, véase el 
Capítulo 4: Guía de uso de SampleCell.

Instrumentos
Un instrumento es una agrupación de 
muestras que puede usarse repetidamente. 
Cada instrumento debe formar parte de un 
banco para poder editarse. Es posible cargar 
instrumentos desde CD-ROM y editarlos, o 
crear instrumentos (que deben incluirse en 
bancos) y configurarlos con muestras 
personalizadas, asignaciones de notas y 
parámetros de modulación. 

Cada instrumento tiene sus propios 
parámetros, a los que se accede haciendo 
clic en los siguientes botones de la barra de 
herramientas Edit:
Capí
Ventana Misc

La  ventana Misc tiene controles deslizantes 
de afinación, prioridad, superposición, 
respuesta, tono y cantidad de filtro. Esta 
ventana contiene también las casillas 
Instrument Crossfade, Monophonic, Key 
Track, Equal Detune y Disable MIDI 
Volume/Pan.

Ventana Envelope

La ventana Envelope contiene tres 
envolventes de cuatro puntos y los 
controles adicionales Keyboard Track, 
Envelope Amount y Gate Time.

Ventana Matrix

La  ventana Matrix es una herramienta de 
asignación de modulación que permite 
asignar gran número de fuentes de control 
de modulación a parámetros de destino.
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Ventana Modulators

La ventana Modulators contiene dos LFO 
con los controles Speed y Amplitude, y los 
menús emergentes de forma y activación. 
También encontrará en esta ventana los 
controles Ramp y MIDI Controller.

Ventana Trackers

La ventana Trackers contiene una gráfica 
con nueve puntos críticos para trazar 
curvas de respuesta personalizadas para 
cualquier parámetro. 

Menú Windows

Los elementos disponibles en el menú 
Windows varían según los instrumentos 
sean de muestra única o multimuestra 
(véase "Creación de instrumentos" en la 
página 36 para más detalles).

Creación de instrumentos
Las características globales de un 
instrumento se definen mediante 
elementos:

Instrumentos de muestra única o 
multimuestra

SampleCell tiene dos tipos de instrumentos 
básicos: de muestra única y multimuestra.
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Los instrumentos de muestra única tienen 
un solo grupo de notas, una sola zona de 
velocidad y carecen de rutas de modulación 
(los efectos de sonido y los bucles suelen ser 
instrumentos de muestra única). Por esta 
razón, los controles Envelope, Matrix, 
Modulators y Trackers no están disponibles 
para instrumentos de muestra única. 

Los instrumentos multimuestra pueden 
tener varios grupos de notas, varias zonas 
de velocidad y varias rutas de modulación. 
Este tipo de instrumentos puede 
modificarse en cualquiera de las ventanas 
de edición de instrumentos.

Cada una de las tarjetas SampleCell II 
instaladas en su sistema puede contener 
hasta 50 instrumentos mono multimuestra y 
10 instrumentos mono de muestra única, y 
hasta 25 instrumentos estéreo multimuestra 
y 5 instrumentos estéreo de muestra única. 

Instrumentos mono o estéreo

Un instrumento puede ser mono o estéreo. 
La característica mono/estéreo de las 
muestras que vayan a usarse en un 
instrumento determinará el modo en que 
debe definirse el nuevo instrumento.

▲ Cuando se cargan muestras mono en 
instrumentos estéreo, la muestra mono usará 
un máximo de dos voces. Es preferible crear 
instrumentos individuales cuando se usan 
muestras de ambos tipos, mono y estéreo. 



Para crear un instrumento:

1  En un banco abierto, elija File > New o 
haga clic en el botón de creación de la barra 
de herramientas de edición. 

2  Seleccione el tipo de instrumento que 
desea crear y haga clic en OK.

3  Elija Windows > Sample Map.

✽ Puede configurar SampleCell para que cree 
un instrumento al arrastrar varios archivos de 
sonido hasta el editor. Véase "Make one 
Instrument" en la página 99.

Botón de creación

Cuadro de diálogo Select New Document Type
Capí
Adición e importación de 
muestras
Después de crear un instrumento de 
muestra única o multimuestra, puede 
añadirle muestras. SampleCell permite 
añadir o sustituir muestras 
individualmente o en lotes de grupos de 
notas durante la creación de instrumentos. 

✽ Las zonas de velocidad deben añadirse 
individualmente.

Para añadir un grupo de notas nuevo:

1  Elija Instruments > New Key Group, o 
haga clic en el botón de nuevo grupo de 
notas de la ventana Sample Map:

2  Seleccione una muestra para importar. 
Puede seleccionar regiones dentro de 
archivos de sonido, o archivos enteros.

3  Haga clic en el botón Play para oír la 
muestra con el tono original.

4  Haga clic en Open para cargar la muestra 
seleccionada. El nuevo grupo de notas se 
sitúa en C8. 

Botón de nuevo grupo de notas

Cuadro de diálogo de creación de grupos de 
notas/zona de velocidad (Windows)
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El grupo adyacente a la izquierda con un 
rango de más de una nota se comprime 
para dar cabida al nuevo grupo; cualquier 
grupo intermedio de una nota se desplaza 
una nota hacia la izquierda.

Para cargar un lote de grupos de notas 
(Macintosh):

1  Elija Instruments > Add Multiple Key 
Groups.

✽ En Windows, pueden añadirse varios 
archivos ubicados en una misma carpeta, pero 
no procedentes de carpetas distintas. Para 
añadir varios archivos desde una misma 
carpeta, elija Instruments > New Key Groups.

2  Para añadir grupos de notas, realice una 
de las siguientes acciones:
• Seleccione muestras en la lista Select Files 

to Add y haga clic en Add. 
• Haga clic en Play para oír la muestra 

seleccionada en ese momento. 
• Para añadir todo el contenido de la 

carpeta actual, haga clic en Add All. 
• Para eliminar una muestra de la lista Files 

Added, selecciónela y haga clic en 
Remove. 

Cuadro de diálogo de adición de lotes de grupos de 
notas (Macintosh)
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3  Cuando termine, haga clic en Done. 

Todos los grupos de notas nuevos se 
repartirán a intervalos regulares en el rango 
del instrumento, en la ventana Sample 
Map. 

Para cargar un lote de grupos de notas 
mientras crea instrumentos: 

1  Elija SampleCell > Preferences y, a 
continuación, configure el parámetro 
"Make One Instrument when Multiple 
Sound Files are Dragged Onto the Editor":

Seleccionada. SampleCell creará un 
instrumento y cargará en él todas las 
muestras que se arrastren hasta el mismo. 

No seleccionada. SampleCell creará un 
instrumento para cada una de las muestras 
que se arrastren hasta el mismo. 

2  Arrastre todas las muestras que quiera 
hasta el icono de archivo de SampleCell (el 
instrumento debe haberse creado y 
guardado para que la función esté 
disponible).

✽ Las zonas de velocidad no pueden cargarse 
en lotes. 

Para añadir una zona de velocidad:

1  Seleccione una muestra en el grupo de 
notas al que quiere añadir una nueva zona 
de velocidad.

2  Elija Instruments > New Velocity Zone o 
haga clic en el botón de nueva zona de 
velocidad de la ventana Sample Map:

Botón de nueva zona de velocidad



3  Haga clic en una muestra para 
seleccionarla. 

4  Haga clic en el botón Play para oír la 
muestra con el tono original.

5  Haga clic en Open para cargar la muestra 
seleccionada. 

La nueva zona de velocidad se coloca en el 
rango de velocidad más alta. Se reducirá la 
zona de velocidad de la muestra 
inmediatamente inferior.
Capí
Asignaciones de muestras
Básicamente, un instrumento se compone 
de muestras que se asignan a diversos 
rangos de notas MIDI (grupos de notas) y 
velocidades (zonas de velocidad). Las 
asignaciones pueden verse y modificarse en 
la ventana Sample Map.

Para abrir la ventana Sample Map:

■ Haga clic en el icono de asignación de 
muestras del instrumento, en la ventana de 
banco, o haga doble clic en el nombre de 
un instrumento.
Ventana Sample Map

Casilla MIDI selects zone

Menú emergente 
de selección de 
instrumento

Nueva zona 
de velocidad

Límite de 
zona de 
velocidad

Zona de 
velocidad

Nuevo grupo de 
notas

Parámetros de 
muestra

Ventana de apertura de bucles
Volver a cargar muestra

Cambiar muestra

Extender grupos 
de notas

Escala de 
velocidad

Configurar 
nota base

Organizar 
grupos de 
notas por 
nota base Teclado Nota base MIDI Grupo de 

notas
Límite de grupo 
de notas
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Asignación de notas
La asignación de notas consiste en 
organizar diversas muestras en el rango 
reproducible de un instrumento 
multimuestra.

Suele ser preciso utilizar varias muestras 
para reproducir con realismo el timbre y 
rango de muchos instrumentos musicales. 
La grabación de varias muestras que 
capturan los diversos rangos dinámicos y 
de frecuencia, y la asignación de esas 
muestras a grupos de notas y zonas de 
velocidad, hacen posible la emulación de la 
fuente original con alto grado de precisión.

Todos los instrumentos multimuestra en 
los CD-ROMs de SampleCell están ya 
asignados, por lo que las siguientes 
secciones de esta guía se basarán en uno de 
éstos para ilustrar el funcionamiento de 
zonas de velocidad y grupos de notas.

Grupos de notas

Las muestras se asignan sobre el eje 
horizontal a varios rangos de notas 
denominados grupos de notas. Puede 
haber uno solo, ocupando todo un teclado, 
o hasta 60 grupos diferentes (si hay 
suficiente memoria).

Zonas de velocidad

Cada grupo de notas contiene zonas de 
velocidad. La mayoría de sonidos e 
instrumentos acústicos reales tienen 
distintos timbres dependiendo de su 
volumen. Por esta razón, se emplea la 
asignación de velocidades (además de la 
asignación de tonos) para que diversas 
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muestras grabadas con intensidad variable 
puedan asignarse a rangos de velocidad 
correspondientes.

SampleCell puede tener un máximo de seis 
muestras/zonas de velocidad por grupo de 
notas. Se activará la muestra en la zona de 
velocidad que corresponda a la velocidad 
MIDI entrante.

La ventana Sample Map mostrada en la 
Figura 7 ilustra un instrumento que utiliza 
tres zonas de velocidad y ocho grupos de 
notas.

Por lo tanto, este instrumento se compone 
de 24 muestras. Los nombres de muestras 
tienen un sufijo como, por ejemplo, p, m, o 
f, para indicar la zona de velocidad 
requerida.

También pueden usarse zonas de velocidad 
para cambiar de sonidos. Un ejemplo típico 
sería un bajo con un bajo "digitado" en la 
zona de velocidad inferior, y una muestra 
"pop" en la zona superior. Las notas que se 
ejecuten más altas activarán las muestras 
"pop", mientras que las velocidades MIDI 
más suaves activarán el bajo con 
digitación.

Figura 7.  Ventana Sample Map para 
"Bosendorfer 1"



☞ Encontrará más ejemplos sobre zonas de 
velocidad con muestras distintas en "Ideas 
para instrumentos de orquesta" en la 
página 87.

Selección de muestras (grupos de 
notas y zona de velocidad) en la 
ventana Sample Map

Para poder editar parámetros de muestra de 
grupos de notas o zona de velocidad, debe 
seleccionarse la muestra apropiada en la 
ventana Sample Map.

Para seleccionar una muestra manualmente:

■ Haga clic en el área de grupo de notas o 
zona de velocidad deseada en la ventana 
Sample Map.

– o –

■ Haga clic sobre el teclado en pantalla 
para seleccionar un grupo de notas y luego 
sobre la escala de velocidad para 
seleccionar una zona dentro del un grupo 
de notas.

Para seleccionar una muestra con el teclado 
del ordenador:

◆ Con una zona ya seleccionada, pulse la 
tecla de dirección derecha (o la tecla Tab) 
para seleccionar grupos de notas situados a 
la derecha. Pulse la tecla de dirección 
izquierda (o Mayús-Tab) para seleccionar 
grupos de notas situados a la izquierda. 
Pulse la tecla de dirección arriba o abajo 
para seleccionar una zona de velocidad 
superior o inferior.
Capí
Para seleccionar una muestra con el 
controlador MIDI:

◆ Seleccione la opción MIDI Selects Zone, 
en la esquina superior derecha de la 
ventana Sample Map.

Con esta opción seleccionada, al tocar una 
nota en el controlador MIDI se selecciona 
la muestra de la velocidad y rango de nota 
MIDI apropiados. Se pueden seleccionar 
grupos de notas o zonas vía MIDI durante 
la edición en la ventana Sample 
Parameters.

Edición de grupos de notas
Cuando las muestras se cargan en una 
ventana Sample Map de un instrumento, 
hay varias formas de editar su ubicación y 
el ancho del grupo de notas. Además, es 
posible editar varios parámetros de grupo 
de notas (por ejemplo, Zone Start; o el 
punto de la muestra en que se iniciará la 
reproducción) en la ventana Sample 
Parameters. Al mover un grupo de notas, 
todas las zonas de velocidad del grupo de 
mueven juntas, y el grupo conserva el 
mismo valor de ancho (es decir, el rango de 
notas) después de moverse.

Traslado, edición, sustitución y 
eliminación de muestras
Hay muchas formas de reorganizar y volver 
a crear las muestras que integran la ventana 
Sample Map de un instrumento.

Puede reordenar grupos de notas 
manualmente arrastrándolos a nuevas 
ubicaciones, y puede modificar el tamaño 
de los mismos arrastrando sus límites 
tulo 5: Creación y modificación de instrumentos 41



42
superiores o inferiores. Además puede usar 
varios botones de funciones especiales para 
que SampleCell reorganice los grupos de 
notas automáticamente.

Para arrastrar un grupo de notas a una nueva 
ubicación:

■ Arrastre a una nueva ubicación la zona 
de velocidad inferior de un grupo de notas. 
Todas las zonas de ese grupo se moverán y 
mantendrán su tamaño (rango).

El comando Reorder Key Groups By Root 
Note reasigna grupos de notas según la 
nota base, de la más baja a la más alta. Si 
acaba de cargar varias muestras, este 
comando constituye un modo rápido de 
organizarlas por nota base en la ventana 
Sample Map.

Si hay varias zonas de velocidad en el grupo 
de notas, se mueven con el grupo. Es decir, 
todas las zonas se reasignarán según la nota 
base de la zona de velocidad más baja en el 
grupo de notas. Véase "MIDI Root Note" en 
la página 45 para más detalles.

Para organizar la ubicación de grupos de 
notas por nota base:

■ Haga clic en el botón de reorganización 
de grupo de notas por nota base, o elija 
Instruments > Reorder Key Groups By Root 
Note.

Todos los grupos de notas de la ventana 
Sample Map actual se reorganizarán según 
su nota base MIDI.

Botón de reorganización de grupo de notas por nota 
base
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Modificación de tamaño de grupos de 
notas

El tamaño de grupo de notas puede modifi-
carse de forma manual y automática. 
Además, los límites superior e inferior de 
una zona de velocidad pueden editarse 
manualmente.

Para modificar manualmente el rango de un 
grupo de notas:

■ Arrastre la línea de límite del grupo a la 
posición deseada. El grupo adyacente se 
comprimirá o expandirá para ajustarse al 
cambio de tamaño.

Distribución de grupos de notas

Puede seleccionar grupos de notas para 
modificar su tamaño de modo que ocupen 
espacios uniformes en el teclado. Se 
igualará el ancho de los grupos a la derecha 
del que esté seleccionado (o el de todos los 
grupos si no se ha seleccionado ninguno).

Por ejemplo, la Figura 8 muestra la ventana 
Sample Map de un instrumento antes de 
usar el comando Spread Key Groups.

Botón de distribución de grupos de notas



Después de hacer clic en el botón de 
distribución de grupos de notas, la ventana 
Sample Map adopta el aspecto mostrado en 
la Figura 9.

Para distribuir uniformemente los grupos de 
notas en el rango del instrumento:

■ Haga clic en el botón de distribución de 
grupos de notas de la ventana Sample Map. 
Todos los grupos a la derecha del que está 
seleccionado y dicho grupo se distribuirán 
uniformemente en el teclado.

Figura 8.  Sample Map antes de distribuir los grupos 
de notas

Figura 9.  Sample Map después de distribuir los 
grupos de notas
Capí
Ajuste de límites de una zona de 
velocidad

Puede arrastrar los límites de zona de 
velocidad para ajustarlos manualmente.

Para modificar el rango de una zona de 
velocidad:

■ Arrastre la línea de límite de la zona a la 
posición deseada. La zona adyacente se 
comprimirá o expandirá para ajustarse al 
cambio de tamaño.

✽ El rango de todas las zonas de velocidad 
puede alterarse en una sola operación, 
pulsando la tecla Opción (Macintosh) o Alt 
(Windows) mientras arrastra el límite de una 
zona cualquiera. Tenga en cuenta que todas 
las zonas tendrán el mismo valor de límite (se 
pierden los valores relativos).

Sustitución y eliminación de 
muestras
En la ventana Sample Map es fácil sustituir 
y eliminar muestras. Así pueden crearse 
plantillas de instrumentos preasignadas 
que facilitan la creación de instrumentos.

Puede sustituir una muestra por otra con el 
botón de cambio de muestra. 

Para sustituir una muestra:

1  Seleccione la muestra que desea sustituir 
haciendo clic en el grupo de notas o la zona 
de velocidad pertinente.

2  Haga clic en el botón de cambio de 
muestra o elija Instruments > Change 
Sample.
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3  Seleccione una muestra con la que 
sustituir la seleccionada previamente.

4  Haga clic en el botón Play para oír la 
muestra con el tono original.

5  Haga clic en Open para cargar la muestra 
seleccionada. La nueva muestra aparecerá 
en la ventana Sample Map con el mismo 
grupo de notas y zona de velocidad que la 
muestra sustituida.

Para descargar una muestra seleccionada:

■ Elija Instruments > Unload Sample.

La muestra seleccionada se descargará de la 
RAM de SampleCell, y el instrumento 
conservará los límites de zona de velocidad 
y grupo de notas de la muestra descargada. 
El nombre de la muestra aparecerá en 
cursiva en la ventana Sample Map.

Para volver a cargar una muestra que se ha 
descargado:

1  Seleccione el grupo de notas/la zona de 
velocidad de la muestra.

2  Haga clic en el botón de recarga de 
muestra o elija Instruments > Load Sample.

SampleCell volverá a cargar la muestra en 
su zona o grupo.

Botón de cambio de muestra

Botón de recarga de muestra
Guía de SampleCell II
☞ Para configurar SampleCell de modo que 
cargue muestras siempre que se abra un 
banco o un instrumento, véase "Automatically 
Load Samples" en la página 100.

Cada grupo de notas de la ventana Sample 
Map puede contener un máximo de seis 
zonas de velocidad. Las muestras en estas 
zonas pueden reorganizarse dentro del 
grupo de notas arrastrando la zona a una 
nueva ubicación.

Para mover una muestra a una nueva 
ubicación de zona de velocidad:

■ Coloque el puntero sobre la muestra o la 
zona de velocidad que va a mover y arrastre 
la muestra hacia arriba o hacia abajo, hasta 
la ubicación deseada. 

Para eliminar un grupo de notas o una zona de 
velocidad:

1  Seleccione el grupo o la zona que desea 
eliminar.

2  Elija Edit > Clear. Así se eliminará de la 
ventana Sample Map el elemento 
seleccionado, pero la muestra permanecerá 
cargada en la memoria de SampleCell.

Para descargar una muestra:

1  Seleccione la muestra que desea eliminar.

2  Elija Instruments > Unload Sample.

Normalmente, las muestras permanecen en 
la memoria de SampleCell después de 
cerrar un banco o eliminar un instrumento. 
Puede configurar SampleCell para que 
descargue automáticamente todas las 
muestras al cerrar bancos o eliminar 
instrumentos. Para ello, seleccione la 
opción Automatically Delete Unused 
Samples en la ventana Preferences.



Otros parámetros de Sample 
Map

MIDI Root Note

Cuando se asigna una muestra a Sample 
Map, la muestra original debe asignarse a 
una nota base, denominada MIDI Root 
Note. La nota base no es necesariamente 
del mismo tono que la muestra (de hecho, 
la nota base predeterminada es C4), pero si 
se configura con el tono de la muestra 
original se obtendrán resultados de mayor 
realismo.

O puede personalizar sonidos configurando 
la nota base en un tono diferente. Por 
ejemplo, si carga una muestra de trompeta 
(por ejemplo, Trumpet C3) y configura la 
nota base en C4, la trompeta sonará una 
octava más baja, que podría ser un sonido 
de tuba aceptable.

SampleCell II sólo puede reproducir una 
muestra dentro de un rango de tres octavas 
más altas que el tono original; las notas por 
encima de ese rango se reproducirán en la 
octava más alta posible para la muestra.

Configuración de nota base

En ocasiones, se cargan muestras en 
SampleCell sin una definición de nota 
base. Puede abrir la ventana Sample 
Parameters para un grupo de notas e 
introducir manualmente notas base, o 
arrastrar el marcador de nota base a una 
ubicación apropiada en el teclado de la 
ventana Sample Map.
Capí
Para asignar la nota base MIDI manualmente:

1  Haga clic en el icono de teclado asociado. 
Aparecerá un teclado en pantalla.

2  Arrastre el puntero a lo largo del teclado 
para resaltar la nota base deseada.

Para configurar o cambiar la nota base en 
todos los grupos de notas de un instrumento:

1  Haga clic en el botón de configuración de 
nota base, o elija Instruments > Set Root 
Notes.

2  Elija una de estas opciones:

◆ Lowest: sitúa la nota base en la nota más 
baja del grupo de notas.

◆ Middle: sitúa la nota base en la nota 
media del grupo de notas.

◆ Highest: sitúa la nota base en la nota más 
alta del grupo de notas.

Asignación de nota base MIDI

Cuadro de diálogo de nota base

Nota base MIDI 
tu
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◆ Use Audio File: sitúa la nota base 
teniendo en cuenta uno de estos factores:

• Si la muestra es un archivo AIFF, usa la 
nota base guardada en el archivo.

• Si la muestra es un archivo SDII, usa C4 
(C medio).

3  Haga clic en OK para cambiar la nota 
base.

Botón de bucle

El botón de bucle cargará la muestra 
seleccionada actualmente en la ventana 
Edit Loops. Para más información sobre 
bucles de muestras, véase el 
Capítulo 6: Edición de muestras, bucles y 
recorte de audio.

Parámetros de muestras

El botón de diapasón abre la ventana 
Sample Parameters para el grupo de notas o 
la zona que haya seleccionado.

La ventana Sample Parameters contiene 
controles de amplitud de muestra, 
afinación, desfase de punto de inicio y 
dirección y afinación de bucle.

Botón de bucle

Botón de diapasón
Guía de SampleCell II
Para acceder a la  ventana Sample 
Parameters:

1  Seleccione un grupo de notas o una zona 
de velocidad en la ventana Sample Map.

2  Haga clic en el botón de diapasón, o 
doble clic en la muestra deseada de la 
ventana Sample Map.

Flechas de selección de muestra

Puede editar distintos parámetros de 
muestra de grupo de notas/zona utilizando 
las flechas de selección de muestra (o las 
teclas de dirección del teclado de su 
ordenador), situadas en la parte superior 
derecha de la ventana Sample Parameters:

• La flecha de dirección arriba (o la tecla 
Re Pág) selecciona la zona de velocidad 
inmediatamente superior en el grupo de 
notas actual.

• La flecha de dirección derecha (o la tecla 
Tab) selecciona la zona de velocidad 
inferior en el grupo de notas 
inmediatamente superior. 

Ventana Sample Parameters

Flechas de selección de muestra



• La flecha de dirección abajo (o la tecla 
Av Pág) selecciona la zona de velocidad 
inmediatamente inferior en el grupo de 
notas actual.

• La flecha de dirección izquierda (o las 
teclas Mayús-Tab) selecciona la zona de 
velocidad inferior en el grupo de notas 
inmediatamente inferior.

• La tecla Inicio selecciona la zona inferior 
izquierda.

También puede seleccionar muestras en sus 
grupos y zonas a través de MIDI, si está 
seleccionada la opción MIDI Selects Zone.

Parámetros de zona y 
parámetros de muestra
Los instrumentos pueden copiarse y 
pegarse para crear copias de los mismos. 
Este método hace un uso eficaz de la 
memoria para coros, redobles y otros 
efectos.

Si el banco actual usa varias copias de la 
misma muestra en uno o varios 
instrumentos simultáneamente, algunos 
de los controles disponibles en la ventana 
Sample Parameters tendrán un efecto 
global pero otros se aplicarán sólo al 
instrumento actual.
Capí
Parámetros de muestra

Los cambios aplicados a los siguientes 
parámetros de muestra se oirán en todos los 
instrumentos abiertos actualmente que 
usen la muestra en cuestión.

Sample Start Coarse, Sample Start Medium 
y Sample Fine Tuning son parámetros de 
muestra globales. También lo son Sus/Rel 
Loop Fine Enable/Fine Tune (y Sus/Rel 
Enable/Fine Tune), disponibles cuando 
existen uno o dos bucles en la muestra. 
Para más información sobre bucles, véase el 
Capítulo 6: Edición de muestras, bucles y 
recorte de audio.

Parámetros de zona (específicos para 
un instrumento)

El efecto de los siguientes controles para 
Zone Parameters y Keygroup Pan se oirá 
sólo en el instrumento que contenga la 
muestra seleccionada en ese momento.

Controles Sample Start y Sample Fine Tuning de la 
ventana Sample Parameters
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Keygroup Pan, Fine (Sample Start), MIDI 
Root Note, Direction y Amplitude son 
parámetros específicos de zona. La sección 
Start Offset refleja el desfase acumulativo 
que se va a aplicar a la muestra desde todos 
los controles Sample/Zone Start.

Parámetros de zona

Panorámico de audio de grupos 
de notas
El ajuste de panorámico de audio puede 
realizarse individualmente para cada uno 
de los grupos de notas de la ventana 
Sample Map. Esto puede ser útil, por 
ejemplo, con un piano estéreo, donde el 
panorámico de las muestras más bajas se 
ajusta más hacia la izquierda y el de las altas 
más hacia la derecha. Otra aplicación 
puede ser un instrumento de teclado 
dividido con salidas distintas resultantes de 
ajustes de panorámico extremos a canales 
opuestos.

Keygroup Pan y Zone Parameters
Guía de SampleCell II
Para cambiar el panorámico de audio de un 
grupo de notas individual:

1  Arrastre el control deslizante Keygroup 
Pan (mientras reproduce la muestra vía 
MIDI, si lo desea). Se ajustará el 
panorámico del grupo de notas completo 
dentro de la imagen estéreo del 
instrumento (tal y como se ha definido 
mediante el control deslizante de la 
ventana de banco).

✽ Pulse la tecla Control (Macintosh) o el botón 
derecho del ratón (Windows) mientras hace 
clic en el control deslizante Keygroup Pan para 
manipularlo desde su controlador MIDI.

También es posible simular el efecto de 
algo como el piano estéreo descrito 
anteriormente sin editar el panorámico de 
grupo de notas para cada muestra. Puede 
usar la ventana Matrix para asignar valores 
de número de nota MIDI para controlar 
panorámico de instrumentos. Véase 
"Modulación de matriz" en la página 55.

Inicio de zona  – control 
deslizante Fine
Es posible modificar el punto en que debe 
comenzar la reproducción dentro de una 
forma de onda de una muestra. Esto resulta 
especialmente útil cuando se desea la 
porción constante de una muestra pero no 
parte o todo el ataque inicial.

El inicio de la muestra puede ajustarse 
mediante tres controles deslizantes, dos de 
ellos son parámetros de muestra y el tercero 
(Fine) es un parámetro de zona. El control 
deslizante Fine ajusta el punto de inicio de 



la muestra en los mínimos incrementos 
posibles, y afecta sólo al instrumento 
actual.

Para ajustar el punto de inicio de muestra:

◆ Ajuste el control deslizante Fine, en la 
sección Zone Parameters de la ventana 
Sample Parameters.

Cada incremento representa 256 muestras 
para un desfase total posible de 32.512. El 
desfase actual aparece en la subsección 
Start Offset de la sección Zone Parameters.

Dirección
Una muestra puede reproducirse en modo 
Forward (de principio a fin) o Backward 
(empezando por el final). El modo 
Backward pasa por alto posibles 
configuraciones de bucle y es útil 
principalmente para efectos especiales.

Para cambiar la dirección de reproducción de 
una muestra:

◆ Haga clic en el botón Forward o en el 
botón Backward.

Amplitud
La amplitud (volumen) de una zona 
individual puede atenuarse mediante el 
control deslizante Amplitude. Esto puede 
contribuir a crear el equilibrio debido entre 
las diversas muestras integrantes de un 
instrumento.
Capí
Para atenuar el volumen de una muestra 
individual:

◆ Arrastre el control deslizante Amplitude.

Cada incremento representa 0,5 dB para un 
rango total de 50 dB.

Nota base MIDI
Los controles MIDI Root Note (teclado 
emergente y cuadro de valor editable) 
sirven para transportar la muestra. El valor 
predeterminado de MIDI Root Note es C4. 
Véase "Nota base MIDI" en la página 49 
para más información.

Parámetros de muestra
Las muestras pueden afinarse de dos 
formas. La afinación general de una 
muestra puede requerir un ajuste para 
hacer su tono compatible con otras 
muestras de un instrumento. Además, un 
bucle de sostenimiento o de liberación a 
veces puede afectar al tono durante la 
reproducción de bucle.

Para afinar la muestra seleccionada:

1  Ajuste el control deslizante Sample en la 
sección Sample Fine Tuning para aumentar 
o reducir el tono de la muestra. Puede 
ajustar los controles deslizantes mientras se 
activa la muestra vía MIDI.

El rango de control deslizante es ± 1/4 de 
tono. Si una muestra en memoria se utiliza 
con más de un instrumento, grupo de 
notas o zona de velocidad, la modificación 
mediante este método afectará a todos los 
instrumentos que utilicen la muestra.
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Afinación de bucles
Puede desafinar cualquier bucle activado 
mediante varios controles deslizantes Loop 
de la ventana Sample Parameters. 

Para afinar el bucle de 
sostenimiento/liberación:

◆ Arrastre el control deslizante Sus/Rel 
Tune para transportar la porción de bucle 
de la muestra. Podrá oír los efectos de esta 
operación mientras activa la muestra vía 
MIDI.

El rango de control deslizante es ± 1/4 de 
tono.

Para afinar la porción de bucle de 
sostenimiento de la muestra:

◆ Arrastre el control deslizante Sus Tune 
para transportar únicamente el bucle de 
sostenimiento. Este control sólo está 
activado cuando hay más de un bucle en la 
muestra. Podrá oír los efectos de esta 
operación mientras activa la muestra vía 
MIDI.

El rango de control deslizante es ± 1/4 de 
tono.

Los bucles de sostenimiento y liberación 
pueden activarse y desactivarse 
individualmente. Para más información, 
véase el Capítulo 6: Edición de muestras, 
bucles y recorte de audio.

Para activar y desactivar el bucle de 
sostenimiento:

◆ Seleccione la opción Sus/Rel Loop.

Para activar y desactivar el bucle de 
liberación:

◆ Seleccione la opción Sus Loop Enable.
Guía de SampleCell II
✽ Si una muestra tiene un solo bucle, se 
utiliza como de sostenimiento y liberación 
("sus/rel" en la ventana Sample Parameters). 
Si existen dos bucles, el primero será de 
sostenimiento y el segundo de liberación. Los 
bucles no deben superponerse.

Conmutación y afinación de bucles

Para trabajar con voces, bit de sonido y 
otras muestras habladas, la 
experimentación con dos bucles puede 
producir resultados interesantes. Use las 
ventanas Matrix y Envelope para controlar 
el equilibrio entre el primer bucle y el 
segundo y, a continuación, active y 
controle el tiempo con una de las teclas del 
controlador MIDI. Consulte la información 
sobre el botón de conmutación de bucle en 
"Edición de bucles, conmutación de bucles 
y fundidos cruzados" en la página 74.

Parámetros de Misc
La ventana Misc contiene controles para 
configurar tono, frecuencia de filtro, 
fundido cruzado, seguimiento de nota, 
seguimiento de tono, entonación, filtro 
MIDI, prioridad y superposición de voz y 
sensibilidad a velocidad.

Para abrir la ventana Misc:

■ Seleccione Windows > Misc, o haga clic 
en el botón Misc.

Botón Misc



El nombre del instrumento seleccionado 
actualmente aparece en el cuadro 
Instrument. Puede usar este cuadro en 
todas las ventanas de edición y 
modulación, para editar esos parámetros 
para un instrumento diferente.

Desactivación de seguimiento de tono

A veces puede ser conveniente reproducir 
muestras con su tono original, al margen 
de la nota MIDI que esté reproduciéndose. 
Dos ejemplos típicos son los efectos de 
sonido y la batería. Cada instrumento 
puede estar configurado para transportar 
sus muestras asociadas según los valores de 
nota MIDI, o para reproducir muestras con 
el tono original.

Para desactivar cambios de tono dentro de un 
instrumento:

◆ En la ventana Misc, anule la selección de 
Key Track. Al hacerlo, se desactiva la 
respuesta de tono.

Puede configurar SampleCell para que 
desactive los valores predeterminados de 
Key Track al crearse nuevos instrumentos. 
Esto sería conveniente cuando hay una 

Ventana Misc
Capí
serie de instrumentos en proceso de 
desarrollo y cada uno tiene una sola batería 
o un efecto de sonido.

Para desactivar Key Track de modo 
predeterminado:

1  Elija SampleCell > Preferences.

2  Desactive "Key Track".

Para más información sobre preferencias de 
SampleCell, véase el Capítulo 8: Interfaz 
SampleCell II.

Respuesta a velocidad

Una de las pocas cosas configuradas por 
cable en SampleCell II es la dirección de 
velocidad MIDI a volumen. El control 
deslizante Velocity de la ventana Misc 
permite ajustar individualmente la 
respuesta a velocidad de cada instrumento.

Para cambiar una respuesta a velocidad MIDI 
de un instrumento:

◆ En la ventana Misc, arrastre el control 
deslizante Velocity al nivel deseado.

Con un valor de velocidad 0, no hay 
respuesta a velocidad (es decir, las notas 
están activadas o desactivadas); los valores 
positivos producen incrementos de 
volumen con incrementos de velocidad, 
mientras que los negativos reducen el 
volumen según aumenta la velocidad.

✽ Si los instrumentos de diversos bancos 
parecen no responder adecuadamente a sus 
acciones, compruebe la velocidad o la curva 
de velocidad en su controlador MIDI. El ajuste 
de un dispositivo principal tendrá un efecto 
más global en todos los instrumentos de 
SampleCell.
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Un uso práctico de velocidad negativa 
consiste en hacer un fundido cruzado entre 
dos instrumentos según la firmeza con que 
se pulse una tecla. Supongamos que hay 
dos instrumentos en un banco, por 
ejemplo cuerdas y metal, asignados al 
mismo canal MIDI, y desea oír las cuerdas 
sólo cuando toca suavemente, ambos 
instrumentos tocando a velocidad media y 
sólo metales cuando toca más 
enérgicamente. Esto puede conseguirse 
asignando a las cuerdas una velocidad 
negativa moderada y a los metales una 
velocidad positiva relativamente alta.

Fundido cruzado de velocidad de 
instrumento

La ventana Misc ofrece la función 
Instrument Crossfade, que permite 
configurar el fundido cruzado entre dos 
instrumentos controlado por la velocidad. 
Esto difiere del ejemplo anterior, 
eliminando algunas de las complicaciones 
que puede plantear el control de valores de 
velocidad negativos.

Para usar la función en la ventana Misc, se 
asignan de nuevo dos instrumentos al 
mismo canal MIDI. Sólo uno de ellos se 
configura con Crossfade. Cuando se activa 
la opción Crossfade, se modifican las 
curvas de velocidad de ambos 
instrumentos en ese canal; el instrumento 
con Crossfade sólo tiene una respuesta 
significativa a velocidades bajas, mientras 
que el instrumento sin Crossfade responde 
únicamente a velocidades más altas.
Guía de SampleCell II
Para implementar el fundido cruzado entre 
dos instrumentos:

1  Configure los instrumentos para que 
respondan al mismo canal MIDI.

2  Haga clic en el botón Ins Vel Crossfade de 
la ventana Misc del instrumento que vaya a 
responder a velocidades bajas.

✽ La función Crossfade asigna dos voces para 
cada nota reproducida. Así, por ejemplo, al 
reproducir cuatro notas con un par de 
instrumentos con Crossfade, se usarán ocho 
voces.

Asignación de voces

Al igual que muchos instrumentos 
musicales electrónicos, SampleCell II 
puede asignar voces de modos diversos. Por 
ejemplo, puede hacer que un instrumento 
aislado haga sonar notas de una en una (es 
decir, que sea monofónico).

Para seleccionar respuesta monofónica:

◆ Haga clic en la casilla Monophonic, en la 
ventana Misc. El instrumento responderá 
sólo a la última nota reproducida 
("prioridad a la última nota"). Esta opción 
no debe estar seleccionada si se desea un 
respuesta polifónica.

Cuando se utilizan muchas voces 
simultáneamente (por ejemplo, como un 
piano con sostenimiento o una secuencia 
recargada), es posible que se sobrepase el 
límite de 32 voces de SampleCell. Para 
minimizar el efecto de dicha limitación, 
puede asignarse a cada instrumento una 
prioridad de sonido que SampleCell 
examinará cuando se requieran muchas 
voces.



Para ajustar la prioridad de asignación de voz:

◆ Arrastre el control deslizante Sound 
Priority en la ventana Misc hasta la 
posición deseada. 

La posición Lo es adecuada para 
instrumentos de fondo y atenuadores fijos 
donde una o dos voces "perdidas" no serían 
muy perceptibles en la mezcla de sonido 
global. La posición Hi es más apropiada 
para melodías e instrumentos en "primer 
plano", cuando no se desea perder una voz.

Además hay situaciones musicales en que 
es importante permitir la audición de las 
notas existentes aunque la tecla se suelte y 
vuelva a pulsarse inmediatamente. Un 
buen ejemplo es el de un platillo: si se toca 
dos veces seguidas se añade un transitorio; 
pero no se suprimen las vibraciones 
residuales del primer golpe. El ejemplo del 
piano es menos obvio: incluso cuando las 
notas se tocan en staccato, sigue habiendo 
una ligera vibración. Por el contrario, un 
órgano o un tambor filtrado no tienen esas 
características. SampleCell hace frente a 
esto con una función de "superposición" 
que modifica la etapa de liberación de una 
nota previa al volver a activar la misma 
nota.

Para especificar cómo deben superponerse 
las notas reactivadas:

◆ Reproduzca una en su controlador MIDI 
repetidamente mientras arrastra el control 
deslizante Overlap Amount hasta la 
posición deseada.

Un valor 0 indica que no hay 
superposición, cada nota ahoga o silencia 
notas sostenidas. Un valor de 99 representa 
la etapa completa de liberación del 
instrumento.
Capí
Envolventes
El uso principal de una envolvente es el 
control de la amplitud de un sonido; por 
esta razón, Envelope 3 de SampleCell está 
dirigido permanentemente a Amplitude. 
Pero ése no es el único uso musical posible. 
Por ejemplo, la aplicación de una 
envolvente a LFO podría producir una 
vibración retardada.

Las envolventes emiten una señal de 
control que va tomando forma con 
relación a la fuerza con que se activa una 
nota, cuánto tiempo se mantiene y lo que 
tarda en liberarse. Cuando una nota se 
activa en una envolvente tradicional ADSR 
(Attack/Decay/Sustain/Release), la señal 
aumenta desde cero hasta el nivel máximo 
de envolvente, y luego cae según la tasa de 
debilitamiento hasta un nivel sostenido. 
Este nivel se mantiene mientras la tecla esté 
pulsada; luego la señal vuelve a cero de 
acuerdo con la velocidad de liberación.

Las envolventes de SampleCell tienen 
algunas adiciones: Sustain Decay permite 
un ligero debilitamiento durante el 
sostenido y después de la etapa de 
debilitamiento formal; Gate Time 
especifica una cantidad mínima de tiempo 
en la que se mantendrá "abierta" la 
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envolvente al margen de que se sostenga la 
nota o no. Por ejemplo, cualquier acústica 
ambiental al final de un tambor se perdería 
si la nota se liberara inmediatamente 
después de producirse, a menos que se 
seleccione la opción Gate Time.

Para acceder a una envolvente:

1  Haga clic en el icono de envolvente, en la 
barra de herramientas de la ventana de 
banco o seleccione Windows > Envelope.

2  Use la barra de desplazamiento y el 
cuadro de tamaño para mostrar los 
parámetros de Envelope 1, Envelope 2 y 
Envelope 3.

Icono de envolvente

Figura 10.  Ventana Envelope (con las 3 envolventes 
visibles)
Guía de SampleCell II
Opciones de visualización de 
envolventes

Los controles de Envelope pueden 
mostrarse de diversas formas. La ventana 
Envelope puede mostrar puntos 
críticos/segmentos lineales o controles 
ADSR de tipo control deslizante. La 
Figura 10 muestra envolventes con 
segmentos lineales.

Para especificar cómo deben mostrarse los 
parámetros de envolvente:

1  Seleccione SampleCell > Preferences.

2  Lleve a cabo uno de estos 
procedimientos:
• Seleccione Display Line Segment 

Envelopes para ver segmentos lineales. 
Esto no se aplicará a una ventana 
Envelope que ya esté abierta; tendrá que 
cerrarla y volverla a abrir para que se 
implementen los cambios.

• Anule la selección de la opción Deselect 
Display Line Segment Envelopes para 
mostrar valores de envolvente en forma 
de control deslizante. 

La Figura 11 muestra una ventana 
Envelope con ese tipo de representación:

Figura 11.  Ventana Envelope, con valores en 
unidades reales



Los parámetros de envolvente se modifican 
ajustando la posición de los controles 
deslizantes o arrastrando los puntos finales, 
según el modo de visualización activo.

Los parámetros de envolvente pueden 
expresarse en milisegundos o en unidades 
de SampleCell.

Para mostrar valores de envolvente en 
unidades reales (ms):

◆ En el cuadro de diálogo Preferences, 
seleccione Display Controls in Real Units.

Para crear o modificar parámetros de 
envolvente, siga este procedimiento:

◆ Para controlar el tiempo que una 
envolvente tarda en llegar desde 0 al nivel 
configurado bajo Amplitude en la ruta de 
modulación, arrastre Attack hasta la 
cantidad deseada y suelte.

◆ Para controlar el tiempo que una 
envolvente tarda en llegar desde su nivel 
máximo a su nivel Sustain, arrastre Decay 
hasta la cantidad deseada y suelte.

◆ Para controlar el nivel en el que una 
envolvente se mantendrá mientras está 
activado un filtro de puerta, arrastre 
Sustain hasta la cantidad deseada y suelte.

◆ Para controlar el tiempo que una 
envolvente tarda en llegar desde su nivel 
Sustain a uno algo inferior, arrastre Sustain 
Decay hasta la cantidad deseada y suelte.

◆ Para controlar el tiempo que una 
envolvente tarda en llegar desde su nivel 
Sustain Decay al nivel 0, arrastre Release 
hasta la cantidad deseada y suelte.

◆ Para controlar el tiempo mínimo que 
una envolvente mantendrá un filtro de 
puerta, arrastre Gate Time hasta la cantidad 
deseada y suelte.
Capí
◆ Para determinar la cantidad de señal de 
envolvente disponible para el control 
deslizante Amplitude de ruta de 
modulación, arrastre Envelope Amplitude 
hasta la cantidad deseada y suelte.

Las envolventes también pueden ajustarse 
al teclado, de modo que los tiempos de 
envolvente se vayan acortando 
gradualmente a medida que aumenta el 
tono y se alarguen a medida que se reduzca. 
Esto es muy útil para simular instrumentos 
acústicos (por ejemplo, el movimiento del 
aire en una tuba tarda más que en una 
trompeta).

Para que una envolvente se ajuste a notas 
MIDI entrantes:

◆ Haga clic en Keyboard Track, en la 
ventana Envelope. Vuelva a hacer clic para 
volver a la normalidad.

Modulación de matriz
Las funciones de modulación de matriz 
facilitan las tareas de adaptación de la gran 
biblioteca de instrumentos de SampleCell; 
si se imaginan las muestras como formas de 
onda, SampleCell funciona como un 
sintetizador.

La modulación de matriz permite modular 
cualquier destino disponible (un 
parámetro SampleCell como 
volumen/panorámico, corte de filtro, 
envolventes, LFO, etc.), con cualquier 
fuente de control disponible (rueda de tono 
o modulación, velocidad, presión, 
controlador MIDI, etc.).
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Para acceder a los controles de modulación 
de matriz de un instrumento:

■ Seleccione el instrumento en la ventana 
de banco y haga clic en el botón de matriz 
de la barra de herramientas.

– o –

■ Elija Windows > Matrix.

Use la matriz designando rutas de 
modulación para el instrumento 
seleccionado. Cada ruta de modulación se 
compone de una fuente, un destino, un 
atributo de puerta y una cantidad de 
modulación.

Hay un total de 20 rutas de modulación 
definibles por usuario.

Icono de matriz

Ventana Matrix
Guía de SampleCell II
Para seleccionar la fuente de control para una 
ruta de modulación:

■ Seleccione la fuente en el menú 
emergente Source.

Para seleccionar el destino de una ruta de 
modulación:

■ Seleccione el destino en el menú 
emergente Destination.

Menú emergente Source

Menú emergente Destination



La cantidad de modulación determina el 
rango del efecto de modulación. Un 
ejemplo típico está relacionado con la 
dirección de Pitch Wheel a Pitch. El valor 
del parámetro Amplitude determina el 
rango máximo disponible en la rueda de 
tono del controlador MIDI.

Los valores positivos ofrecen respuesta 
normal e incrementan la intensidad de la 
asignación; los negativos crean 
modulación invertida.

Supongamos que una envolvente se dirige 
a controlar el tono: una cantidad de 
modulación positiva elevaría el tono 
durante la etapa de ataque y lo haría caer 
durante la etapa de debilitamiento; una 
cantidad negativa haría caer el tono 
durante el ataque y lo elevaría según el 
debilitamiento.

Para determinar la cantidad de modulación 
en una ruta de modulación:

■ Arrastre el controlador deslizante Amp 
para la ruta deseada.

Para configurar un valor de amplitud máximo 
(+99):

■ Pulse las teclas Opción-Mayús 
(Macintosh) o Alt-Mayús (Windows) 
mientras hace clic en el valor de amplitud 
(no en el control deslizante).

Para configurar un valor de amplitud mínimo (-
99):

■ Pulse las teclas Opción-Control 
(Macintosh) o Alt-Mayús (Windows) 
mientras hace clic en el valor de amplitud 
(no en el control deslizante).
Capí
Para restablecer un valor de amplitud 0:

■ Pulse la tecla Opción (Macintosh) o Alt 
(Windows) mientras hace clic en el valor de 
amplitud (no en el control deslizante).

Para borrar una fuente o un destino:

■ Mantenga pulsada la tecla Opción 
(Macintosh) o Alt (Windows) mientras 
hace clic en la fuente o el destino de una 
ruta de matriz definida para borrarla (el 
cuadro de fuente/destino queda en 
blanco).

Fuentes de modulación tales como 
envolventes, controladores MIDI y 
osciladores LFO poseen sus propios 
controles de amplitud. Estos establecen el 
rango máximo disponible para el 
parámetro Amplitude de ruta de matriz, de 
modo parecido a como un grifo determina 
la cantidad de agua disponible para un 
segundo grifo. 

Si usa una envolvente o controlador MIDI 
en una matriz y sus propios controles de 
amplitud están configurados en 0, no 
podrá haber modulación a través de la ruta 
de matriz. Abra la ventana Envelope, o la 
ventana Modulation, y ajuste los valores de 
amplitud de esos parámetros; luego regrese 
a la ventana Matrix y configure la amplitud 
de su ruta.

Si la cantidad de modulación de una ruta 
determinada no tiene acceso a un rango 
suficiente para el efecto deseado, rutas de 
modulación adicionales con fuentes y 
destinos idénticos tendrán un efecto 
aditivo para incrementar el rango. Puede 
que sea necesario doblar o triplicar la ruta 
de modulación para obtener el rango 
deseado.
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Modulación de panorámico de audio 
en instrumentos estéreo

Al modular el panorámico con una fuente 
como por ejemplo un LFO, debe asignar esa 
fuente a Panning dos veces en la ventana 
Matrix para que SampleCell ajuste el 
panorámico de ambos canales. El 
panorámico de los instrumentos mono se 
ajusta con una sola asignación de matriz.

Cada ruta puede ser efectiva de continuo o 
únicamente cuando se mantiene una nota 
(se pasa por un filtro de puerta). Esta 
función se aplica a las notas de modo 
individual. Un ejemplo ilustrativo de la 
utilidad de la modulación con un filtro de 
puerta es la programación de una rueda de 
variación de tono filtrada en un 
instrumento con intervalo de liberación 
largo: las notas liberadas de un acorde no 
resultarían afectadas, pero la melodía se 
reproduciría con variación de tono.

Para configurar una ruta de modulación de 
modo que sólo funcione mientras se sostiene 
una nota:

■ Haga clic en la opción Gated de la ruta de 
modulación deseada. Cuando esta opción 
está seleccionada, una ruta será efectiva 
sólo mientras una nota tenga un filtro de 
puerta. Si la opción no está seleccionada, la 
ruta de modulación está siempre activa.

En SampleCell hay varias rutas de 
modulación configuradas por cable que no 
anulan ninguna de las 20 rutas definibles 
por el usuario:
• Note Number a Pitch (notas MIDI 

controlan el tono de instrumento)
• Envelope 3 a Volume (Envelope 3 

controla el volumen de instrumento)
Guía de SampleCell II
• Velocity a Volume (velocidad MIDI 
controla el volumen de instrumento)

• Pitch Wheel a Pitch (variación de tono)

Tanto la asignación de Velocity a Volume 
como Pitch Wheel a Pitch pueden activarse 
y desactivarse en la ventana Misc. Consulte 
"Parámetros de Misc" en la página 50 para 
más detalles.

Cuando se crea un instrumento, la ventana 
Matrix del mismo se configura para cinco 
rutas de modulación predeterminadas, 
además de las configuradas por hardware 
citadas anteriormente:
• Velocity a Sample Select (velocidad MIDI 

elige la zona de velocidad en Sample 
Map)

• LFO 1 a Pitch (vibrato)
• Modulation Wheel a LFO 1 Amplitude 

(rueda de modulación controla cantidad 
de vibrato)

• Sustain Pedal a Envelope 3 Release (actúa 
igual que un pedal sostenido)

Estas rutas de modulación predeterminadas 
y cualquier otra ruta no deseada pueden 
eliminarse seleccionando los elemento en 
blanco en los menús emergentes.

Parámetros de modulación tales como New 
default Matrix pueden guardarse como 
nuevos parámetros predeterminados, 
eligiendo Instruments > Set Instrument 
Defaults.

A partir de esas rutas predefinidas, la 
modulación de matriz está abierta a la 
creatividad del usuario. Experimente todo 
lo que quiera con diversas direcciones de 
modulación. Seguro que sus 
investigaciones le aportan interesantes 
hallazgos.



▲ Ciertas direcciones de modulación pueden 
ser posibles desde la ventana Matrix sin que 
los resultados sean audibles.

Moduladores
La ventana Modulators contiene 
parámetros de edición adicionales, entre 
ellos controladores MIDI, LFO y 
generadores de rampa. Esos parámetros 
pueden configurarse en la ventana 
Modulators y luego usarse como fuentes y 
destinos en la ventana Matrix.

Para abrir la ventana Modulators de un 
instrumento:

■ Haga clic en el botón de moduladores, en 
la barra de herramientas de la ventana de 
banco, o elija Windows > Modulators.

Botón de moduladores

Ventana Modulators
Capí
LFO
SampleCell II tiene dos LFO (osciladores de 
baja frecuencia) idénticos. Los LFO suelen 
tener fluctuaciones de control periódicas 
que corresponden a la forma de onda 
relacionada. Por ejemplo, el tono de 
modulación con un LFO (es decir, 
asignando LFO a Pitch en la ventana 
Matrix de SampleCell) producirá vibrato 
desde una onda sinusoidal y vibraciones 
desde una onda cuadrada.

Para configurar una forma de onda LFO:

1  Elija una forma de onda en el menú 
emergente de forma de onda.

La velocidad de un oscilador LFO 
determina lo rápido que será el cambio de 
control. El rango del cambio de control se 
ve afectado por la amplitud. La amplitud 
LFO define el máximo rango de control 
disponible para el control Amp de la ruta 
de modulación.

Como ejemplo, tanto un vibrato y una 
sirena pueden producirse modulando el 
tono con una onda sinusoidal. La sirena 
usa velocidad baja y amplitud alta mientras 
que el vibrato usa una velocidad alta y una 
amplitud baja.

Al ajustar los LFO, recuerde que puede 
editarlos con valores de unidades reales 
(Hz, ms, etc.) a través de Preferences. 

Formas de onda LFO
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Para cambiar la velocidad de modulación de 
un LFO:

■ Arrastre hasta la posición deseada el 
control deslizante Speed del LFO requerido.

Para cambiar el rango de modulación de un 
LFO:

■ Arrastre hasta la posición deseada el 
control deslizante Amplitude del LFO 
requerido.

Dado que la mayoría de formas de onda 
LFO emiten una señal de control cíclica, 
conviene controlar cómo y cuándo se 
activa el LFO con relación a la señal que 
modula. El menú emergente de 
sincronización LFO de la ventana 
Modulators permite especificar la 
temporización LFO mediante la selección 
de cuatro opciones.

Cuando el LFO se ejecuta libremente, tiene 
un ciclo constante y por lo tanto puede 
estar prácticamente en cualquier punto 
dentro de su propio ciclo, cuando la 
modulación está activada. Esto añade un 
elemento aleatorio a la modulación LFO, 
ya que nunca se sabe dónde está el ciclo al 
aplicar la rueda de modulación u otros 
controladores.

Los LFO sincronizados a través de varias 
voces dan la impresión de que todas ellas 
están moduladas uniformemente por un 
solo LFO. Esto puede ser ideal para 
sintetización funky, pero malo para 
secciones de cuerda y otros conjuntos 
musicales.

La activación de LFO garantiza que se 
iniciará al comienzo de su ciclo cuando se 
reproduzca una nota. Esto puede ser deseable 
para inflexiones musicales como vibraciones 
Guía de SampleCell II
y otros efectos que requieren consistencia de 
modulación entre todas las notas.

Para seleccionar el modo de activación de un 
LFO determinado:

1  Elija el modo deseado en el menú 
emergente de sincronización LFO. Éstas 
son las opciones disponibles:

• Free Run no tiene en cuenta la fase de 
forma de onda entre voces y notas 
activadas.

• Sync sincroniza la fase de formas de onda 
LFO entre voces SampleCell para simular 
un solo LFO.

• Trig restablece el valor de forma de onda 
LFO como cero cruzando cada nota 
activada MIDI para eventos esperados.

• Sync & Trig combina los atributos de Trig 
y Sync.

Generador de rampa
El generador de rampa emite una señal de 
control cuyo efecto se asemeja a una 
rampa. La señal se inicia a nivel normal y 
sube hasta otro nivel, a una velocidad 
definida. Si se utiliza una cantidad de 
modulación positiva, la rampa asciende; las 
amplitudes negativas la hacen descender.

Por ejemplo, si el generador de rampa 
modula el tono, una amplitud con un valor 
50 hace que cada nueva nota suba una 
octava; una amplitud de -50 hace que 
descienda una octava.

Menú emergente de sincronización LFO



Para alterar la velocidad a la que cambia la 
señal del generador de rampa:

■ Arrastre a la posición deseada el control 
deslizante Ramp Time.

Asignación de controladores 
MIDI
SampleCell permite a cada instrumento 
definir dos controladores MIDI (A y B) 
entre un total de 120. Estos pueden usarse 
como fuentes de modulación. Puede 
utilizar, por ejemplo, Yamaha Breath 
Controller (controlador MIDI 2) para 
modular el volumen o un pedal 
(controlador MIDI 4) para modular la 
amplitud LFO 1.

Para asignar el controlador MIDI A o B:

■ Arrastre el icono de control deslizante 
bajo el controlador MIDI A (o B) hasta que 
aparezca el número de controlador MIDI 
deseado.

✽ También puede asignar un número de 
controlador MIDI pulsando la tecla Control 
mientras hace clic en el cuadro de número 
correspondiente a un controlador MIDI y 
moviendo el controlador deseado en su 
dispositivo principal.

Selección de un número de controlador MIDI
Capí
Trackers
El generador de seguimiento (Tracker) 
altera una señal de control basándose en 
una gráfica con nueve puntos definidos por 
el usuario. Los puntos son uniformes en 
espaciado y temporización; la altura de su 
posición en la gráfica determina si la 
cantidad correspondiente es positiva o 
negativa. El eje X es la fuente de 
modulación (seleccionable en un menú 
emergente de la ventana Trackers); el eje Y 
es el destino de modulación.

La ventana Matrix Map sirve para hacer 
accesibles muchas de las posibilidades 
expresivas de la generación de 
seguimiento. Cuando están debidamente 
configurados, los generadores de 
seguimiento se "insertan" entre una fuente 
y un destino de modulación. Para cada 
generador de seguimiento se selecciona 
una fuente de modulación en el menú 
emergente Tracker. Así se asigna esa fuente 
(por ejemplo, velocidad, presión, número 
de nota MIDI) a través del generador de 
seguimiento, donde los nueve puntos 
críticos definidos por el usuario trazan la 
curva aplicable al destino de modulación 
correspondiente en la ventana Matrix.

Para ilustrar el mejor uso posible de los 
controles Tracker, imagine un instrumento 
como los violines pizzicato menos notorios 
en una zona (registro superior) que en otra 
(registro inferior). El control de volumen 
mediante la velocidad es sencillo, pero para 
conseguir un mayor realismo puede 
asignarse al violín una curva de respuesta 
tal que el registro superior no sea tan alto 
como el inferior. Al reproducir, el volumen 
global estará determinado principalmente 
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por la velocidad (siempre y cuando se 
mantenga la asignación de matriz 
predeterminada), pero habrá una 
diferencia notable entre los registros 
inferior y superior, al igual que la hay al 
tocar un violín real. Además, cualquier otra 
asignación, como la de velocidad a filtro, o 
velocidad a ataque de envolvente, se 
realzará mediante la curva de respuesta 
trazada en el generador de seguimiento.

Encontrará más ejemplos en "Seguimiento" 
en la página 81, donde se detallan otras 
sugerencias de uso de los controles Tracker.

Para abrir la ventana Tracker:

1  Haga clic en el botón de Trackers, en la 
barra de herramientas de la ventana de 
banco, o elija Windows > Trackers.

Botón de Trackers

Ventana Trackers
Guía de SampleCell II
Para seleccionar la fuente de modulación 
para generación de seguimiento:

■ Elija una fuente de control en el menú 
emergente de entrada de Tracker.

La curva de respuesta de Tracker se aplicará 
a la fuente seleccionada.

Para ajustar la curva de control de nueve 
puntos para el generador de seguimiento:

■ Arrastre cada punto verticalmente hasta 
el nivel deseado.

El último paso en el uso del control Tracker 
consiste en asignarlo a otro destino en la 
ventana Matrix. Active la ventana Matrix y 
experimente con diversas configuraciones 
de asignación y amplitud. Guarde los 
resultados de sus experimentos.



capítulo 6

Edición de muestras, bucles y recorte de 
audio
SampleCell Editor incluye una ventana 
Edit Loops para añadir, editar y eliminar 
puntos de bucles en sus muestras, y ofrece 
todas las herramientas necesarias para 
convertir muestras en bucles de calidad. La 
ventana Edit Loops también ofrece 
funciones de recorte de audio no 
destructivo, que permiten eliminar datos 
sobrantes de pre y post bucle.

La ventana Edit Loops ofrece las funciones 
de bucle de Sound Designer II y añade 
otras, entre ellas:

◆ Creación de dos bucles, uno de 
sostenimiento y otro de liberación, en 
cualquier archivo de sonido

◆ Recorte de audio (elimina todo el 
material que no esté seleccionado)

◆ Fundidos cruzados, bucles hacia adelante 
y hacia atrás, etc.

◆ Posibilidad de guardar archivos 
directamente desde la ventana Edit Loops

◆ Apertura de archivos de audio desde 
disco o desde instrumentos de SampleCell

◆ Visualización de información de datos de 
bucle, audición, edición y desplazamiento 
de bucles mientras se supervisa o activa la 
muestra desde controladores externos 
Capítulo 6: 
MIDI (vía OMS en Macintosh o vía 
Multimedia en Windows)

◆ Supervisión de bucles a través de la 
tarjeta SampleCell, Sound Manager de 
Apple o una tarjeta de sonido de Windows

Introducción
Esta sección describe los bucles de 
sostenimiento y de liberación en 
SampleCell, y el uso de ambos para obtener 
el máximo de expresividad y control.

Bucles
SampleCell admite el uso de un máximo de 
dos bucles con cada archivo de sonido. 
Cualquier muestra puede tener cuatro 
marcadores de bucle: inicio de bucle 1, final 
de bucle 1, inicio de bucle 2 y final de bucle 
2.

Con dos bucles en un archivo de sonido, 
SampleCell reproducirá el primer bucle 
mientras se mantiene una nota MIDI, y el 
segundo bucle durante la liberación de la 
nota. Cuando sólo hay un bucle definido, 
SampleCell lo reproduce tanto en la etapa 
de sostenimiento como en la de liberación.
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Si su archivo de sonido tiene un solo bucle

Si su archivo de sonido tiene un solo bucle, 
SampleCell reproducirá la muestra hasta el 
comienzo del bucle y luego continuará con 
la porción de bucle mientras se mantenga 
la nota. Al soltarla, SampleCell reproducirá 
el bucle mientras el sonido se atenúa de 
acuerdo con la envolvente actual.

▲ Un archivo de sonido con un solo bucle se 
denomina "Sus/Rel" en la ventana 
SampleCell Parameters (los controles de 
Sustain Loop aparecen en gris, no disponibles 
para muestras de un solo bucle).

Si su archivo de sonido tiene dos bucles

Si su archivo de sonido tiene dos bucles, 
SampleCell tratará el bucle 1 como de 
sostenimiento (lo reproduce mientras se 
mantiene pulsada la nota), y el 2 como de 
liberación (lo reproduce después de 
soltarla).

Los bucles deben cumplir dos requisitos:
• No deben superponerse (es decir, el bucle 

1 debe acabar antes de que empiece el 2)
• La duración de cada bucle debe ser 

equivalente, como mínimo, a un ciclo de 
forma de onda completo o a cinco 
cuadros de la muestra

Puede desafinar ambos bucles 
individualmente, desde la ventana Sample 
Parameters. Véase "Parámetros de muestra" 
en la página 49.
Guía de SampleCell II
Carga de muestras y 
acceso a la ventana Edit 
Loops
Al abrirse, la ventana Edit Loops carga una 
copia de la muestra seleccionada 
actualmente en la RAM de su ordenador. 
Esto permite trabajar de modo no 
destructivo en la ventana Edit Loops, 
protegiendo la versión original de la 
muestra, que permanece cargada en la RAM 
de SampleCell.

Todas las acciones realizadas en la ventana 
Edit Loops pueden deshacerse eligiendo 
Edit > Undo. Además, puede controlar el 
modo y el momento de la actualización de 
la muestra original (es decir, cómo y 
cuándo se sobrescribe con el contenido 
actual de la ventana Edit Loops). Véase 
"Uso del modo Link" en la página 66.

No es preciso cargar archivos en los 
instrumentos de SampleCell para abrirlos 
en la ventana Edit Loops. Una muestra 
puede cargarse directamente desde el disco 
en la ventana Edit Loops y luego realizar el 
bucle; también puede cargarse desde la 
ventana Sample Map de un instrumento.

▲ Debe detener su secuenciador siempre que 
vaya a abrir la ventana Edit Loops. 



Para abrir la ventana Edit Loops:

■ Si quiere hacer un bucle en una muestra 
ya cargada en un instrumento de 
SampleCell, seleccione la muestra en la 
ventana Sample Map del instrumento y 
luego elija Instruments > Edit (nombre de 
muestra), o haga clic en el icono de bucle.

– o –

■ Para hacer un bucle en un archivo en 
disco (un archivo no cargado en 
SampleCell), elija Instruments > Edit 
Loops.

✽ No puede cargar una muestra en la ventana 
Edit Loops si procede de un CD que no está 
montado en el sistema. Esta situación puede 
producirse si abre instrumentos sin cargar 
muestras mediante la preferencia 
"Automatically Load All Samples".

Botón de edición de bucles

Figura 12.  Ventana Edit Loops
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La ventana Edit Loops utiliza RAM del 
sistema (en lugar de RAM de SampleCell) 
para guardar la muestra. La muestra no se 
modificará hasta que utilice la opción Save 
Audio File (overwrite) de la ventana Edit 
Loops para guardarla sobrescribiéndola con 
el nuevo contenido, o Save Audio File As 
para guardar un nuevo archivo sin cambiar 
el original.

Para salir de la ventana Edit Loops:

■ Elija un banco en el menú Windows, o 
cierre la ventana Edit Loops.

Audición de bucles
Hay varios métodos de activar la 
reproducción en la ventana Edit Loops: 
haciendo clic en los iconos de altavoz en 
pantalla, pulsando la barra espaciadora o 
vía MIDI. Utilizando otro comando de 
reproducción, se puede elegir la audición de 
datos de pre-bucle y en bucle, simplemente 
estos últimos o el archivo de sonido entero 
una sola vez o en modo de repetición.

Usando MIDI, puede oír el bucle a través de 
las salidas de SampleCell, en contexto con 
otras muestras e instrumentos. Pero para 
esto es preciso tener activado el modo de 
vinculación a SampleCell. De modo 
predeterminado, este modo está activado al 
cargar una muestra en la ventana Edit Loops 
desde un instrumento. Si el audio de la 
ventana Edit Loops no se ha cargado desde 
un instrumento, el modo está desactivado 
por defecto. Véase "Uso del modo Link" en 
la página 66 para más información.

Si utiliza las opciones de reproducción en 
pantalla (iconos de altavoz o barra 
espaciadora) oirá diversas selecciones de 
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audio a través de Sound Manager 
(Macintosh) o a través del dispositivo de 
salida (Windows).

Para reproducir la muestra entera (sin tener 
en cuenta marcadores de bucle): 

■ Mantenga pulsada la tecla Opción 
(Macintosh) o Alt (Windows) mientras hace 
clic en el icono de altavoz de la barra de 
herramientas. También puede pulsar la tecla 
Opción y la barra espaciadora (Macintosh) o 
Alt y la barra espaciadora (Windows).

El audio se supervisará a través de las 
salidas de sonido del ordenador, y no a 
través de SampleCell.

Uso de controladores de onda para Windows

Puede oír los bucles a través del hardware 
Pro Tools mediante el controlador de onda 
de Pro Tools. Para más detalles, consulte la 
documentación de Pro Tools relativa a 
Windows.

Para reproducir sólo audio con bucles:

■ Pulse la barra espaciadora o haga clic en 
el altavoz de la sección de zoom de bucle (la 
sección inferior de la ventana Edit Loops).

Para reproducir el bucle desde el principio de 
la mezcla:

1  Anule la selección de todo el material de 
audio en la sección de vista general 
haciendo clic en la forma de onda 
(Windows) o, si trabaja con Macintosh, 
pulsando al mismo tiempo la tecla Opción.

2  Haga clic en el altavoz de la sección de 
vista general. La muestra se reproducirá 
desde el principio del archivo y luego 
comenzará y repetirá el primer bucle. Haga 
clic de nuevo para detener la reproducción.
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Para reproducir sólo audio seleccionado:

1  Arrastre para realizar una selección en la 
sección de vista general de forma de onda.

2  Haga clic en el icono de altavoz o pulse la 
barra espaciadora.

Uso del modo Link
MIDI no activa la reproducción de audio en 
la ventana Edit Loops. Únicamente los 
instrumentos de SampleCell son 
dispositivos MIDI. La opción de 
vinculación a SampleCell envía cada 
versión editada de la muestra de nuevo al 
instrumento, donde puede activarse vía 
MIDI y reproducirse a través de las salidas 
de audio de SampleCell.

Para reproducir muestras a través de salidas 
de SampleCell:

■ Si quiere reproducir la muestra o el bucle 
a través de la tarjeta SampleCell y activarlos 
vía MIDI, active la opción de vinculación a 
SampleCell. El modo Link está desactivado 
de modo predeterminado cuando se cargan 
muestras en la ventana Edit Loops desde un 
disco, en lugar de hacerlo desde un 
instrumento.

Si la muestra ya está asociada a un 
instrumento, se produce una actualización 
automática. Si no hay un instrumento 
asociado, la activación de vinculación a 
SampleCell creará un nuevo instrumento 
con la muestra como único grupo de notas.

Al utilizar el secuenciador o el controlador 
MIDI, se activará la versión más reciente 
del bucle. Para más detalles sobre el modo 
Link, véase "Actualización de muestras y 
modo Link" en la página 67.)



Actualización de muestras y modo 
Link

Al abrir una muestra en la ventana Edit 
Loops, SampleCell carga la muestra en la 
RAM del ordenador. Las modificaciones 
realizadas se aplican a la copia de la 
muestra en la RAM del sistema y no a la 
muestra cargada originalmente en la RAM 
de SampleCell.

No obstante, cuando está seleccionada la 
opción de vinculación a SampleCell, cada 
una de las acciones de la ventana Edit 
Loops se guarda automáticamente, con lo 
que la muestra de instrumento actual se 
sustituye por el contenido de la ventana.

Si la vinculación a SampleCell no está 
seleccionada, no se produce carga 
automática. El archivo en la RAM de 
SampleCell permanece intacto, y toda la 
supervisión se realiza a través de las salidas 
de sonido del ordenador.

Probablemente preferirá editar bucles sin la 
opción de vinculación a SampleCell. 
Después de realizar las operaciones de 
edición para oír el bucle en contexto, 
seleccione la opción para actualizar la 
muestra en la RAM de SampleCell.

✽ En modo de vinculación a SampleCell, la 
opción "Try to assign unused MIDI Channel for 
a new Instrument" asignará automáticamente 
el más alto de los canales MIDI disponible a 
los instrumentos recién creados. Para más 
información sobre esta preferencia, véase 
"Preferencias de instrumentos" en la 
página 99.
Capítulo 6: 
Selección de color de fondo para la 
ventana Edit Loops

Los colores utilizados para mostrar cada 
canal y el fondo de la ventana Edit Loops 
pueden configurarse. 

Para seleccionar los colores deseados para la 
ventana Edit Loops:

1  Elija SampleCell > Preferences. El selector 
de color se encuentra en la parte inferior de 
la pantalla Preferences. 

2  Haga clic en una de las tres opciones y 
elija el color deseado.

Repita la operación para las demás 
opciones de canal/fondo.

Selección de otro editor de muestras

El comando Select Sample Editor, en el 
menú Instruments, permite seleccionar 
una aplicación compatible para editar sus 
archivos de muestras.

El comando Launch Sample Editor (en el 
menú Instrument de la ventana Sample 
Map) cargará la muestra seleccionada 
actualmente en el editor de muestras que 
elija.

Selectores de color y canal de la ventana Edit Loops
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Descripción de la ventana 
Edit Loops
La sección de vista general de forma de 
onda muestra el archivo de audio entero 
cargado en la ventana Edit Loops, con una 
línea de tiempo a lo largo de la parte 
inferior. Aquí debe marcar el inicio y final 
de bucle, recortar datos sobrantes, 
conmutar bucles, etc.

Esta sección describe cada una de las 
funciones y comandos de la ventana Edit 
Loops. En esta ventana puede crear bucles a 
partir de sus muestras, aplicar bucles de 
fundido cruzado, invertir y 
avanzar/invertir bucles y sincronizar bucles 
automáticamente sin salir del entorno 
SampleCell.

Barra de herramientas

Menú emergente de la ventana Edit 
Loops

Este menú contiene opciones para guardar, 
guardar como, guardar selección como, 
guardar una copia y regresar al archivo de 
audio. Utilícelo para tareas de gestión de 
archivos y recuperaciones de emergencia. 
Cuando no está seleccionada la opción de 
vinculación a SampleCell, estos comandos 
realizan sus funciones habituales. Si la 
opción de vinculación a SampleCell está 
seleccionada, todos los comandos del 
menú (excepto Save a Copy) actualizan el 
instrumento de SampleCell. El comando 
Save Audio File actualizará grupos de notas 
originales (de haberlos) en el instrumento 
de SampleCell. El comando Save Audio File 
As creará un nuevo instrumento que 
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contendrá la muestra con bucle como 
único grupo de notas. El comando Save 
Audio File Copy guardará en disco una 
nueva copia del archivo de audio sin 
actualizar ni crear un instrumento. El 
comando Save Audio Selection As permite 
asignar un nombre al archivo de audio 
seleccionado actualmente y guardarlo en 
un nuevo archivo en disco. El comando 
Revert Audio File retomará la versión 
previamente guardada del archivo de audio 
actual.

Botón de altavoz

El botón de altavoz de la barra de 
herramientas controla la reproducción de 
audio en la ventana Edit Loops. La ventana 
Edit Loops ejecuta la reproducción a través 
de las salidas de sonido del ordenador, y no 
a través de SampleCell.

Para reproducir audio desde la ventana Edit 
Loops, haga clic en el botón de altavoz de la 
barra de herramientas de la sección de vista 
general para oír la muestra desde el 
principio con el audio en bucle, que se 
repite. Si no hay bucles definidos, al hacer 
clic en el botón de altavoz o en la barra 
espaciadora se reproducirá la porción 
seleccionada actualmente en el archivo de 
audio. Si no hay ninguna porción 
seleccionada (es decir, no hay nada 
resaltado en la forma de onda de la sección 
de vista general) ni bucles definidos, se 
reproducirá todo el archivo de audio.

Para oír el archivo de audio entero pasando 
por alto bucles y selecciones, pulse la tecla 
Opción (Macintosh) o Alt (Windows) 
mientras hace clic en el botón de altavoz (o 
mientras pulsa la barra espaciadora).



Para oír únicamente el bucle, use el botón 
de altavoz de la sección de zoom de bucle, o 
la barra espaciadora. 

▲ Al hacer clic en el icono de altavoz o pulsar 
la barra espaciadora para escuchar el 
contenido de la ventana Edit Loops, la 
reproducción utilizará el dispositivo de sonido 
estándar del sistema. Para poder supervisar 
un bucle o una muestra a través de la tarjeta 
SampleCell (y activarlos vía MIDI), la opción de 
vinculación a SampleCell debe estar 
seleccionada para actualizar la muestra en el 
instrumento de SampleCell (si ya existe en un 
instrumento cargado) o para crear un nuevo 
instrumento para la muestra. 

Botón de vinculación a SampleCell

Este botón envía el contenido de la 
ventana Edit Loops a SampleCell o 
actualiza los instrumentos de SampleCell 
pertinentes (de haber alguno). Si no hay 
una muestra con nombre idéntico que 
actualizar (como sería el caso si se hubiera 
aplicado un bucle a un archivo 
directamente desde el disco), se creará un 
nuevo instrumento de muestra única (y, si 
es preciso, también se creará un banco). 

Botón de conmutación de bucle

Este botón cambia el número de bucle 
designado actualmente (de 1 a 2, o de 2 a 
1). Sólo está disponible si existe un bucle. 
Dado que SampleCell designa el bucle 
predeterminado para actuar como bucle de 
liberación, este botón es útil para pasar del 
bucle 1 al 2, permitiendo anteponer un 
bucle de sostenimiento (bucle 1). Si se 
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mantiene el bucle 1, sólo puede colocar 
detrás un bucle 2, para convertir al bucle de 
liberación en bucle de sostenimiento.

Herramientas de recorte

La función de recorte de SampleCell sirve 
para eliminar audio situado fuera de una 
selección. Utilícela con cautela: no elimina 
datos del audio seleccionado, sino todo el 
audio sin seleccionar. 

Si tiene intención de aplicar un fundido 
cruzado al bucle, asegúrese de dejar audio 
"extra" antes y después de los marcadores 
de bucle. Los cambios que realice no se 
guardarán en disco hasta que se utilice el 
comando apropiado en el menú emergente 
de la ventana Edit Loops. 

Flechas de zoom

Estas flechas sirven para controlar la 
visualización de la sección de vista general. 
Las flechas arriba/abajo (y las 
correspondientes teclas) aumentan o 
reducen respectivamente la altura de la 
forma de onda; las flechas 
derecha/izquierda (y las correspondientes 
teclas) acercan o alejan la imagen a lo largo 
de la línea de tiempo. Pulse la tecla Opción 
(Macintosh) o Alt (Windows) mientras 
hace clic en una de las flechas de zoom de 
la sección de vista general (o pulse la tecla 
correspondiente en el teclado) para activar 
la resolución máxima (es decir, ampliación 
máxima o mínima).
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Representación de duración (ms y 
muestras)

Esta zona de la barra de herramientas 
muestra la duración de la selección actual.

Herramienta de selección

La herramienta de selección sirve para 
seleccionar audio en la forma de onda y 
para colocar marcadores de bucle. Haga clic 
sobre el icono de flecha y arrastre el 
puntero sobre una porción de audio; pulse 
la tecla Mayúsculas mientras hace clic si 
desea añadir o sustraer material de una 
selección. Para anular una selección, haga 
clic en cualquier punto de la sección de 
vista general. 

Marcadores de inicio y fin de bucle

Los marcadores de inicio y fin de bucle se 
añaden a la forma de onda de la sección de 
vista general para definir los puntos donde 
comienzan y terminan los bucles. Los 
marcadores se añaden haciendo clic en uno 
de los botones de la barra de herramientas, 
para seleccionarlo, y luego haciendo clic 
sobre la forma de onda de la sección de 
vista general para colocarlo. El marcador de 
bucle correspondiente se colocará en esa 
posición, reflejada en la sección de 
información de bucle (sección inferior 
izquierda de la ventana Edit Loops). 
Consulte "Creación de un bucle" en la 
página 73 para más información sobre la 
adición de marcadores de bucle.

Borrador

Para eliminar un marcador, seleccione esta 
herramienta y haga clic en el marcador. 
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Sección de zoom de bucle y 
herramientas

Esta zona de la ventana Edit Loops muestra 
un primer plano de la forma de onda, con 
el final del bucle seleccionado a la izquierda 
y el inicio a la derecha. Debajo de la 
pantalla de la sección de zoom de bucle se 
encuentran los botones Auto y los de 
desplazamiento. A la izquierda de la 
pantalla de zoom se encuentran las 
herramientas asociadas a ésta: los botones 
de canal, bucle, fundido cruzado y las 
flechas de zoom. Debajo de estas 
herramientas se encuentra la casilla Stereo, 
para seleccionar la audición de uno o 
ambos canales de un bucle estéreo.

Flechas de desplazamiento izquierda 
y derecha

Bajo el inicio del bucle (a la derecha de la 
pantalla de zoom) y el final (a la izquierda) 
están las flechas izquierda y derecha de 
desplazamiento de bucle. Al hacer clic 
sobre ellas se mueve el punto de bucle 
correspondiente, en pequeños 
incrementos, al principio del archivo de 
sonido (flecha izquierda) o hacia el final 
(flecha derecha). 

✽ Pulse la tecla Comando (Macintosh) o 
Control (Windows) mientras tiene lugar el 
desplazamiento, para que la operación sea 
más precisa.

Las secciones de vista general y de zoom de 
bucle pueden estar activas 
simultáneamente, y los cambios realizados 
en una se reflejarán en la otra. También 
puede pasar de una a otra para mover los 
marcadores de bucle. Por ejemplo, 
trabajando en la sección de zoom de bucle 



puede decidir llevar un marcador más lejos 
y en un movimiento más rápido que el 
permitido por las flechas de la sección de 
zoom. En ese caso, puede seleccionar el 
marcador en la sección de vista general, 
colocarlo en una nueva posición y regresar 
a la sección de zoom de bucle para 
continuar ajustando el bucle. 

✽ También puede hacer clic en un punto 
cualquiera de la sección de vista general y la 
pantalla de zoom pondrá a la vista dicho 
punto.

Flechas Auto izquierda y derecha

Las flechas AUTO izquierda y derecha son 
especialmente útiles para la colocación de 
puntos de bucle. En lugar de desplazar los 
puntos de bucle hacia la izquierda o la 
derecha en pequeños incrementos, las 
flechas AUTO mueven automáticamente el 
punto de bucle al siguiente punto que 
mantenga tanto el valor como la 
inclinación del otro marcador de bucle. Por 
ejemplo, si quiere ajustar el final de un 
bucle, al hacer clic en la flecha AUTO 
derecha el punto final se moverá hacia el 
final del archivo de audio, hasta la 
siguiente forma de onda cuya inclinación y 
amplitud sean similares a las del inicio del 
bucle. Al hacer clic en la flecha AUTO 
izquierda se movería el mismo marcador 
hasta un punto anterior en el archivo de 
audio, para encontrar una ubicación 
equivalente. Pero tenga en cuenta que estos 
botones no pueden garantizar un bucle de 
sonido perfecto. Aunque harán 
corresponder la ubicación de un marcador 
a la inclinación y amplitud del otro, esto no 
sirve para asegurar el mejor bucle posible 
(es decir, las flechas AUTO no encuentran 
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automáticamente puntos de bucle de cruce 
cero). ¡Haga caso a su oído para determinar 
la calidad del bucle!

Flechas de sección de zoom de bucle

Sirven para ajustar la resolución (zoom) de 
la imagen en la sección de zoom de bucle, 
con cuatro posibles grados de ampliación. 

Las flechas arriba/abajo aumentan o 
reducen respectivamente la altura de las 
formas de onda; las flechas 
derecha/izquierda acercan o alejan la 
imagen en sentido horizontal. Las flechas 
de zoom de bucle pueden controlarse 
manteniendo pulsada la tecla Mayúsculas 
mientras se hace clic en la tecla de 
dirección deseada, en el teclado del 
ordenador. 

Casilla Stereo

Permite oír canales individuales de un 
bucle estéreo. Cuando está seleccionada, 
todas las audiciones de bucle usarán ambos 
canales de un bucle estéreo. Si no está 
seleccionada, sólo se oirá el canal 
seleccionado mediante el botón de 
selección de canal. Esta casilla puede 
activarse y desactivarse mientras se 
escuchan los bucles. 

Botón de bucle de fundido cruzado

Al hacer clic en este botón se abre el cuadro 
de diálogo Crossfade Looping. Aquí puede 
seleccionar el tipo y la duración de un 
fundido cruzado. Puede elegir entre dos 
tipos de fundido: Linear e Equal Power; y la 
duración puede ser cualquier valor inferior 
a la duración de la muestra o región 
correspondiente. El cuadro de diálogo 
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Crossfade Looping también permite crear 
bucles hacia adelante o adelante/atrás. 
Consulte "Creación de un bucle de fundido 
cruzado" en la página 75 para más detalles. 

✽ Si trabaja con un sistema Macintosh, la 
ventana Edit Loops no sirve para audiciones 
de bucle adelante/atrás a menos que el bucle 
esté cargado en un instrumento de 
SampleCell. Es decir, si la opción de 
vinculación a SampleCell está desactivada, no 
puede activar un bucle adelante/atrás vía 
MIDI. Para oír el nuevo bucle, el botón de 
vinculación a SampleCell debe estar activado 
(para que SampleCell se actualice con la 
versión adelante/atrás del archivo de sonido). 

Botón de selección de bucle

El número del bucle en proceso de edición 
aparece en la parte superior izquierda de la 
sección de zoom de bucle. Para editar otro 
bucle, haga clic en el botón de selección de 
bucle. Úselo para seleccionar y supervisar 
un bucle u otro mediante el altavoz de la 
sección de zoom de bucle o la barra 
espaciadora. 

Botón de selección de canal

Al hacer clic en este botón se mostrará el 
bucle del canal derecho o el del izquierdo 
de un archivo estéreo. 

Botón de altavoz

El botón de altavoz sirve para reproducir el 
audio seleccionado. 
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Sección de información

Esta sección contiene campos de texto 
editables para indicar el inicio y el fin de un 
bucle (en muestras), botones para desplazar 
la sección de vista general en el punto de 
bucle seleccionado y un menú emergente 
para seleccionar el tipo de bucle. Mediante 
la edición de valores en estos campos 
(haciendo clic en ellos, escribiendo el valor 
deseado y pulsando la tecla Retorno o 
Entrar), puede definir/ajustar bucles o 
selecciones directamente. 

Start/End. Indican los puntos de inicio y 
final (en muestras) para ambos bucles 
(Loop 1, Loop 2) y la selección de audio 
actual, de haberla. Para editar estos 
campos, haga clic en el campo deseado y 
escriba el valor que quiera. Si se eliminan 
estos valores también desaparecerá el 
marcador o la selección correspondiente. 

Botones de gafas. Al hacer clic en uno de 
estos iconos, junto al campo de 
información de bucle, la forma de onda de 
la sección de vista general mostrará la 
ubicación de ese marcador. 

Type. Para cambiar la dirección del bucle, 
haga clic en el menú emergente Type y 
seleccione la opción Fwd/Bk para definir 
un bucle adelante/atrás, o Forward para 
seleccionar un bucle estándar.



Creación de un bucle

Introducción
En esta sección se explica el procedimiento 
de creación de bucles. Primero debe abrir la 
ventana Edit Loops con la muestra en la 
que quiere crear el bucle, y a continuación 
añadir marcadores de bucle al archivo 
usando las herramientas de edición de 
bucles. Después de oír los bucles creados, 
aprenderá a editar su ubicación, añadir 
bucles de fundido cruzado y usar el modo 
de vinculación a SampleCell. 

Para cargar una muestra en la ventana Edit 
Loops:

1  Si la muestra ya está cargada en un 
instrumento de SampleCell, seleccione el 
grupo de notas o la zona de velocidad en la 
ventana Sample Map y elija Instruments > 
Edit (nombre de muestra), o haga clic en el 
botón de edición de bucles de la ventana 
Sample Map.

La ventana Edit Loops aparece con la 
muestra cargada y visible en la sección de 
vista general. Para realizar un bucle en una 
muestra, no es preciso que esté cargada en 
SampleCell. Los archivos en disco pueden 
abrirse directamente en la ventana Edit 
Loops y editarse antes de cargarlos en 
SampleCell. Si quiere crear un bucle en un 
archivo que esté cargado en SampleCell, 
elija Instruments > Edit Loops. Localice el 
archivo deseado en el cuadro de diálogo 

Botón de edición de bucles
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emergente. Si el modo de vinculación a 
SampleCell está activado, SampleCell 
creará automáticamente un instrumento 
de muestra única para el bucle, tan pronto 
como añada o edite un marcador de bucle.

Al abrirse la ventana Edit Loops, verá el 
nombre del archivo en la barra de título; la 
duración del archivo se indica en el centro 
de la barra de herramientas (en ms y 
muestras). La sección de vista general 
mostrará las formas de onda del archivo, y 
cualquier marcador de bucle (hasta un 
máximo de 2 bucles) existente en el 
archivo. 

Para crear un bucle en la ventana Edit Loops:

1  Haga clic en el icono de marcador de 
inicio de bucle. El puntero adoptará la 
forma de inicio de bucle siempre que se 
sitúe sobre la forma de onda en proceso de 
edición.

2  Haga clic en el punto de inicio de bucle 
deseado dentro de la forma de onda. 
Aparecerá un marcador de inicio de bucle 
con el número 1.

3  Haga clic en el icono de marcador de fin 
de bucle de la barra de tareas. El puntero 
adoptará la forma de fin de bucle siempre 
que se sitúe sobre la forma de onda en 
proceso de edición.

Marcador de inicio de bucle

Marcador de fin de bucle
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4  Haga clic sobre la forma de onda junto a 
la que quiere colocar el punto final del 
bucle. Aparecerá un marcador de fin de 
bucle con el número 1 en la parte inferior 
de la pantalla de forma de onda, a lo largo 
de la línea de tiempo.

Acaba de crear un bucle. La sección de 
zoom de bucle (en la parte inferior derecha 
de la ventana Edit Loops) siempre muestra 
un primer plano de los puntos de bucle.

Edición de bucles, 
conmutación de bucles y 
fundidos cruzados 
El modo más simple de editar un bucle 
consiste en arrastrar los marcadores a una 
nueva posición en la sección de vista 
general. Pero no es probable que los ajustes 
realizados mediante este método sean lo 
suficientemente precisos para crear un 
bucle suave; por lo tanto, se recomienda 
utilizar los botones AUTO y las flechas de 
desplazamiento de la sección de zoom de 
bucle. 

Las dos mitades de la sección de zoom de 
bucle muestran primeros planos del audio 
al final del bucle (en la parte izquierda) y al 
inicio (en la parte derecha). Para obtener 
bucles suaves, es preferible utilizar puntos 
de cruce cero. Esto quiere decir que las 
formas de onda de inicio y final del bucle se 
cortan exactamente en el punto cero. 

Herramientas de la sección de zoom de bucle
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Compruebe la proximidad de los puntos de 
bucle actuales al punto cero en la sección 
de zoom de bucle. 

Bajo ambas vistas existen flechas de 
desplazamiento hacia la izquierda y la 
derecha, y botones AUTO de dirección 
izquierda y derecha. Las flechas de 
desplazamiento sirven para mover muy 
gradualmente un marcador de bucle hasta 
un punto anterior o posterior (hacia la 
izquierda o hacia la derecha, 
respectivamente). Pulse la tecla Comando 
(Macintosh) o Control (Windows) 
mientras hace clic para activar el modo de 
ajuste preciso, con lo que el 
desplazamiento será realmente lento. Estas 
flechas facilitan la localización del punto 
de cruce cero más próximo, o el de 
cualquier otra ubicación relevante en la 
muestra. 

Las flechas AUTO izquierda y derecha son 
especialmente útiles para la colocación de 
puntos de bucle. En lugar de desplazar los 
puntos de bucle hacia la izquierda o la 
derecha en pequeños incrementos, las 
flechas AUTO mueven automáticamente el 
punto de bucle al siguiente punto que 
mantenga tanto el valor como la 
inclinación del empalme. Si está ajustando 
el final del bucle, la flecha AUTO encuentra 
el inicio del bucle. Si está ajustando el 
inicio del bucle, la flecha AUTO encuentra 
el fin del bucle. También puede hacer clic 
en cualquiera de las formas de onda 
mostradas en la sección de zoom de bucle, 
y el correspondiente marcador de bucle se 
moverá a esa posición. 



Para definir con precisión las ubicaciones de 
bucle:

1  Después de añadir marcadores de bucle 
en la sección de vista general, use las 
flechas de desplazamiento 
izquierda/derecha para encontrar un punto 
de empalme para el marcador 
seleccionado. 

Pulse la tecla Comando (Macintosh) o 
Control (Windows) mientras tiene lugar el 
desplazamiento, para que la operación sea 
más precisa.

2  Después de encontrar un buen punto de 
empalme, use la flecha AUTO del otro 
marcador para encontrar un empalme 
adecuado. O use las flechas de 
desplazamiento izquierda/derecha para 
realizar la búsqueda manualmente. 
También puede ajustar las ubicaciones de 
marcador con los campos de texto 
editables. Simplemente, haga doble clic en 
el campo deseado e indique una nueva 
ubicación (en muestras). 

Creación de un bucle de fundido 
cruzado
La ventana Edit Loops ofrece una opción de 
fundido cruzado irreversible. 

Para crear un bucle de fundido cruzado:

1  Haga clic en el botón de fundido cruzado 
de la ventana Edit Loops. Se abrirá el 
cuadro de diálogo Crossfade Looping.

Botón de fundido cruzado
Capítulo 6: 
El cuadro de diálogo Crossfade Looping 
permite crear un bucle de fundido cruzado. 
La creación de bucles de fundido cruzado es 
una técnica destructiva de edición de 
muestras que usa la forma de onda natural 
del sonido para "suavizar" el punto de 
empalme del bucle.

La función de bucle de fundido cruzado 
consiste en realizar una copia de la forma 
de onda del final del bucle y fundir 50% de 
ésta con 50% de la forma de onda de inicio. 
A continuación, toma la forma de onda de 
inicio de bucle original y funde 50% de ésta 
con 50% de la forma de onda final. De este 
modo se asegura que las formas de onda 
inicial y final coinciden, aunque ninguna 
de ellas se haya modificado radicalmente.

Para que todas las transiciones se 
reproduzcan uniformemente, incluidas las 
que preceden y siguen al comienzo y final 
del bucle, los fundidos cruzados se centran 
justo sobre los puntos de inicio y final. 
Entre otros, el cuadro de diálogo Crossfade 
Looping contiene los siguientes elementos:

Crossfade Type . Este parámetro ofrece dos 
opciones: Linear, que utiliza curvas de 
fundido planas (lineales) y resulta la 
opción más conveniente, en general; e 

Cuadro de diálogo Crossfade Looping
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Equal Power, que utiliza una curva no 
lineal. Esta opción es útil si el centro del 
fundido parece tener un volumen más 
bajo. 

Crossfade Length. El valor del parámetro 
Crossfade Length determina la cantidad de 
forma de onda a ambos lados de los puntos 
de bucle que participará del fundido. Por 
esta razón, el valor de Crossfade Length 
debe ser inferior al de la duración total del 
bucle, inferior a la duración de la forma de 
onda entre el principio del archivo de 
sonido y el inicio del bucle, e inferior a la 
duración de la forma de onda entre el final 
del bucle y el final del archivo de sonido.

✽ SampleCell no puede realizar una audición 
de bucle adelante/atrás directamente desde 
dentro de la ventana Edit Loops. Debe activar 
el botón Link y luego activar y supervisar la 
versión adelante/atrás desde su controlador 
MIDI.

2  Configure los valores de Crossfade y haga 
clic en Continue. Si está activada la opción 
de vinculación a SampleCell, al añadir un 
bucle de fundido se actualizará el 
instrumento de SampleCell. 

Conmutación de bucle 1 a bucle 2

SampleCell puede reconocer un máximo 
de 2 bucles en un archivo de sonido. 
Cuando sólo existe un bucle (y por lo tanto 
un solo par de marcadores de inicio/fin de 
bucle), ese bucle se reproducirá durante las 
porciones de sostenimiento y de liberación 
del archivo de sonido. Cuando se añade un 
bucle a un archivo que ya contiene uno, el 
segundo bucle será el de liberación y el 
primero el de sostenimiento. Para obtener 
un máximo de flexibilidad al crear bucles, 
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puede usar el botón de conmutación de 
bucle para "intercambiar" el primer bucle a 
fin de definir el siguiente bucle que añada 
como de sostenimiento.

Para añadir un solo bucle:

◆ Añada marcadores de inicio y fin para el 
bucle 1. El archivo de audio tendrá un 
bucle, denominado "Sus/Rel Loop" en la 
ventana Sample Parameters. Este bucle se 
repetirá durante la envolvente de 
sostenimiento y de liberación del 
instrumento. 

Para añadir un segundo bucle:

◆ Decida si quiere que el bucle actual sea de 
sostenimiento o de liberación. 

Si opta por el de sostenimiento y desea 
añadir un nuevo bucle de liberación, 
simplemente añada marcadores de 
inicio/fin de bucle 2 después del final del 
bucle 1. Este nuevo bucle será el de 
liberación. 

Si quiere que el bucle actual sea el de 
liberación y desea añadir un bucle de 
sostenimiento, haga clic en el botón de 
conmutación de bucle.

Esta acción "convierte" el único bucle 
actual en el segundo bucle y los marcadores 
se asociarán a "Loop 2". Así, el nuevo bucle 
que añada podrá convertirse en bucle de 
sostenimiento. Después de hacer clic en el 
botón de conmutación de bucle, 
simplemente añada nuevos marcadores de 
bucle y colóquelos antes que los 

Botón de conmutación de bucle



marcadores de bucle 2 existentes. Estos 
nuevos marcadores se identificarán con un 
"1" para representar la porción de 
sostenimiento del bucle. 

Para conmutar bucles:

1  Debe haber un único bucle definido en el 
archivo. 

2  Haga clic en el botón de conmutación de 
bucle. 

3  Defina un nuevo bucle como bucle de 
sostenimiento. 

Eliminación de bucles
El borrador permite eliminar un bucle en 
cualquier momento.

Para eliminar un bucle:

1  En la barra de herramientas, haga clic en 
la herramienta borrador. El puntero 
adoptará la forma de borrador. 

2  Haga clic en los marcadores de inicio y 
fin de bucle que desee eliminar. 

– o –

3  Seleccione y elimine uno de los valores 
de inicio o fin de bucle en el área de 
información. Esta acción eliminará 
también el marcador de bucle 
correspondiente. 
Capítulo 6: 
Recorte de audio
El audio antes y después de un rango de 
forma de onda seleccionada puede 
eliminarse de un archivo con el comando 
Trim. Este comando facilita la eliminación 
de datos que no pertenezcan al rango 
seleccionado. 

Para recortar datos sobrantes en un archivo 
de sonido:

1  Seleccione el área del archivo de sonido 
que desea mantener.

2  Haga clic en el botón de recorte. 

3  Se eliminarán del archivo de sonido 
todos los datos excepto los del área 
seleccionada. Para deshacer esta operación, 
elija Edit > Undo. 

4  Elija Save Selection As en el menú 
emergente de la ventana Edit Loops para 
guardar esta muestra (recortada). Asígnele 
un nombre exclusivo, para no 
sobrescribirla accidentalmente con el 
original. También debe cerrar la muestra 
original, sin guardar los cambios realizados 
para que quede como estaba.

– o –

Después de hacer clic en el botón de 
recorte, seleccione Save Audio As en el 
menú emergente de la ventana Edit Loops 
para guardar esta nueva muestra con un 
nombre nuevo. 

Botón de recorte
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capítulo 7

Técnicas avanzadas
Este capítulo explica cómo dar un toque 
especial a sus muestras e instrumentos. 
Muchos de los ejemplos los han 
suministrado realizadores de pruebas beta, 
personal de asistencia al cliente y 
desarrolladores de sonido. Use estos 
ejemplos como punto de partida para sus 
propios experimentos.

Plantillas
La función principal de una plantilla de 
instrumento consiste en almacenar 
asignaciones de zonas y grupos de notas y 
configuraciones de instrumento. Un 
archivo de plantilla puede usarse como 
punto de partida para crear nuevos 
instrumentos. Las plantillas de SampleCell 
contienen parámetros de instrumento tales 
como Sample Map, Matrix Modulation, 
Envelope y Tracker.

Carga de muestras automática

Cuando está seleccionada la opción 
Automatically Load Samples (en la ventana 
Preferences), SampleCell cargará todas las 
muestras requeridas por bancos e 
instrumentos abiertos en ese momento. Si 
la opción no está seleccionada, el 
instrumento se abre con muestras vacías y 
en la ventana Sample Map los nombres de 
muestra aparecen en cursiva (por ejemplo, 
Elec bass D2).

Es posible seleccionar zonas individuales y 
sustituir sus muestras, o puede cargarse la 
muestra original seleccionando su zona y 
eligiendo el comando Load Sample.

Las plantillas pueden cargarse con muestras 
"en blanco" o marcadores con apenas 
información de audio. De este modo se 
acelera la carga de la plantilla, y las 
muestras se sustituyen por archivos de 
sonido "reales".

Las plantillas son útiles para configurar 
instrumentos complejos. Por ejemplo, los 
instrumentos de tipo batería suelen tener 
un gran número de muestras individuales, 
muchas zonas y grupos de notas y muchos 
parámetros individuales. Una vez 
configurado uno de estos instrumentos con 
una asignación MIDI, velocidad y curvas 
ADSR, filtrado, panorámico de audio, etc., 
puede usar el comando Save Instrument As 
para guardar una nueva copia de ese 
instrumento y utilizarla como plantilla.

Si quiere utilizar repetidamente una 
plantilla de instrumento, puede guardarla 
como plantilla (Macintosh) o como 
archivo de sólo lectura (Windows).
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Para crear una plantilla de instrumento:

1  Abra o cree un instrumento y configure 
sus parámetros como desee. Configure los 
parámetros de la ventana Sample Map y 
edite las ventanas Misc, Envelope, Matrix, 
Modulators, Trackers o Sample Parameters.

2  Use el comando Save Instrument As para 
guardar el archivo con un nombre nuevo 
que lo identifique como plantilla.

3  Abra la plantilla mediante uno de estos 
procedimientos:

◆ Para abrirla rápidamente sin cargar 
muestras, abra la ventana Preferences y 
anule la selección de la opción 
Automatically Load Samples.

– o –

◆ Para abrirla cargando todas sus muestras, 
asegúrese de que está seleccionada la 
opción Automatically Load Samples en la 
ventana Preferences antes de abrir el 
archivo de plantilla.

4  Elija la opción Save Instrument As para 
guardar el nuevo instrumento con otro 
nombre, o elija Save Instrument para 
guardar una nueva versión de la plantilla.

5  Cuando se abra el archivo de plantilla, 
sustituya o cargue las muestras según lo 
requiera.

Uso de muestras en blanco

Las plantillas de instrumento de 
SampleCell pueden utilizar muestras en 
blanco para conservar espacio en disco y 
agilizar la carga inicial de la plantilla. Una 
muestra en blanco es simplemente un 
archivo de audio de pequeño tamaño 
(existe un ejemplo en el CD-ROM 
SampleCell Library #, Drum & Percussion 
Samples). Una vez abierto el instrumento, 
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puede empezar a cargar muestras en 
Sample Map para sustituir a las que están 
en blanco.

Plantillas y opciones 
predeterminadas de 
instrumento
Muchos parámetros de SampleCell pueden 
guardarse como opciones predeterminadas 
de instrumento, pero es importante tener 
clara la diferencia entre estas opciones 
predeterminadas y las plantillas descritas 
anteriormente. 

Parámetros predeterminados de 
instrumento. Se aplican a todos los 
instrumentos nuevos; cualquier 
instrumento de muestra única o muestras 
múltiples, mono o estéreo se configurará 
según las opciones predeterminadas 
vigentes. Las opciones predeterminadas de 
instrumento se crean siempre que se elige 
el comando Set Instrument Defaults, que 
guarda los parámetros de instrumento y 
banco (pero no las asignaciones de grupo y 
zona).

Cuando se crea un nuevo instrumento, se 
le aplican tanto las opciones 
predeterminadas de banco como las de 
instrumento. Si hay un banco abierto y se 
carga un instrumento (junto con una 
plantilla de instrumento), sólo se aplicarán 
los parámetros de banco (volumen de 
instrumento, panorámico de audio, canal 
MIDI, salida de audio y nota Hi/Lo). Los 
parámetros a nivel de instrumento (Misc, 
Envelope, Matrix, Modulators, Trackers, 
etc.) se configurarán según el archivo de 
instrumento que se abra.



Plantillas de instrumento. Permiten guardar 
distintas opciones predeterminadas de 
instrumento (ya que las plantillas 
almacenan parámetros a nivel de 
instrumento) y además guardan 
asignaciones de muestra para zonas y 
grupos de notas (que no se guardan con las 
opciones predeterminadas de 
instrumento).

Seguimiento
Los generadores de seguimiento (Trackers) 
tienen usos diversos: definición de curvas 
de respuesta, incremento de resolución de 
parámetros de Matrix, adición de un 
elemento de tono aleatorio y aumento del 
efecto de vibrato y otros parámetros de 
rendimiento.

Curvas de respuesta 
personalizadas
Las curvas de respuesta personalizadas se 
usan para aumentar o reducir el valor de un 
parámetro según la configuración de otro 
parámetro. Los controles Tracker facilitan 
el trazado de la curva de respuesta, y 
consiguientemente el incremento de 
resolución de prácticamente cualquier 
asignación de Matrix para conseguir mejor 
afinación, vibrato y otros efectos.

Las curvas de respuesta personalizadas 
pueden usarse en distintas situaciones. En 
las siguientes secciones se ofrecen ejemplos 
ilustrativos.
Incremento de resolución de 
asignaciones de Matrix: matriz, 
generadores de seguimiento
Esta técnica puede aplicarse prácticamente 
a cualquier instrumento utilizado. Los 
generadores de seguimiento pueden usarse 
para editar asignaciones que, de lo 
contrario, podrían estancarse entre 
amplitudes de Matrix. Por ejemplo, a veces 
un valor de amplitud de Matrix 2 no es 
suficiente, pero un valor 3 es excesivo. Es 
un dilema típico cuando se realizan 
asignaciones de velocidad a tono para 
simular las variaciones naturales de 
baterías y otros instrumentos de percusión. 
En esta situación, un valor muy alto puede 
hacer que cambie excesivamente el tono de 
las muestras (un tam tam puede empezar a 
sonar como un timbal), mientras que un 
valor demasiado bajo produce resultados 
apenas perceptibles. Además puede que 
prefiera evitar fluctuaciones de tono en un 
bombo o un cencerro en la misma medida 
que con otros componentes. 

A continuación se ofrece un ejemplo del 
uso de un generador de seguimiento para 
modular moderadamente el modulador de 
control (en este caso, la velocidad) y 
obtener la resolución deseada de las 
asignaciones Matrix:

1  Abra la ventana Trackers y elija Velocity 
en uno de los menús emergentes Tracker. 
Luego trace una curva de respuesta que se 
desvíe ligeramente del nivel neutral (haga 
subir o bajar ligeramente todos los nodos 
con respecto al centro, o cree alguna 
variación no lineal). Experimente con 
valores diferentes hasta obtener el 
resultado deseado.
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2  Abra la ventana Matrix y asigne el 
control Tracker (debe recordar cuál usó en 
el paso previo) a Pitch, y configure un valor 
de Amplitude entre 3 y 8, para empezar.

3  Escuche el instrumento. Pruebe uno de 
los instrumentos de demostración, por 
ejemplo Drums Library #1, para ver si 
puede hacer que los controles Tracker 
"animen" la batería intentando no afectar 
al tono de los platillos. 

4  Si son necesarios otros ajustes, puede 
incrementar o reducir el valor de amplitud 
de Matrix de Tracker a Pitch, o volver a 
editar la curva de respuesta en el generador 
de seguimiento. Experimente con estos dos 
parámetros hasta que el instrumento tenga 
la cantidad de respuesta justa.

Afinación: matriz, generadores 
de seguimiento, generador 
aleatorio
Los controles Tracker pueden usarse para 
conseguir una óptima variación de tono y 
aleatoriedad para instrumentos que la 
necesiten, como por ejemplo salterios, 
koras y otros instrumentos no occidentales. 
Por ejemplo, para crear un sonido metálico 
bajo que suene semejante a un carillón, use 
el "Glockenspiel Mono" del CD-ROM 
Library #1 y redúzcalo dos octavas.

Pruebe una de las técnicas descritas a 
continuación, o ambas, para refinar la 
afinación del instrumento. El primer 
método desafina el instrumento completo 
a incrementos que no sean de medio tono. 
El segundo método añade aleatoriedad de 
tono al esquema de tono existente para el 
instrumento.
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Método 1: incrementos que no sean 
de medio tono:

1  Abra la ventana Misc y desactive Key 
Track. 

2  Abra la ventana Trackers y seleccione 
MIDI Note # en el menú emergente. 
Mantenga lineal la curva de Tracker (es 
decir, como diagonal recta). Pulse la tecla 
Opción (Macintosh) o Alt (Windows) 
mientras hace clic en la curva para 
restablecer su posición, si es preciso.

3  Abra la ventana Matrix, asigne Tracking 
Generator a Pitch y configure Amplitude en 
99.

Esta acción debería dar como resultado 
incrementos que no sean de medio tono. 
Experimente con la amplitud de Matrix y la 
curva de Tracker hasta obtener la 
entonación deseada.

Método 2 : aleatoriedad de tono

1  Abra la ventana Trackers y elija Random 
Generator para una de las entradas de 
Tracker.

2  Trace una curva de respuesta para ese 
Tracker. Las áreas en las que eleva la curva 
sonarán con más cantidad de generador 
aleatorio. Esta curva será la base de la 
aleatoriedad del instrumento, 
representación visual de los rangos en que 
éste será bemol o sostenido.

3  Abra la ventana Matrix y asigne a Pitch 
este Tracking Generator. Comience con un 
valor de amplitud bajo (entre +5 y +15) 
para luego ajustarlo al grado de amplitud 
de Matrix que crea conveniente.

Esto producirá una leve desafinación del 
instrumento con respecto a sí mismo, 
manteniendo un tono centrado.



Para obtener una mayor variedad de 
respuesta del instrumento, regrese a la 
ventana Matrix y asigne Random 
Generator a Pitch con valor moderado de 
amplitud de Matrix, entre 10 y 15. Elija una 
nota en su controlador y tóquela 
repetidamente para oír la variación de tono 
causada por Random Generator. Tenga en 
cuenta que Random Generator suele ser 
una fuente de modulación moderada. Esto 
puede añadir una viva desestabilización de 
tonalidad del instrumento.

☞ Para información adicional sobre técnicas 
de afinación, véase "Coros" en la página 89.

Configuración de vibrato 
dinámico: matriz, generadores 
de seguimiento, moduladores
Los generadores de seguimiento también 
pueden usarse para configurar vibrato 
dinámico. SampleCell ofrece un tipo de 
vibrato predeterminado mediante la 
asignación de LFO 1 a Pitch. Usando el 
generador de seguimiento, puede aplicar 
una curva de respuesta para que la anchura 
del vibrato varíe dependiendo del tono 
relativo de la nota.

Para este ejemplo, tenga en cuenta cómo 
suena el vibrato en los violines reales y 
otros instrumentos de cuerda con arco: el 
vibrato suele ser más amplio en los registros 
superiores que en los inferiores. La razón de 
esto debería ser evidente si se observa el 
mástil de una guitarra, cuyos trastes están 
más juntos en la parte superior que en la 
inferior. Cuanto más alta sea la frecuencia, 
menor será la distancia entre tonos. La 
misma técnica de vibrato puede hacer 
variar el tono ± un cuarto al aplicarse a la 
nota más baja, pero la variación será 
mucho mayor (la mitad, tres cuartos de 
tono) si se aplica una octava por encima, en 
la misma cuerda.

Puede usar el generador de seguimiento 
para definir una curva que, al asignarse a la 
amplitud LFO 1 de generación de vibrato, 
puede incrementar la amplitud del vibrato 
en los registros superiores para obtener el 
efecto deseado. Aunque es fácil conseguir 
esto mediante la asignación de MIDI Note 
# a LFO 1 Amplitude en la ventana Matrix, 
la resolución de amplitud de Matrix puede 
ser insuficiente para lograr el resultado 
deseado (véase "Incremento de resolución 
de asignaciones de Matrix: matriz, 
generadores de seguimiento" en la 
página 81). Los controles Tracker pueden 
proporcionar un grado más moderado de 
variación de vibrato, especialmente con 
instrumentos de rango limitado.

1  Abra la ventana Trackers y seleccione 
MIDI Note # en uno de los menús 
emergentes Tracking Generator.

2  Ajuste la curva elevando ligeramente los 
nodos superiores o bajando ligeramente los 
nodos inferiores (compare el efecto 
conseguido con cada uno de los métodos).

3  Abra la ventana Matrix, asigne Tracking 
Generator a LFO 1 Amplitude y asegúrese 
de que LFO 1 está asignado a Pitch.

4  Abra la ventana Modulators y ajuste la 
configuración de LFO 1.

5  Regrese a la ventana Matrix y, mientras 
ejecuta una reproducción con el 
controlador o secuenciador, ajuste la 
amplitud de ambas rutas de Matrix hasta 
conseguir el resultado deseado.
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Vibrato retardado: matriz, 
generador de rampa, 
generadores de seguimiento, 
envolventes
Otro parámetro de vibrato de gran efecto es 
la temporización de la aplicación del 
vibrato a la nota. Muchos cantantes e 
instrumentistas no aplican vibrato de 
inmediato. En su lugar, una nota larga se 
mantendrá constante para una cantidad de 
tiempo variable y se coloreará 
gradualmente con incrementos de vibrato. 
En SampleCell, esto puede lograrse 
asignando la rueda de modulación a la 
amplitud LFO apropiada (muchos 
instrumentos están así configurados de 
modo predeterminado), usando el 
generador de rampa para retardar el vibrato 
con una cantidad constante, o mediante 
una envolvente para retrasar el vibrato en 
cantidad variable.

Rueda de modulación. La rueda de 
modulación para controlar la amplitud 
LFO constituye el modo más sencillo de 
lograr un vibrato con retardo. Este método 
es ideal cuando se dispone de una mano 
libre, pero no sirve de nada si tiene ambas 
manos ocupadas y no dispone de un 
controlador con pedal. En ese caso, puede 
optar por uno de los siguientes métodos:

Generador de rampa. El uso del generador 
de rampa también sirve para configurar 
fácilmente un efecto de vibrato con 
retardo. El único inconveniente de esta 
técnica es que la velocidad del generador de 
rampa propiamente dicho no puede 
modularse con ningún otro parámetro 
(como Mod Wheel, MIDI Note #, Pressure, 
etc.). 
Guía de SampleCell II
Envolvente. El uso de una envolvente para 
controlar el retardo del vibrato ofrece una 
gran flexibilidad, y sólo requiere unos 
cuantos pasos adicionales.

Para retardar el vibrato con el generador de 
rampa:

1  Abra la ventana Modulators y configure 
un valor bastante alto de Ramp Time, para 
que sea más fácil oír el efecto al principio; 
puede reajustarlo posteriormente. Puede 
que le resulte más fácil configurar el valor 
de Ramp Time si elige Display Real Units 
como una de sus preferencias. De este 
modo los tiempos de rampa se mostrarán 
en milisegundos.

2  Abra la ventana Matrix y asigne Ramp 
Generator a LFO 1 Amplitude. Configure la 
amplitud de ruta de Matrix en una 
cantidad moderada (aprox. 30).

3  Si es preciso, ajuste el valor de Ramp 
Time en la ventana Modulators, o la 
amplitud del parámetro Ramp>LFO 
Amplitude en la ventana Matrix, hasta 
lograr el efecto deseado.

Aunque el ejemplo anterior ofrece 
resultados útiles, el nivel de retardo (es 
decir, el tiempo que tarda en producirse el 
vibrato) se mantiene al margen de cuál sea 
el tono. Para evitar una aplicación tan 
lineal del vibrato, puede utilizar un 
generador de seguimiento para añadir una 
curva de respuesta al nivel de retardo.



Para retardar el vibrato con el generador de 
seguimiento:

1  Abra la ventana Trackers y elija MIDI 
Note # en el menú emergente de uno de los 
controles Tracker.

2  Defina una curva de respuesta para el 
generador de seguimiento. Para que el 
vibrato se produzca más rápidamente en 
los registros altos, eleve ligeramente los 
nodos superiores. Para que se produzca más 
lentamente en las notas de registro bajo, 
baje ligeramente los nodos de la izquierda.

3  Abra la ventana Envelopes y configure 
una inclinación de ataque gradual para 
Envelope 1 o 2 (dependiendo de cuál esté 
en uso), pero no use Envelope 3. Si activa la 
opción Display Real Unit Values (en la 
ventana Preferences) podrá ver la 
configuración de Envelope expresada en 
unidades de tiempo.

4  Abra la ventana Matrix. Asigne el 
generador de seguimiento adecuado a la 
opción requerida de Envelope Attack, 
configure la amplitud en un valor 
ligeramente negativo (por ejemplo -11). 
Esto hará que las notas altas reduzcan el 
tiempo de Envelope Attack. 

5  Asigne Envelope Attack a LFO 1 
Amplitude con una amplitud positiva 
moderada (entre 30 y 40). 

6  Oiga el resultado de sus modificaciones, 
reproduciendo y manteniendo notas en los 
registros inferior, medio y superior de su 
controlador, y fíjese en el momento de 
aparición del vibrato.

Puede regresar a las ventanas Tracking 
Generator o Matrix para ajustar el retardo 
de vibrato hasta conseguir el efecto 
deseado.
Filtros
Un filtro monopolar de un instrumento 
puede usarse para conseguir numerosos 
efectos de gran interés. Dos de esos posibles 
usos consisten en hacer más nítidos 
instrumentos de percusión y reducir ruido 
en muestras con ataques lentos.

Uso del filtro para el control 
dinámico de la nitidez de 
percusión
Una forma simple y eficaz de hacer más 
nítidas sus secuencias de batería y 
percusión consiste en utilizar filtros de 
SampleCell.

Quizás el modo más rápido de comprobar 
esto sea usar la ventana Matrix para asignar 
Velocity a Filter con una amplitud de 
Matrix de ±30 (no muy alta, para evitar que 
el filtro se cierre completamente en notas 
bajas). Esta asignación imita el modo en 
que las baterías reales suelen sonar más 
claras al golpear más fuerte, y viceversa. 
Configure Filter Amount (en la ventana 
Misc) en un punto por debajo del máximo. 
Configure el parámetro Overlap Amount 
(en la ventana Misc del instrumento) en 
aproximadamente 2/3 del máximo. Esto 
evita que unas notas corten notas 
precedentes ya que el filtro responde a 
nuevos valores de velocidad. 

La única limitación de esta técnica es que 
no hay ningún profesional de la batería tan 
consistente como la resolución 0 - 127 de la 
velocidad MIDI. Para situaciones que 
requieren una variación que exceda el 
ejemplo de velocidad a filtro mencionado, 
puede añadir el generador aleatorio a la 
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muestra, para modular el filtro de forma 
más o menos moderada. Para ello, 
configure Velocity a Filter Matrix, hasta 
que suene lo mejor posible. Luego cree una 
ruta Matrix adicional en que el generador 
aleatorio controle el filtro. Ahora debería 
tener dos fuentes diferentes: la velocidad y 
el generador aleatorio, ambas asignadas al 
filtro. 

Configure la amplitud de Matrix de la ruta 
generador aleatorio a filtro en un valor 
relativamente alto, y experimente hasta dar 
con un buen equilibrio entre el control del 
filtro mediante la velocidad opuesto a 
variaciones aleatorias en frecuencia desde 
el generador aleatorio. Tenga en cuenta 
que Random Generator es una de las 
fuentes de modulación más moderadas, de 
modo que puede ser preciso acumular 
diversas asignaciones de Random 
Generator a Filter para que los resultados 
sean más patentes.

✽ Para facilitar el trabajo con este ejemplo, 
defina medidas de cuartos de nota en su 
secuenciador. Configure todos los niveles en 
la primera medida en un volumen bajo (p) y 
repita las mismas notas a un volumen algo 
más alto (m) primero, y todavía más alto (f) 
después. Aplique un bucle a las tres medidas 
y active la reproducción. Deberían oírse 
características de frecuencia diferentes en 
notas consecutivas con velocidades idénticas.
Guía de SampleCell II
Uso del filtro para controlar 
ruido
Con muestras ruidosas, puede suceder que 
la relación señal-ruido en el rango de 
variación inferior sea deficiente. Esto suele 
hacerse más evidente durante la etapa de 
debilitamiento de la muestra, donde podría 
percibir sonido ambiental que parece 
aumentar con el fundido de salida del 
efecto o el instrumento muestreado. Para 
reducir el efecto del ruido, pruebe a asignar 
Envelope 3 a Filter, con una amplitud 
positiva moderada de Matrix, para que el 
filtro se abra al crecer el sonido o se cierre al 
debilitarse el sonido.

Uso del filtro con efectos de 
sonido para película o vídeo
También puede usar su controlador MIDI 
externo y filtros de SampleCell para 
controlar la forma de espectro de sus 
muestras. Este efecto funciona 
especialmente bien con sonidos que 
contienen numerosos datos de alta 
frecuencia. 

A continuación describiremos una 
situación para ilustrar su utilidad. 
Supongamos que estaba creando efectos de 
sonido para una escena de vídeo o película 
en la que figura un avión a reacción. Si la 
escena tiene lugar en mitad de un campo 
abierto, la muestra sin procesar procedente 
de su biblioteca de efectos de sonido sonará 
lo suficientemente real. Pero sería diferente 
si la escena se desarrollara en una ciudad, 
en una calle flanqueada por rascacielos. En 
esa situación, el sonido de los motores 
quedaría amortiguado pero iría 
aumentando hasta que el avión pase por 



encima suyo, momento en que resultaría 
ensordecedor. Al pasar de largo y 
desaparecer detrás de los edificios, el 
sonido disminuiría bruscamente y luego se 
desvanecería en la distancia.

Asignando su rueda de modulación a los 
filtros y viendo el vídeo de referencia puede 
trazar manualmente una inclinación ADSR 
de acuerdo con la temporización del avión 
aproximándose (el filtro abriéndose 
lentamente), el avión sobre su cabeza (el 
filtro totalmente abierto) y el ruido 
disminuyendo (el filtro se cierra otra vez 
gradualmente).

Para conseguir lo mismo sin intervenir en 
la acción, sin usar la rueda de modulación, 
asigne Envelope 1 o 2 para que controlen el 
filtro y, a continuación, configure la 
envolvente para que se aproximen a la 
temporización del material de referencia. 

Ideas para instrumentos de 
orquesta
En esta sección nos centraremos en dos 
formas de crear rutas expresivas de 
controlador de rendimiento para 
instrumentos de orquesta tales como el 
corno o la sección de cuerdas.

La variación de tono o la modulación de 
tono LFO son muy útiles para sonidos de 
sintetizador o incluso algunos 
instrumentos acústicos de solo como, por 
ejemplo, guitarras o trompetas. Sin 
embargo, los instrumentos acústicos de 
orquesta no suelen sonar muy auténticos 
cuando todos ellos se modulan con la 
misma frecuencia, y como resultado, la 
rueda de modulación (o la de tono) apenas 
se usan con dichos instrumentos. Esto deja 
la rueda de modulación o de tono 
disponible para control en tiempo real de 
otros parámetros, que puede usar para 
conseguir fantásticos efectos.

Expresividad mejorada con 
Sample Select
Esta técnica requiere un instrumento de 
orquesta con varias zonas de velocidad por 
grupo de notas, cuantas más zonas mejor. 
El componente principal de este efecto es el 
control de la selección de muestra con una 
rueda de control (preferentemente la de 
modulación). Cuando las zonas de 
velocidad del instrumento contienen 
diversas variaciones de sonido, se obtiene 
más expresividad a través del rango de 
variación del instrumento. Cuando las 
zonas de velocidad diferentes contienen 
distintas melodías o inflexiones estilísticas, 
la rueda de modulación permite obtener 
más matices. Muchos de los instrumentos 
de orquesta de viento y cuerda en los 
CD-ROMs de SampleCell II ya utilizan esta 
asignación de Matrix.

Para crear esta configuración, abra la 
ventana Matrix y asigne Mod Wheel a 
Sample Select. Puede que, de momento, 
prefiera desactivar cualquier otra 
asignación de rueda de modulación (por 
ejemplo, LFO u otras asignaciones 
estándar). Experimente con la rueda de 
modulación mientras ejecuta la 
reproducción a distintos niveles de 
variación. La rueda de modulación puede 
provocar la activación de las zonas de 
velocidad superiores, pero el volumen 
seguirá controlado por la velocidad. Esto 
puede ayudar a rellenar huecos de colores 
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disponibles al añadir partes de conjunto a 
secuencias. Puede hacer la prueba con Rock 
& Roll Horns en el CD-ROM SampleCell 
Library #1, por ejemplo. 

También puede usar esta técnica para 
simular el efecto en tiempo real de la barra 
de "percusión" de un órgano Hammond 
que se presiona y se libera. Si carga 
muestras con mucha percusión en las 
zonas de velocidad superiores, la rueda de 
modulación permitirá activar sonidos con 
un ataque más vivaz, incluso a baja 
velocidad. 

Un truco adicional para expresividad 
realzada consiste en asignar la rueda de 
modulación a la amplitud de Envelope 3 
con una amplitud de Matrix de -99 (con lo 
que se convierte en una rueda de volumen 
invertida para fundidos). A continuación, 
abra la ventana Trackers y, después de 
seleccionar Mod Wheel en el menú 
emergente, edite la curva en uno de los 
generadores de seguimiento; pruebe con 
una inclinación en forma de rampa 
ascendente (similar al fundido de entrada 
de Pro Tools o Sound Designer). La 
combinación de estas dos asignaciones de 
Matrix permite a la rueda de modulación 
ofrecer un mayor rango de expresividad de 
variación.
Guía de SampleCell II
Realismo acentuado para 
cuerda mediante varias 
matrices de envolvente
Los instrumentos de cuerda con arco, dada 
su técnica inherente, no tienen curvas de 
ataque uniformes a diferentes niveles de 
variación. Cuando se toca con el arco un 
violoncelo para producir una nota alta, el 
instrumento responde instantáneamente y 
el sonido es perceptible de inmediato. Pero 
cuando el arco se maneja suavemente, el 
ataque se retarda ligeramente debido al 
movimiento más lento del arco sobre la 
cuerda.

Si trabaja con un número relativamente 
reducido de muestras, puede simular este 
efecto asignando Envelope 1 o 2 a Envelope 
3, que controla la amplitud. Envelope 1 (o 
2) se moldea con un ataque lento para 
responder a notas tocadas suavemente, 
mientras que Envelope 3 tiene un ataque 
"normal" y está configurado para responder 
a velocidades altas.

1  Abra la ventana Envelopes. 

2  Edite Envelope 2 incrementando el 
tiempo de ataque para que sea superior 
(más lento) que el ataque de Envelope 3. 
Cuanto mayor sea la diferencia entre estos 
dos parámetros, más pronunciado será el 
efecto.

3  Abra la ventana Matrix y cree las 
siguientes asignaciones:
• Velocity a Envelope 2 Amplitude 90
• Envelope a Envelope 3 Attack  30

Para darle más veracidad a esta 
configuración, asigne Envelope 2 a Filter 
con una amplitud de matriz máxima (99). 



Coros
Los efectos de coro son ideales para añadir 
consistencia a ciertos instrumentos y avivar 
su sonido. El ejemplo siguiente 
proporciona resultados muy satisfactorios:

1  Cargue el instrumento al que quiere 
aplicar el efecto de coros (los violines 
sostenidos son apropiados en este caso).

2  En la ventana de banco, copie y pegue el 
instrumento, con lo que tendrá dos copias 
del mismo en el banco.

3  Abra la ventana Misc del segundo 
instrumento (el copiado) y desintonícelo 
ligeramente (use el control deslizante 
Detune, no Pitch Semitone).

Si desea más efectos de este tipo, 
experimente con una asignación de 
Modulator a Pitch para el segundo 
instrumento, y pruebe diversas 
configuraciones de LFO Sync y Waveform.

Efectos y trucos variados

Pisadas: uso de velocidad para 
controlar el inicio de zona
Al añadir a un proyecto pisadas o un efecto 
de sonido tipo Foley, no suele bastar con 
incrementar el volumen a medida que el 
personaje se acerca a la pantalla. Para 
acercamientos prolongados, también 
debería adaptar las pisadas para que el 
ataque del sonido se haga más 
pronunciado con el acercamiento. Esto 
puede lograrse asignando Velocity a 
Sample Start Point en la ventana Matrix, 
mediante el siguiente procedimiento:
1  Abra la ventana Sample Parameters para 
las zonas que contienen muestras de pisadas.

2  Ajuste el inicio de zona a la velocidad 
más baja que tenga intención de utilizar.

3  Abra la ventana Matrix y asigne Velocity 
a Sample Start Point.

4  Configure un valor negativo de amplitud 
para la asignación. Esto hará que la muestra 
se inicie un poco antes con velocidades altas.

Efectos para batería: uso de 
aleatoriedad de muestras para 
reducir repetición
La aleatoriedad de muestras permite 
reproducir éstas al azar con las mismas 
notas MIDI. Esto es especialmente útil para 
hacer que las baterías muestreadas suenen 
menos repetitivas. Para conseguir este 
efecto, haga lo siguiente:

1  Cargue dos muestras, o más, en las zonas 
de velocidad de un grupo de notas.

2  Ajuste las zonas en una posición baja (es 
decir, colóquelas cerca de la parte inferior 
del grupo de notas).

3  En la ventana Matrix, defina tres 
asignaciones idénticas de Random 
Generator a Sample Select con un valor de 
amplitud de 99.

Este ejemplo sólo funciona con muestras 
mono, porque el generador de aleatoriedad 
realiza selecciones izquierda/derecha de 
modo independiente. Por ejemplo, podría 
reproducir el canal izquierdo de la muestra 
1 y el canal derecho de la muestra 2. Si 
trabaja con muestras estéreo puede evitar 
contratiempos utilizando LFO, en lugar del 
generador de aleatoriedad, para modular la 
selección de muestra.
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capítulo 8

Interfaz SampleCell II
Menú File

New
Crea un banco o un instrumento. 

Seleccione Bank y haga clic en OK para 
crear un banco nuevo, vacío. 

Para crear un nuevo instrumento dentro 
del banco actual, elija el tipo de 
instrumento deseado. 

Existen cuatro tipos de instrumentos:

Multi-Sample Instrument. Los instrumentos 
de muestras múltiples son los que usan una 
o varias muestras mono con opciones de 
modulación.

Stereo Multi-Sample Instrument. Los 
instrumentos estéreo de muestras múltiples 
son los que usan una o varias muestras 
estéreo con opciones de modulación.

Single-Sample Instrument. Los 
instrumentos de muestra única son los que 
usan una o varias muestras mono en un 
solo grupo de notas sin opciones de 
modulación.
Stereo Single-Sample Instrument. Los 
instrumentos de muestra única estéreo son 
los que usan una o varias muestras estéreo 
en un solo grupo de notas sin opciones de 
modulación.

Debe haber una muestra asociada al 
instrumento. 

Open
Cargue un banco, instrumento o muestra 
existente en cualquier tarjeta SampleCell 
disponible. 

Close
Cierra la ventana activa.

Save All Changed
Guarda todas las modificaciones aplicadas 
a cualquier banco abierto y todos los 
instrumentos incluidos.

Save Bank
Guarda el banco actual en la unidad y el 
directorio desde el que se había cargado. 
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Save Bank As
Guarda el banco actual en la unidad y 
directorio especificados. Este comando 
también permite guardar instrumentos y 
muestras en un nuevo directorio. 

Revert Bank
Vuelve a la última versión guardada del 
banco actual.

Save Instrument
Guarda el instrumento seleccionado 
actualmente en la unidad y el directorio 
desde el que se había cargado.

Save Instrument As
Guarda el instrumento actual en la unidad 
y directorio especificados. También 
permite guardar en un nuevo directorio 
todas las muestras asociadas con el 
instrumento.

Revert Instrument
Vuelve a la versión del instrumento actual 
guardada previamente.

Get Bank Info
Muestra información sobre el banco actual. 
Los cuadros de diálogo Open y de búsqueda 
muestran comentarios sobre información 
de banco.

Quit
Cierra SampleCell.
Guía de SampleCell II
✽ Al cerrarse un banco, se silencian todos los 
instrumentos que contiene. Al salir de 
SampleCell, los instrumentos actuales 
permanecen en la RAM, de modo que puede 
seguir usándolos aunque se haya cerrado 
SampleCell Editor.

Menú Edit

Undo
Deshace el último comando u operación de 
edición que se haya ejecutado (pero tenga 
en cuenta que algunas acciones son 
irreversibles).

Cut Instrument
Elimina de un banco el instrumento que 
está seleccionado y lo copia en el 
portapapeles. Es irreversible.

Copy Instrument
Coloca en el portapapeles una copia del 
elemento seleccionado actualmente sin 
eliminarlo del banco. Es irreversible.

Paste Instrument
Pega en el banco actual un instrumento 
copiado al portapapeles. Se conserva una 
copia del instrumento en el portapapeles. 
Es irreversible.

✽ Al pegar instrumentos en un sistema con 
varias tarjetas SampleCell, aparece un cuadro 
de diálogo en el que el usuario debe indicar en 
qué tarjeta desea pegar el instrumento.



Clear Instrument
Elimina de un banco el instrumento que 
está seleccionado sin copiarlo al 
portapapeles. Es irreversible.

Menú Instruments

New Velocity Zone
Crea una nueva zona de velocidad dentro 
del grupo de notas seleccionado 
actualmente (el máximo son seis zonas por 
grupo). Permite asociar la muestra o región 
a la nueva zona de velocidad. Haciendo clic 
en el botón de reproducción puede oírse la 
muestra o región seleccionada con el tono 
base. Si se requiere una muestra estéreo 
para un instrumento mono, existe un 
cuadro de diálogo en el que es posible 
seleccionar el canal 1 (izquierdo) o el 2 
(derecho) como único canal que cargar.

New Key Group
Crea un nuevo grupo de notas con la 
muestra especificada en el cuadro de 
diálogo subsiguiente. Cada instrumento 
puede tener un máximo de 60 grupos de 
notas. Haciendo clic en el botón de 
reproducción puede oírse la muestra 
seleccionada con el tono base. El nuevo 
grupo de notas se sitúa en el extremo 
derecho de la ventana Sample Map, con un 
rango predeterminado de una nota.

✽ Si trabaja en un sistema Windows, puede 
seleccionar varios archivos de muestras 
desde el cuadro de diálogo New Key Group.
Add Multiple Key Groups
(Sólo para Macintosh)

Permite seleccionar varias muestras y 
cargarlas todas en una sola operación. Este 
comando es útil para crear rápidamente 
instrumentos de muestras múltiples.

Load Sample
Carga la muestra para la zona/grupo de 
notas que haya seleccionado. Este 
comando se utiliza junto con la opción de 
preferencia "Automatically load samples". 
Si esta opción no está seleccionada, 
SampleCell cargará sólo información de 
directorio de un instrumento; la muestra 
no se cargará hasta que el usuario elija el 
comando Load Sample. Este método es útil 
para abrir bancos o instrumentos 
demasiado grandes para cargar en la tarjeta 
SampleCell.

Unload Sample
Descarga la muestra seleccionada 
actualmente pero conserva la referencia de 
archivo y los límites de zona de velocidad y 
grupo de notas.

Reload Sample
Se utiliza para cargar una versión recién 
editada de una región o una muestra. Si 
modifica una muestra o una región, la 
muestra original permanece en SampleCell 
hasta que se actualice mediante este 
comando.
Capítulo 8: Interfaz SampleCell II 93



94
Change Sample
Permite cargar una nueva muestra en la 
zona/grupo de notas que haya 
seleccionado. También se aplicarán a la 
nueva muestra los demás parámetros 
configurados (punto de inicio, afinación, 
etc.).

Sample Parameters
Abre o activa la ventana Sample Parameters 
para la muestra de instrumento 
seleccionada.

✽ La ventana Sample Parameters también 
puede abrirse haciendo doble clic en una 
muestra (es decir, en un grupo de notas o una 
zona de velocidad) desde la ventana Sample 
Map, o haciendo clic en el icono de diapasón 
con una muestra resaltada en la ventana 
Sample Map.

Ventana Sample Parameters

La parte superior de la ventana Sample 
Parameters contiene la siguiente 
información:

Instrument. El nombre del instrumento de 
SampleCell que contiene el archivo de la 
muestra seleccionada actualmente.

File. El nombre del archivo de la muestra 
seleccionada actualmente.

Size. El tamaño de la región o del archivo 
que esté seleccionado.

Volume. La ubicación del archivo de la 
muestra seleccionada actualmente.

Region. La región seleccionada 
actualmente.
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Time. La duración del archivo o de la región 
(en segundos).

A continuación se describen los parámetros 
de muestra globales (es decir, afectan a 
todos los instrumentos que usen copias de 
la muestra seleccionada actualmente):

Sample Start Coarse. Ajusta el punto de 
inicio de la muestra en la duración total de 
la misma.

Sample Start Medium. Permite realizar 
ajustes precisos del parámetro Sample Start 
Coarse.

Sus Loop Fine Tune. Especifica la afinación 
precisa del tono de la muestra durante el 
bucle de sostenimiento. Este control 
deslizante sólo está disponible con 
muestras que contienen dos bucles.

Sus/Rel (Rel) Loop Fine Tune. Especifica la 
afinación precisa del tono del bucle Sus/Rel 
(sostenimiento) o Rel (liberación) de una 
muestra. Este control deslizante no está 
disponible con muestras que no contienen 
bucles. Cuando la muestra tiene un solo 
bucle, el control deslizante Sus/Rel permite 
afinar con precisión el audio que se va a 
reproducir en la etapa de sostenimiento y 
de liberación. Con muestras de dos bucles, 
este control deslizante se convierte en el 
control Rel y permite afinar el audio en 
bucle en la fase de liberación del sonido.

Sample Fine Tune. Especifica la afinación 
precisa general del tono de la muestra.

Sus Loop Enable. Esta opción activa el bucle 
de sostenimiento. Haga clic en ella para 
activarla y desactivarla. Sólo está 
disponible con muestras de dos bucles.



Sus/Rel (Rel) Loop Enable. Si está 
seleccionada esta opción, se activa el bucle 
Sus/Rel o el bucle Release, según el caso. 
Haga clic en ella para activarla y 
desactivarla.

A continuación se describen los parámetros 
de zona (afectan sólo a la muestra del 
instrumento actual):

Key Group Pan. Controla el panorámico de 
la muestra seleccionada dentro del campo 
estéreo del instrumento. El valor cero 
representa un panorámico de audio 
idéntico a la izquierda y a la derecha.

Sample Amplitude. Volumen individual de 
la muestra seleccionada.

Fine (Zone Start). Define el punto inicial 
de reproducción de la zona de velocidad, 
en incrementos menores que Sample Start 
Coarse o Medium. Este parámetro sólo 
afecta a la muestra seleccionada 
actualmente (pero no a copias de ésta 
usadas en otros instrumentos abiertos). Es 
útil para eliminar silencios no deseados o 
transitorios al comienzo de una muestra. 
Rango: 0 (sin desfase) a 127 (32.512 ciclos 
de forma de onda) en incrementos de 256.

MIDI Root Note. Permite repetir las 
asignaciones de una muestra, de modo que 
la nota especificada reproduzca la muestra 
en el tono original, sea cual sea la ubicación 
del grupo de notas dentro del rango de un 
instrumento. Para modificar el parámetro, 
arrastre el teclado emergente hasta un 
nuevo valor de nota.

Direction. Determina si la muestra se 
reproducirá hacia atrás o hacia delante. Si 
se opta por la opción Backward, no se 
tendrán en cuenta los posibles bucles.
Launch Sample Editor
Activa la aplicación de edición de muestras 
y abre la muestra seleccionada. Después de 
editarla tendrá que utilizar el comando 
Reload Sample si la edición ha sido 
destructiva o el comando Change Sample 
para cargar una nueva versión de la 
muestra.

Select Sample Editor
Permite designar la aplicación de edición 
de muestras que debe iniciarse al hacer clic 
en el botón Edit Sample.

Edit Loops
Permite elegir un archivo de audio para 
cargarlo en la ventana Edit Loops. Cuando 
la ventana Edit Loops abre el archivo 
seleccionado, el modo de vinculación a 
SampleCell está desactivado de modo 
predeterminado.

Edit "nombre de muestra"
Carga en la ventana Edit Loops la muestra 
seleccionada en la ventana Sample Map. 
Cuando la ventana Edit Loops carga la 
muestra seleccionada, el modo de 
vinculación a SampleCell se activa.

Convert Instrument to 
Stereo/Mono
Convierte el instrumento seleccionado a 
estéreo, si es mono, y viceversa. El nombre 
del nuevo instrumento incluirá la 
identificación "mono" o "stereo".
Capítulo 8: Interfaz SampleCell II 95



96
Get Instrument Info
Muestra comentarios acerca del 
instrumento seleccionado. Esta 
información es útil para saber, por ejemplo, 
qué elementos controlan ciertas funciones 
(la rueda de tono controla el tono, la rueda 
de modulación controla el panorámico...).

Set Instrument Defaults
Guarda como predeterminados los 
parámetros (Modulators, Envelope, Misc., 
etc.) del instrumento seleccionado, para 
usarlos al crear otros instrumentos o 
añadirlos a bancos. Si crea un nuevo 
instrumento, la configuración guardada se 
aplicará a todo el instrumento. Si abre un 
instrumento en un banco, sólo se aplicarán 
los parámetros a nivel de banco (Panning, 
MIDI channel, Instrument Volume, etc.), ya 
que los parámetros a nivel de instrumento se 
toman del archivo de instrumento.

Map All Instruments
Vuelve a asignar todos los instrumentos del 
banco actual y ajusta el rango de nota 
Hi/Lo de cada instrumento para que tenga 
un rango de nota exclusivo. Por ejemplo, si 
se añaden a un banco dos instrumentos y 
los rangos de nota de ambos son A0 - C8, el 
comando Map All Instruments reasignará 
el rango Lo/Hi A0 - F4 al primer 
instrumento (el de la izquierda) y el rango 
F#4 - C8 al segundo instrumento.
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Set Root Notes
Permite definir o volver a definir la nota 
base MIDI para una muestra seleccionada, 
basándose en la nota inferior, superior o 
media del grupo de notas de la muestra.

✽ Macintosh: Si trabaja con archivos AIFF, 
también puede configurar la nota base MIDI 
utilizando la definición contenida en el archivo.

Reorder Key Groups By Root 
Note
Reorganiza los grupos de notas 
seleccionados en un instrumento 
(incluidos los situados a la derecha del 
grupo o la zona en cuestión); se sigue un 
criterio ascendente por nota base.

Spread Key Groups
Mueve y modifica el tamaño de los grupos 
de notas seleccionados para que tengan igual 
ancho/rango (se incluyen los situados a la 
derecha del grupo o la zona en cuestión).

Menú SampleCell

Load All Samples
Permite cargar todas las muestras necesarias 
para el banco y los instrumentos actuales.

Delete Unused Samples
Elimina de la memoria muestras que no se 
estén usando con los instrumentos 
cargados actualmente en la memoria.



Test SampleCell
Comprueba diversos chips de RAM y ROM 
en la tarjeta SampleCell II. En el 
Apéndice C: Comprobación del hardware 
SampleCell II encontrará una descripción de 
la ventana Test SampleCell.

68000 Status. Comprueba el 
microprocesador integrado en la tarjeta.

ASIC. Comprueba el procesador de sonido 
de SampleCell.

SRAM Status. Valida la RAM utilizada para 
los parámetros de instrumento.

DRAM Status. Comprueba la RAM utilizada 
para guardar muestras. Después de realizar 
la prueba DRAM Status, debe apagar el 
ordenador y luego reiniciarlo, si lo desea.

Test Sine. Envía una onda sinusoidal de 
código completo a través de cada una de las 
salidas analógicas de SampleCell II. 

▲ Advertencia: Antes de efectuar la prueba 
Test Sine, baje el volumen en su mezclador. 

Monitor SampleCell
Ventana con datos de estado de audio y 
memoria para cada tarjeta SampleCell II 
instalada.

Total Memory. La cantidad total de RAM 
instalada en la tarjeta.

Available Memory. La cantidad de memoria 
disponible para muestras adicionales.

Largest Unused Block. El tamaño del mayor 
bloque de RAM de SampleCell sin usar.
Open Current OMS Studio Setup
(Sólo para Macintosh)

Inicia la aplicación OMS Setup y abre el 
documento Studio Setup actual. Para 
información sobre actualización de OMS 
Studio Setup, véase OMS Manual. 

MIDI Setup
(Sólo para Macintosh)

Abre el cuadro de diálogo OMS MIDI Setup, 
donde pueden activarse y desactivarse 
puertos serie para comunicación MIDI.

El cuadro de diálogo también permite 
iniciar la aplicación OMS Setup haciendo 
clic en New Easy Setup o en Edit Custom 
Setup. Además puede seleccionarse la 
opción Run MIDI in Background.

Para más información, véase OMS Manual.

Cuadro de diálogo OMS MIDI Setup
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Run MIDI in Background

Esta opción también permite a 
secuenciadores compatibles con OMS 
continuar la reproducción MIDI aunque 
hayan dejado de estar activos; de este modo 
puede comprobar cambios en SampleCell 
Editor mientras el secuenciador sigue 
reproduciendo.

Tenga en cuenta que cuando está activada 
la opción Run MIDI in Background y tanto 
SampleCell Editor como su secuenciador 
emiten eco de MIDI thru al mismo 
instrumento, se producirán notas dobles. 

Para evitar este problema, desactive el "eco" 
MIDI en su secuenciador, o asegúrese de 
que MIDI no se dirija a un instrumento de 
SampleCell.

All Notes Off
Al volver a canalizar un instrumento es 
posible dirigir una nota desactivada al 
nuevo canal y no al actual (el que está 
sonando). El comando All Notes Off 
silencia temporalmente todos los 
instrumentos de los bancos abiertos para 
arreglar notas bloqueadas.
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Preferences
Permite personalizar los parámetros 
operativos de SampleCell. 

Ventana Preferences (Macintosh)

Ventana Preferences (Windows)



Preferencias generales
Automatically delete unused samples...  

Asegura la eliminación de muestras 
asociadas a un instrumento al eliminar 
éste, siempre y cuando no se utilicen con 
otro instrumento. Se recomienda activarla 
para una gestión de memoria eficaz (a 
menos que se prevea la carga de un 
instrumento que vaya a utilizar las mismas 
muestras).

Pass MIDI Through from the editors control 
port... Permite avanzar y retroceder para 
ajustar parámetros de SampleCell sin 
necesidad de seleccionar el canal MIDI 
apropiado para activar el instrumento 
seleccionado. Los datos MIDI entrantes se 
enviarán al canal MIDI del instrumento 
seleccionado, sea cual sea la asignación de 
canal MIDI. Si se desactiva esta opción se 
anula la posibilidad de activación doble de 
notas, una situación que puede ocurrir 
cuando el secuenciador y el instrumento 
están ya asignados al mismo canal.

Pass MIDI thru unchanged to SampleCell 
(Sólo para Windows). Esta opción pasa a las 
tarjetas SampleCell datos MIDI recibidos en 
todos los dispositivos de entrada. El Editor 
no canaliza los datos MIDI a un 
instrumento determinado antes de 
enviarlos a la tarjeta. Esta opción y la 
anterior se excluyen mutuamente.

Pass MIDI thru when in background (Sólo 
para Windows). Permite a dispositivos MIDI 
externos continuar activando la 
reproducción de la tarjeta SampleCell, 
incluso si SampleCell Editor no es la 
aplicación activa en Windows.
Preferencias de instrumentos
Default new Instruments to "Key Track" off. 

Evita que el tono de nuevos instrumentos 
se vea afectado por notas MIDI. Esta 
función es útil para crear un banco de 
instrumentos con un efecto de sonido en 
cada uno. 

Automatically remap Instruments. Este 
comando distribuye todos los 
instrumentos existentes en el banco actual 
siempre que se añade un nuevo 
instrumento. El rango de instrumentos 
ocupa un rango de 5 octavas (es decir, 
define notas Hi/Lo MIDI), y la nota central 
de cada grupo se asigna a la nota base MIDI. 
Por ejemplo, si tiene abiertos cinco 
instrumentos, el que esté más a la izquierda 
se asigna a C0 - B2 con F#2 como nota base. 
El siguiente instrumento, hacia la derecha, 
se asigna a C3 - B3 con F#3 como nota base, 
y así sucesivamente. Éste es un método fácil 
para crear efectos de sonido o bancos de 
batería sobre la marcha.

Make one Instrument. Cuando está 
seleccionada esta opción, todos los 
archivos de muestra se cargan en un nuevo 
instrumento al arrastrarlos a SampleCell 
Editor. Si son archivos AIFF, la asignación 
de grupo de notas se toma de los 
parámetros en el archivo AIFF.

Si la opción no está seleccionada, se crea un 
nuevo instrumento para cada archivo de 
muestra y la asignación de nota Hi/Lo se 
basará en los parámetros AIFF (de 
haberlos). Si los archivos no son AIFF, se 
organizarán y cargarán por orden 
alfabético de nombre de muestra.
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Try to Assign Unused MIDI Channel for New 
Instruments. Esta opción se impone a la 
configuración de instrumento 
predeterminada y asigna automáticamente 
el primer canal MIDI disponible para cada 
nuevo instrumento.

Si no hay canales MIDI disponibles, el 
instrumento se asignará al canal MIDI 
predeterminado para el instrumento, lo 
que puede ocasionar una duplicación en la 
asignación de canales MIDI.

Esta preferencia sólo busca canales 
disponibles en el banco actual. Si hay 
abiertos varios bancos, es posible que 
asigne un canal MIDI que ya se esté usando 
con otro banco abierto.

Preferencias de apertura y 
carga
Preview using Sound Manager (Sólo para 
Macintosh). Esta opción permite usar 
Sound Manager para oír muestras en los 
cuadros de diálogo de búsqueda, Open, 
New Key Group y Add Multiple Key 
Groups. Si la opción no está seleccionada, 
la operación se realizará a través de la 
tarjeta SampleCell. En este caso, no puede 
detenerse la acción.

Verify sample file locations. Permite 
especificar si SampleCell debe encontrar 
todos los elementos para cargar, o si realiza 
la búsqueda a medida que se carga cada 
instrumento o muestra.

Automatically open all Instruments in a 
Bank.  Si la opción está seleccionada, no 
aparecerá el cuadro de diálogo Select 
Instrument al abrirse los bancos. En este 
cuadro se pueden elegir los instrumentos que 
se desea cargar, y en qué tarjeta SampleCell.
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Automatically Load Samples. Si la opción 
está seleccionada, se cargan las muestras en 
cuanto se abre un instrumento o un banco.

Preferencias de visualización
Display line segment envelopes. Muestra 
representaciones gráficas de parámetros de 
envolvente, en la ventana Envelope.

Default to Small Bank View. Permite 
especificar la vista de banco 
predeterminada. Si esta opción está 
seleccionada, todos los bancos abiertos o 
los que se creen se abrirán en vista 
reducida. Cuando la opción no está 
seleccionada se utiliza la vista completa.

Display Controls in Real Units. Las ventanas 
de parámetros de instrumentos pueden 
configurarse de modo que los valores se 
indiquen en unidades reales (ms, Hz, etc.) o 
en valores de SampleCell (0-127, 0% - 100%).

Loop Editing
Las opciones de esta sección permiten el 
acceso al cuadro de diálogo de selección de 
color para configurar los colores de canal y 
de fondo para la ventana Edit Loops. 
Consulte el Capítulo 6: Edición de muestras, 
bucles y recorte de audio para más detalles. 

Preferencias de búsqueda
(Sólo para Macintosh)

Permite especificar las características 
predeterminadas de la función de 
búsqueda de muestras e instrumentos de 
SampleCell.



Menú Windows

Edición de ventanas
Elija los elementos en la parte superior de 
este menú para abrir o activar las ventanas 
Sample Map, Misc, Envelope, Matrix, 
Modulators y Trackers. Cada una de estas 
ventanas puede abrirse también mediante 
el botón correspondiente en la barra de 
herramientas del Editor. 

Switch Bank Size
Sirve para pasar de una vista de banco a 
otra (de vista completa a vista reducida y 
viceversa) para el banco actual.

Current Bank
En la parte inferior del menú Windows 
aparece una lista de todos los bancos 
abiertos en ese momento. Al seleccionar 
uno de ellos, se convierte en la ventana de 
banco activa.
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apéndice a

Uso de SampleCell II con Pro Tools
Las pistas MIDI de Pro Tools pueden 
reproducirse en instrumentos de 
SampleCell. Si utiliza SampleCell TDM, 
puede dirigir la salida de audio de 
SampleCell a través del bus TDM, 
asignando inserciones y envíos en la 
ventana Mix de Pro Tools.

Para hacer que Pro Tools active SampleCell:

1  Debe tener instalado y configurado OMS 
(Macintosh) o Windows Multimedia 
(Windows) y todos los dispositivos MIDI 
deben estar debidamente conectados y 
encendidos. 

2  Inicie Pro Tools y abra una sesión. 

3  Inicie SampleCell Editor y cargue los 
instrumentos que desee reproducir desde la 
sesión Pro Tools. Para este ejemplo puede 
usar Library Instrument #2 (Drums).

4  Configure el canal MIDI y otros 
parámetros para cada instrumento. Si carga 
Drums, configúrelo en el canal MIDI 10. 

5  En Pro Tools, elija File > New Track.

6  En el cuadro de diálogo New Track, 
seleccione una nueva pista MIDI y haga clic 
en OK.

7  En la ventana Mix, asigne el selector de 
canal de la nueva pista MIDI al canal 
deseado de SampleCell (canal 10 en este 
caso).
8  Haga clic en el botón de activación para 
grabación para la nueva pista MIDI y 
reproduzca unas cuantas notas en su 
controlador MIDI.

El diodo de la pista se ilumina para indicar 
la entrada MIDI; si la dirección de señal es 
correcta, podrá oír la salida de audio desde 
el instrumento de SampleCell.

Si utiliza SampleCell TDM

Si utiliza SampleCell TDM dentro del 
sistema Pro Tools, también puede dirigir 
salidas de audio de SampleCell a Pro Tools 
internamente. Esto permite aplicar 
automatización de Pro Tools al audio de 
SampleCell para obtener mezclas y 
rendimientos óptimos. 

Consulte la Guía de instalación del módulo 
SampleCell TDM para informarse sobre el 
modo de configurar Pro Tools con 
SampleCell TDM. 
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apéndice b

Solución de problemas
Esta sección le ofrece ayuda para resolver 
problemas de instalación, software, MIDI y 
hardware. Es importante que la lea 
detenidamente antes de ponerse en 
contacto con el servicio de asistencia 
técnica de Digidesign.

Notas sobre instalación de 
hardware
Si su ordenador no se inicia o no reconoce 
el software SampleCell después de la 
instalación, compruebe la instalación de la 
tarjeta. Apague el ordenador, toque la 
fuente de alimentación para eliminar 
posible electricidad estática y retire la 
tarjeta. Examine el conector por si hubiera 
alguna patilla doblada. Si esto ha ocurrido 
durante la instalación, póngase en 
contacto con el servicio de asistencia 
técnica de Digidesign.

Si no hay patillas dobladas, vuelva a 
introducir la tarjeta sin forzar la acción y 
asegúrese de que SampleCell encaja bien en 
la ubicación correspondiente. También 
debe asegurarse de que SampleCell no se 
apoye ni toque otras tarjetas instaladas.
Si el problema persiste, puede ser debido a 
la instalación del software, o al hardware 
SampleCell. Consulte las secciones de 
resolución de problemas pertinentes.

Notas sobre instalación de 
software
Si cree que la causa de algún problema está 
en el software, consulte detenidamente la 
sección sobre instalación de software y 
repita la instalación si es preciso.

Asegúrese de que su sistema cumple los 
requisitos mínimos mencionados en 
"Requisitos del sistema" en la página 3.

Macintosh: Si el sistema Macintosh no 
tiene suficiente RAM, puede cambiar la 
partición de memoria de SampleCell 
Editor. Para ello, seleccione (mediante un 
clic) el icono de SampleCell Editor situado 
en el escritorio. Seleccione Get Info en el 
menú File y cambie el valor del tamaño de 
memoria de la aplicación a 1024. Esto 
podría limitar el número de instrumentos 
que SampleCell Editor será capaz de 
manipular, o puede impedir el 
funcionamiento del monitor de audio. 
Tenga en cuenta que esto no afectará a la 
memoria interna de SampleCell.
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Comprobación de entrada MIDI
Para esta prueba, es esencial que OMS 
(Macintosh) o Windows Multimedia 
(Windows) estén en funcionamiento y 
reconozcan SampleCell.

Para asegurarse de que SampleCell recibe 
datos MIDI:

1  Cargue un instrumento en un banco.

2  Configure los parámetros de canal MIDI 
del instrumento para recibir en el mismo 
canal MIDI desde el que transmite su 
controlador MIDI.

3  Haga clic en el icono Sample Map situado 
en la parte superior del panel frontal del 
instrumento. Se abrirá la ventana Sample 
Map.

4  Reproduzca una nota en el controlador 
MIDI. Debería resaltarse la nota 
correspondiente en el teclado en pantalla. 
De ser así, significa que SampleCell recibe 
datos MIDI. Si no se oye nada, consulte 
"Comprobación de salidas de audio" en la 
página 106.

5  Si el teclado en pantalla no muestra la 
nota resaltada, consulte la sección sobre 
conexiones MIDI para su sistema.

6  Compruebe todas las conexiones MIDI 
entre su controlador MIDI y su ordenador. 
De ser necesario, retire temporalmente 
otros elementos MIDI entre ambos 
dispositivos para eliminar variables 
adicionales.

7  Pruebe la interfaz MIDI con otros 
programas de software y hardware para 
asegurarse de que funciona correctamente.
Guía de SampleCell II
Comprobación de salidas de 
audio
Si no oye ningún sonido procedente de 
SampleCell, el problema podría tener 
diversas causas.

1  Cargue un instrumento en un banco. Use 
uno de la biblioteca SampleCell que no 
haya sido modificado.

2  Configure la salida del instrumento de 
acuerdo con el conector de SampleCell que 
utilice su sistema de audio.

3  Centre el control de panorámico de 
audio del instrumento.

4  Configure en 0 el atenuador del 
instrumento.

5  Haga clic en el icono Sample Map situado 
en la parte superior del panel frontal del 
instrumento. Se abrirá la ventana Sample 
Map.

6  Haga clic en una de las notas del teclado 
en pantalla. Si oye sonido, repita la prueba 
con el instrumento en el que detectó el 
problema. Si sigue sin oír nada, compruebe 
la configuración de ese instrumento. Si un 
instrumento produce sonido desde el 
teclado en pantalla pero no desde el 
controlador MIDI, consulte 
"Comprobación de entrada MIDI" en la 
página 106 para asegurarse de que está 
utilizando SampleCell correctamente.

7  Si aún así no oye nada, desconecte los 
cables de las salidas de audio de SampleCell 
y conéctelos a otro dispositivo de audio que 
emita sonido. Si al probarlo con los cables 
no se oye sonido, significa que el problema 
está en los cables o en su sistema de audio.



apéndice c

Comprobación del hardware SampleCell II
SampleCell II tiene integrada una función 
de diagnóstico. Si cree que el hardware no 
funciona correctamente, lleve a cabo los 
siguientes procedimientos de 
comprobación. 

Para probar el hardware SampleCell II:

1  En SampleCell Editor, elija SampleCell > 
Test SampleCell. 

2  Para comprobar el rendimiento de 
68000, ASIC, SRAM o DRAM, haga clic en 
cada uno de los botones Test. Algunas 
pruebas pueden tardar varios minutos. La 
prueba de DRAM puede llegar a durar hasta 
30 minutos con una tarjeta SampleCell de 
32 MB.

1 Prueba de 68000

Si el botón muestra la palabara "Passed" 
significa que la sección funciona 
correctamente y puede continuar con la 
prueba 2. Si la prueba falla, quiere decir que 
el microprocesador de la tarjeta SampleCell 
tiene problemas para comunicarse con el 
ordenador. El fallo de la prueba de 68000 
significa que todas las demás pruebas serán 
asimismo negativas. 

Puede ser que la tarjeta no esté 
debidamente colocada en la ranura. 
Apague el ordenador, saque la tarjeta 
Apénd
SampleCell y examine los contactos para 
ver si están sucios o dañados. Reinstale la 
tarjeta y vuelva a ejecutar la prueba de 
68000. 

Si la prueba sigue resultando fallida, 
póngase en contacto con su proveedor o 
con el servicio de asistencia técnica de 
Digidesign. 

2 Prueba de SRAM 

Si SRAM pasa la prueba satisfactoriamente, 
prosiga con la prueba 3. Si falla, póngase en 
contacto con su proveedor o con el servicio 
de asistencia técnica de Digidesign. 

3 Prueba de ASIC

Si ASIC pasa la prueba, prosiga con la 
prueba 4.

Si las pruebas de 68000 y SRAM son 
satisfactorias pero falla la de ASIC, póngase 
en contacto con su proveedor o con el 
servicio de asistencia técnica de Digidesign.

4 Prueba de DRAM

✽ Esta sección no es aplicable a la tarjeta 
SampleCell II Plus. En esta prueba, los 
módulos SIMM de RAM sólo pueden 
comprobarse con la tarjeta SampleCell 
estándar.
ice C: Comprobación del hardware SampleCell II 107
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La prueba de DRAM puede llegar a durar 
hasta 30 minutos. Si la prueba de DRAM es 
satisfactoria, realice las pruebas Test Sine.

Si falla la prueba de DRAM, compruebe los 
módulos SIMM de RAM de su tarjeta 
SampleCell. Para ello, apague el ordenador 
y desconéctelo. Retire la tapa del ordenador 
y toque la caja de la fuente de alimentación 
para eliminar la posible electricidad 
estática. A continuación, saque la tarjeta 
SampleCell de su ranura, retire toda la RAM 
y reinstálela. Asegúrese de que la RAM está 
bien encajada antes de volver a colocar la 
tarjeta.

Reinstale la tarjeta SampleCell y vuelva a 
realizar la prueba de DRAM. 

Si la prueba sigue resultando fallida, 
póngase en contacto con el servicio de 
asistencia técnica de Digidesign.

5 Test Sine

▲ La prueba Test Sine envía un tono MUY 
ALTO a través de las salidas de audio de 
SampleCell II. Ajuste los niveles de volumen 
de su mezclador antes de realizar una prueba 
Test Sine. 

Para comprobar las salidas de SampleCell, 
haga clic en el botón Test Sine cuyo 
número corresponda al canal de salida de 
audio que desea poner a prueba. Esto 
enviará a la salida designada una onda 
sinusoidal a código completo. Para detener 
la onda sinusoidal, vuelva a hacer clic en el 
botón de salida correspondiente o cierre la 
ventana Test de SampleCell. 

Póngase en contacto con el servicio de 
asistencia técnica de Digidesign si sigue 
teniendo problemas. 
Guía de SampleCell II
Muestras en DRAM después del 
reinicio

SampleCell II mantiene la memoria de 
muestras después de reiniciar el sistema. 
Para eliminar totalmente el contenido de 
DRAM, apague el ordenador, espere unos 
minutos y vuelva a encenderlo.



apéndice d

Creación y edición de muestras
Aunque SampleCell II no puede crear 
muestras por sí sola, hay varias formas de 
hacerlo externamente para utilizarlas en la 
creación de instrumentos de SampleCell.

Muestras con Audiomedia II/III (Sólo 
para Macintosh)

Audiomedia II y Audiomedia III pueden 
servir como "plataforma" de muestreo de 
dos canales para SampleCell.

Para crear una muestra compatible con 
SampleCell utilizando Audiomedia III:

1  Use Audiomedia III para grabar en el 
disco duro el sonido deseado. Consulte la 
documentación de Audiomedia III. 

2  Use las herramientas de edición para 
seleccionar la porción de muestra deseada. 
Debe ser de menor tamaño que la memoria 
disponible en su tarjeta reproductora 
SampleCell.

3  Guarde la muestra en la carpeta adecuada 
dentro de Samples (consulte la 
documentación de SampleCell). Debería 
poder cargar la nueva muestra desde la 
ventana Sample Map de SampleCell, desde 
la que es posible crear bucles y aplicar 
opciones de Matrix y otros parámetros 
editables. 
Muestreo con Pro Tools

El sistema Pro Tools de Digidesign también 
puede usarse para muestrear sonidos igual 
que con Audiomedia. 

Para crear una muestra con Pro Tools:

1  Use Pro Tools para grabar en el disco duro 
el sonido deseado. Consulte la 
documentación de Pro Tools. 

2  Use las herramientas de edición para 
seleccionar la porción de muestra deseada. 
Debe ser de menor tamaño que la memoria 
disponible en su tarjeta SampleCell.

3  Guarde la muestra en la ubicación 
apropiada dentro de la carpeta Samples. 
Debería poder cargar la nueva muestra 
desde la ventana Sample Map de 
SampleCell.

Uso de muestras procedentes 
de otros muestreadores
Existe un gran número de sonidos 
muestreados para todo tipo de 
muestreadores digitales. Aunque 
SampleCell II no incluye compatibilidad 
directa con muestreadores, es fácil 
importar muestras con los siguientes tipos 
de archivo: AIFF, Sound Designer, Sound 
Designer II o Snd con programas de otros 
Apéndice D: Creación y edición de muestras 109
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fabricantes, como Alchemy™ (Alchemy, 
Sound Designer y Snd son aplicaciones sólo 
para Macintosh). Además, puede utilizar 
uno de los muchos programas de 
conversión de archivos disponibles, por 
ejemplo Interpreter™ de Gallery. Póngase 
en contacto con Digidesign, en el número 
facilitado en la portada interna, para 
informarse sobre éstos y otros programas 
de Digidesign y desarrolladores asociados. 
Guía de SampleCell II
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